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ABSTRACT

MODELING AND VALIDATION OF CONTROL PARAMETERS FOR MATERIAL
EXTRUSION-BASED ADDITIVE MANUFACTURING OF THIXOTROPIC
ALUMINUM ALLOYS

Lars Herhold
May 22, 2018

Additive Manufacturing (AM) with metals has been accomplished mainly through
powder bed fusion processes. Initial experiments and simulations using Material
Extrusion Additive Manufacturing (MEAM) have been performed by various
researchers especially using low melting alloys. Recently Stratasys Inc. submitted
a patent application for the use of their Material Extrusion technology also called
Fused Deposition Modeling (FDM) where they describe the process using
thixotropic semi-solid alloys. Currently this process using semi-solid, engineering
type alloys such as A356 or THIXALLOY 540 aluminum have not been researched
to evaluate the control parameters. This research combines the in-depth
knowledge of applying thixotropic semi-solid aluminum alloy processing as used
in thixocasting and thixoforming with the MEAM research. Successful
implementation of this metal AM process category besides powder bed fusion
would result in the gain of certain MEAM process advantages like speed and ease

of material handling (filament) for metal AM.

In this dissertation thixotropic aluminum alloys have been identified for their
applicability for MEAM and optimal pre-processing as well as thermo-mechanical
handling in a nozzle has been identified. A review of the optimal heating
temperature for an aligned quality of microstructure were completed to provide
experimental proof of thixotropic aluminum alloy applicability. As further research
aging of such alloys during isothermal holding while pausing or pure movement of



a MEAM nozzle will help to derive the required cleaning processes in case the
alloy develops an in-adequate microstructure. The research results build the basis
for the next phases towards a larger project goal of developing a successful MEAM

machine for producing aluminum alloy parts.

Vi
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1 INTRODUCTION

1.1 Problem Statement

Several strategies using additive manufacturing (AM) resulting in near net shape
metal products have been implemented. Powder bed systems are commercially
available to create prototypes, molds and functional parts. Most commercial
systems are based on steel, chrome, titanium, nickel or iron materials to produce
either direct or “green” parts'. Aluminum parts can mainly be produced via the
casting route, i.e. creating a wax pattern or sand casting mold via AM and pouring
the aluminum part. To allow a higher volume additive manufacturing of aluminum
products a direct route to produce parts would be required. Material Extrusion
Additive Manufacturing (MEAM)? based Fused Deposition Modeling® (FDM)
developed by Stratasys is a well know additive manufacturing process route using
a filament to extrude shaped layers of material and therefore layer wise creating a
finished product. Current commercialized MEAM filament materials are restricted
to thermoplastics such as acrylonitrile butadiene styrene (ABS), polycarbonate
(PC) or Polyphenylsulfone (PPSF or PPSU).

Aside of the current use of metal in additive manufacturing, David Spencer [1] and
Merton Flemings discovered in 1971 the thixotropic behavior of certain alloys and
applied this effect to casting and forging of products. One of the key aluminum
alloy that is used in such thixotropic casting routes is A356°. Research on such
casting alloys are focused on its use as large ingots in casting and forging

environments. Specifics on alloys extruded from filaments as thixotropic slurry

" Parts that need to be sintered below the melting point to retrieve the required strength or infiltrate
with a second material e.g. bronze

2 Material Extrusion Additive Manufacturing will be used as the generalized term still recognizing
that the method was invented by Stratasys Inc. Other terms that have been used for that method
are Solid Freeform Fabrication (SFF) and

3 Aluminum alloy with Al, Si, Zn, MG as per ANS| H35.1

1



have only been completed using low melting Pb and Sn and extrapolating for
aluminum alloys by Finke et al.[2], Rice et al.[3] and Vijh et al.[4]. Another route for
direct printing of aluminum is the use of single molten aluminum droplets as
proposed by Cao & Miyamoto [5] or Qi et al. [6]. The aluminum alloy MEAM route
has been progressed in 2000/2001 but since then just numerically been simulated
by Vijh et al. in 2009 [4].

1.2 Research Contributions

This dissertation defines the possible routes for using as-is or pre-processed
aluminum alloy filament for layer-based extrusion in a semi solid state. It compares
the existing paths of pre-production of cast alloys and illuminates the most
promising routes. Simulations and experiments of driving, heating and extruding
of such aluminum alloy filaments are performed. Individual process parameters
such as extrusion temperature, velocity, holding time and designs are validated via

a prototype thixotropic extrusion nozzle.

This dissertation is structured in nine main chapters. After the introduction (this
chapter) chapter 2 will review the literature for aluminum alloy raw material, the
pre-processing of aluminum alloys for semi-solid use, the key aspects of MEAM
as the chosen additive manufacturing process and the latest results on additive
manufacturing with semi-solid metals. Chapter 3 will provide details of an initial
filament experiment and the MEAM apparatus design that is proposed to be used
during this research. Chapter 4 will describe the performed simulations and
experiments as well as show the outcome. Chapter 5 will take the outcomes of the
prior chapter and derive decisions for the following simulations and experiments
as well as derive models for application in a MEAM apparatus. Chapter 6 will take
all the discussed results and derive a machine and process design. Chapter 7 will
conclude and summarize the work while chapter 8 will define the proposed next

steps in a research towards an operational MEAM machine.



2 LITERATURE REVIEW
This dissertation will combine an existing research and application area of using
semi solid aluminum in casting and forging with Material Extrusion Additive
Manufacturing (MEAM) as a specific additive manufacturing process. The
literature review will therefore go through published research areas starting with
thixotropic raw materials and review it from more fundamental aspects towards the
latest developments. As a next area additive manufacturing with its specific
application of MEAM will be reviewed. As referred to in section “1.1 Problem
Statement” there is limited research on using thixotropic / semi-solid metals applied
to MEAM. This area will be reviewed last and the research topic and contribution

will be discussed as well as a work plan derived from that.

2.1 Thixotropic raw material

2.1.1 Fundamentals of aluminum alloys

To understand the thixotropic behavior of an aluminum filament one would need
to review the basics of metals, metallic alloys and their phase diagrams [7]. The
first concept to recognize is that of crystals. Metal crystals have a specific structure
defined by its lattice parameter i.e. the distance between single atoms and their
angle within a certain unit. A unit that is repeated within the overall structure is
called a “unit cell.” Unit cells can be simple* or stacked with additional atoms. The
most important crystal structures are face centered cubic (FCC), body centered
cubic (BCC) and hexagonal closed packed (HCP). Pure Aluminum exhibits an FCC
structure (see Figure 1) which means the cube of 4 aluminum atoms houses 6

more atoms — a single one on each outward facing side.

4 Simple unit cells can be cubic, tetragonal or hexagonal
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Figure 1 - Face Centered Cubic (FCC) Lattice structure

Another key concept of metals are the irregularities of a lattice structure. Those will

later become very important in creation of a thixotropic raw material.

The first model for irregularities is a point defect. The point failure can be a vacancy,
which means that a place which under normal conditions is being occupied is
vacant. The other less frequent defect is the self-interstitial which is an atom
trapped in a place in which under normal conditions an atom would not be included.
The point defects may also include impurities. Alloys are the result of intentionally
adding one or more types of atoms together, which typically become solutes® or a
solvent®. Such a solute atom can, depending on its size, become a substitutional
or interstitial atom. Substitutional atoms replace a solvent atom whereas
interstitials atom will assemble into a space between the solvent atoms. If a solute
atom will differ in size more than +15% from the solute, it will create a significant
deviation from the pure solvent lattice structure. Such a solid solution will result in
a new phase as it exhibits significant changes to its attributes. During review of
semi-solid slurries the types of phases become a fundamental aspect to
understand phase diagrams. As part of understanding a phase the concept of
concentration is vital as in semi-solid slurries phases with different compositions
may exist. The composition or concentration for one component out of a binary

metal alloy is defined in Equation 2.1 as:

5 Element in minor concentration
6 Element in greatest concentration — also known as host atoms
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Such a composition can be calculated as weight percent or atomic percent.

The further important types of irregularities are dislocations and interfacial defects
resulting in grains. Dislocations can be separated into edge also known as line
dislocations and screw dislocation (see Figure 2). For semi-solid slurries such
dislocations are used as seeds for grain growth especially during the Strain
Induced Melt Activated (SIMA) process to create raw material for the thixotropic
route. Edge dislocations are a terminated line of atoms within a plane as per Figure
2a.

The screw dislocation is a region of atoms that is shifted by one atomic distance
(see Figure 2b). Both the screw and edge dislocations generally appear as hybrid
dislocations. Any dislocation significantly increases the energy of the lattice
structure. The dislocation density in annealed metal is about 10%mm/mm?3
(resulting in a dislocation line length of 1km per mm?3) and can be raise through
cold processing to about 10"™mm/mm?3 (10 000km). For each 1mm of dislocation
line, the energy increases by about 10-'2Joules. This results in an assumed

maximum increase of energy of 10-2J/mm3. [8]

PEYye
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Figure 2 - Dislocation types: (a) Edge (b) Screw [9]



Another important defect is the interfacial one. It includes external surfaces,
defects in crystals, and grain and phase boundaries. During cooling of a metal in
its liquid state below the liquidus temperature, solidification typically starts at walls,
interfaces or dislocations with the appearance of a nucleus’. To grow further a
nucleus requires a critical radius otherwise it will re-dissolve. Each nucleus will
grow if cooled further until it reaches a wall or another nucleus. As the direction of
the crystal is random in normal cases the boundary of the finished growing nuclei
will show different crystallographic orientations. Individual crystals with a single
orientation are called grains and the touching lines / areas are called grain
boundaries. In solid alloys the additional boundaries that can be observed are

phase boundaries which separate the phases with different chemical composition&.

To understand the cooling behavior of an alloy it is important to understand its
phase diagram. An important concept besides the shown temperature, liquid semi-
solid, solid phase and concentration is the solubility of a compound within a second
one. In the case of A356 the key solutes are silicon (Si) and magnesium (Mg).
Depending on the temperature there is a maximum concentration of the solute e.g.

Si that can dissolve in the solvent e.g. Al.

A binary aluminum silicon alloy is a eutectic alloy and does have a full solubility in
the liquid phase as well as a limited solubility at room temperature. For the
assumed thixotropic alloy the overall composition of Si will be chosen above the
maximum solubility (see Figure 3) at room temperature (e.g. 1.65% Si) and the
below the composition at the eutectic point (e.g. 12.6% Si). When cooled from the
pure liquid state and past the liquidus line a primary phase will form. This will

continue until the eutectic temperature Te.

7 Known as heterogeneous nucleation
8 Note that phases are a portion with uniform physical and chemical properties as such a different
state (liquid, solid, gaseous) is also seen as a different phase e.g. for a pure material.
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Figure 3 - Al-Si Phase Diagram [10]
If the temperature falls below the eutectic temperature the eutectic phase will
crystallize to include eutectic a and B phases that exhibit a repeating lamellar
structure. A eutectic alloy composition solidifies directly from a pure liquid to the
full solid phase at the eutectic temperature.

2.1.2 Fundamentals of thixotropic alloy behavior

Thixotropic behavior was discovered by Schalek and Szegvari in 1923 through
experiments with iron oxide gels [11]. They found that the gel becomes completely
liquid through gently shaking but solidifies after a period of time. This concept of
time dependent viscosity when applying shear stress was called thixotropy. It was
reviewed that microstructural breakdown of 3D structure and its re-establishment
is the cause of the time dependent thixotropic shear thinning. In 1971 David
Spencer with his Professor Merton J. Flemings discovered that metal alloys can
be processed while in such a time dependent semi-solid state [12] (see Figure 5)
as long as dendritic breakdown and therefore creation of spherical grains within
the solid phase happens. The basic principle behind the behavior lies in the

dendritic solidification of metals (see Figure 4) which is observed in nearly all metal



alloys. If then stirred during a semi solid state these dendritic structures break and

form spherical solid particles, enabling flow with less shear stress than before.

COLUMNAR- EQUIAXED
DENDRITIC DENDRITIC

200 LIQUID

Figure 4 - Solidification of an alloy against a cold chill wall (a) columnar (b) equiaxed [12]

2.1.3 Semi-solid states of thixotropic alloys

During solidification the fraction liquid/ solid is a key attribute to determine whether
it can be processed or not. The fraction liquid can be modeled by the Scheil
equation using the composition of the liquid at a given location (CL), composition

of the initial alloy (Co) and a constant partition ratio (k) as shown in equation 2.2:

1

_(G) P 2.2
o= (Co)

As the liquid composition (CL) is related to temperature, Scheil’s equation can be
written using a dimensionless temperature ¢=(Twm-T)/(Tm-TL) where T is the
temperature of the alloy, Twm is the melting point of the pure solvent (e.g. Al)and TL

is the liquidus temperature of the alloy:

1
fu=¢ G0 23
Both composition and temperature based equations measure the fraction of
solid/liquid based on weight. Assuming that the liquid and solid has the same

density the fraction would also reflect the volume fraction of solid.



Figure 5 - Aluminum alloy billet at fs=0.5 exhibits a consistency of modeling clay [13]

Scheil’s equations[14] neglect two processes that exist in semi-solid metals and
results in a somewhat lower fraction liquid than that calculated from the
equation[12]. First one is diffusion or micro segregation in the solid phase
(assumption for Scheil's equation Ds—0°9). For the liquid phase a complete
diffusion / homogenous distribution is expected (DL—) for Scheil’s equation. As
long as the cooling rates are sufficiently high, e.g. >>1Ks™' (see Figure 6) the effect
can be neglected as a typical diffusion coefficient of D=10"3m?s-! requires several

hours to occur at a center of a 100um diameter spherical particle[15].

9 Ds defines the mass transfer from liquid into the solid phase
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Figure 6 - Effect of Cooling Rate on fraction solid [15]

The second aspect neglected by Scheil’s equation is coarsening via Ostwald
Ripening and coalescence. It results in fusing of single grains into a larger one or
the filling of spaced between dendrite arms and therefore the increase of the grain

size in order to reduce the area between the solid — liquid interface.

2.1.4 Shape and structure of thixotropic alloy particles

Ostwald Ripening and coalescence is time dependent and can be described by

the following equation 2.4 [16]:

1
S, =S,0(1+kt)3 24

Sv represents the solid - liquid interface surface area per unit volume, t the time
and S is the initial value before isothermal holding. The rate constant k in min-!
was determined for AISi7Mg0.6 between 0.3 and 1.8 min-' (electromagnetically
stirred and non-stirred). Figure 7 [15] shows the initial and isothermal hold structure

of electromagnetically stirred and conventional AlSi7Mg0.6 alloy at 580°C.

Additional measurable or derived shape and structure attributes of thixotropic
alloys are grain size of the solid phase, number of grains per unit area, average

globule diameter, volume fraction of the solid phase and a resulting shape factor.
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Figure 7 - (a,c,e) conventional casting and (b,d,f) MHD casting after holding at 580°C [15]

The number of grains per unit and their final size is dependent on the development
of initial nucleus or the cut off of dendrite arms within the agitated semi-solid slurry.
It has to be noted that nucleus or broken off particles require either enough free
energy i.e. through undercooling or need to have reached a critical size. Otherwise
the nucleus or particle will melt/dissolve [8]. A common standard to determine the
grain size is ASTM e112 for manual or ASTM e1382 for semi or full automatic
determination [17]. The most manual method proposed by ASTM e112 is the
comparison of a magnified acid treated and polished specimen with a standard

chart. Aluminum is proposed to be compared to plate | at a magnification of 100x.

The volume fraction of solid at a given temperature can be determined by
quenching of a semi-solid specimen to capture the microstructural phase status.
Quenching is the process of extreme chilling that result in the creation of single

phase metal with the fraction liquid in a ‘frozen’ state [8]. Based on that state the

11



fraction solid at the quenched temperature is visible as single phase a grains under
a microscope. Tzimas and Zavaliangos [18] reviewed the volume fraction
approximation methods '© and found no superior ones — each with unique

advantages.

The above defined solid liquid interface surface area per unit volume S,, can be
determined for a specimen using image analyzing techniques by measuring the
total solid liquid interface length (Lq) and the chosen area of the specimen (A):

4L

= 25
Sv T A

The fraction of the solid phase (fa) can be determined by the total solid phase area

(Aa) and the chosen area of the specimen (A).

A
fo= 7“ 2.6
Using the number of grains (Na) in the specimen area a grain specific shape factor

(Fg) defined by Loué and Suéry [16] can be determined:

1 5,°

F. = —_— 2.7
g 67Tfa NA

This shape factor shows value larger than 1 for complex e.g. dendritic grain
structures and equals 1 for perfectly spherical solid phase grains. A more simple

form factor used for semi solid metal processing is defined as:

_ dmd 2.8
U2
with A being the grain area and U the length of the grain contour.

Further, an important attribute of the structure is called contiguity (C) and was
introduced by Gurland [19]. It defines the average fraction of the surface area of a

0 Used approximation methods: equilibrium phase diagrams, thermal analysis techniques,
quantitative metallography on microstructures of quenched
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solid particle that is shared with its neighbor of the same phase. The contiguity is

defined as:

2S4a

€=
2Saa + Sap 2.9

Saa represents the area of interface between the a particles and Sqp between a
and B particles (or eutectic phase). C will equal 0 for no contact and 1 for full

contact i.e. in a fully solid state.

The volume contiguity calculated by multiplying the contiguity with the fraction

solid:
VC = fsc 210

This attribute is one of the reasons for the solid behavior of slugs with a liquid

fraction above 0.4.

2.1.5 Viscosity, Shear and plastic behavior of semi-solid aluminum alloys
Viscosity () is the measure of resistance of a fluid to being deformed. The rate of
deformation is called strain (y), its velocity strain rate (y) and the force divided by
the area cross sectional is called shear stress (t). The basic relationship between

viscosity, strain rate and shear stress is called dynamic viscosity:
T=nx*y 2.11

When viscosity is constant over time and for different shear stresses the fluid is
called Newtonian. If the viscosity decreases with shear stress it is called shear
thinning whereas if its increases it is called shear thickening. The general power
law type viscosity model (known as the Ostwald and de Waele model) for all
behavior to shear stress introduces a consistency factor (k) and a power law index
(n) [20]:

T=ky"™ or n=ky"1! 2.12

The power law index defines the type of behavior, with n=1 for Newtonian, n>1 for

shear thickening and n<1 for shear thinning.
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If change in viscosity is dependent on time it is called thixotropic for (decreasing
viscosity) or rheopectic (increasing viscosity). An additional behavior is the
requirement of a yield stress (t,) to start deformation. Such fluids are called
Bingham fluids and can again behave from stress as a Newtonian (ideal Bingham
Plastic), shear thinning or shear thickening fluid (see Figure 8). The complete

power law model including Bingham behavior can be written as [21]:
To o .
n=7+kyn Loor t=10+ky" 213

Aluminum alloys can behave in several ways. Thixotropic behavior relates to
processing of aluminum and other alloys. This behavior is mainly caused by
breaking the dendritic structure in a semi solid state. If the alloy is allowed to re-
create the dendritic structure over time it returns to a higher viscosity. However this
is not the only behavior a semi-solid alloy exhibits. If the alloy is agitated or
otherwise forced to create globular particle structures in the semi-solid state it can
behave rheopectically by further reducing the viscosity over time especially
through Ostwald Ripening when no dendritic growth is applicable anymore. When
applying rapid stress changes the semi-solid alloy exhibits shear thickening which

has no time dependence[22].
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Figure 8 - Schematic Model Flow Curves

For semi-solid metals in general a yield shear stress can be observed [23] and as
such have a Bingham like behavior. But compared to an ideal Bingham fluid semi-
solid metals do not employ a linear relationship between shear stress and shear
rate above the yield stress. A simple approximation of yield stress for Al-Si alloys

with a solid fraction below 0.6 has been developed by G.K. Sigworth [24]:

3

T0=9615*f ¢
m

(Pa) 2.14

The maximum packing fraction of spherical solid grains fm equals 0.6. Pan et.al
[23] reviewed this approximation and found that for A356 the model predicts the

yield stress reasonably well up to a fraction solid of about 0.5.

Another model that has been implemented in the commercially available simulation
tool ProCast [25] is called the Power Law Cut-Off (PLCO) model that assumes the
semi-solid slurry to be a viscous, isotropic and incompressible fluid. This model
therefore assumes (as the models shown before) the material being a one phase
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material. The model was developed and verified by Orgeas et al. and is described

as a modified power law relationship by [26]:

. n—1

Y o .
M:H0<._) ify =7
Ve 2.15
v\ L
llzllo(-_o) if v <vo
Ye

The model assumes that for a shear thinning behavior the shear rate y needs to
be higher than a cut-off shear rate y,. Below that value the viscosity will be
constant. In this model y, is defined as a temperature dependent viscosity at a

specific shear rate y,. (Orgeas et al. used 1s™' [26]) and can be calculated via:

Ho = Miiquia€XP(Bfs) 2.16

The specific viscosity (u,) is therefore based on the temperature which is
represented by the fraction solid (f;), the parameter B that is mainly dependent on
the microstructure of the semi-solid metal and the viscosity (u;;4uiq) Of the pure

liquid phase which behaves as a Newtonian liquid.

The shear rate sensitivity coefficient (n) is also dependent on the fraction solid f;

and can be calculated as follows:

1—n.. 2 -
n= M[l — tanh (M)l + Nnin 217

2 — Mmin

As defined by Orgeas et al. the model for n results in the asymptotic limits for low
fraction solid (n=1 — Newtonian behavior) and a high fraction solid (n,,;,) with a

‘slope’ a at a critical fraction solid f; 4.

The PLCO model has been validated with an axisymmetric Poiseuille-type
extrusion experiment and besides its simplicity with using only 6 rheological

parameters it can model the full range of temperature / fraction solid.

To describe the flow behavior e.g. viscosity without external variables and knowing
the history Kumar [22] proposed models using internal or structural variables (see

Figure 9).
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Figure 9 Dependency of slurry viscosity on structural/internal variables

The models above do assume the semi-solid slurry as a one phase material.
Several attempts [27], [28], [29], [30], [31] have been made to derive two phase
models that treat the liquid and the solid phase differently. The solid phase is
treated as a solid skeleton modeled as a pure viscous and compressive medium.
The liquid phase is treated as a Newtonian liquid and each phase has its own
behavior that will influence the other behavior [15]. The calculation of such models
would include a simultaneous processing of a solid fraction, pressure, 2x velocity
for solid and liquid and a temperature field. The resulting computation
requirements and the need for a larger set of boundary values have prevented
those types of models from appearing in industry simulation software packages as
of now. It is also assumed that the modeling of a simple MEAM case may not need
a two phase model but could rely on a one phase model. A good overview of one
and two phase models proposed, compared and used for simulations can be found
in the paper of H.V. Atkinson [32].

2.1.6 Temperature and energetic behavior of thixotropic alloys
During thixotropic processing the key attribute of the slurry for an adequate
viscosity is the fraction solid. The fraction solid is dependent on the precise and

homogenous temperature adjustment throughout the slurry within the machine. A
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key influence of the processability of an alloy is expressed by the change of the

enthalpy for a 1°K change in temperature:
dH
* = | — 2.18
v = [z

The second important attribute is the temperature difference between the solidus
and liquidus line. This can be expressed by the alloy specific temperature
sensitivity (S*) of the fraction solid (fs) [33].

_ |95

= 219
dT

S*

For both attributes (see Table 1) the AISi7Mg, AISi5Mg, AZ91 and AM60 are
suitable due to small temperature sensitive of the solid phase fraction but on the
other side the sensitive alloys AISI1TMg and AE42 are not temperature sensitive

towards the added or removed energy.

Table 1 - Phase sensitivity!! and enthalpy of technical used alloys [33]

AISi7Mg | AISi5Mg | AISiIMg | AZ91 | AM60 | AE42
S* [%K 7] 0.83 0.91 4.0 0.87 1.33 2.5
L*[Jcm3K1 | 115 118 47 5.9 8.9 16.5

AlISi7Mg is the basis for the A356 standard and widely researched in it behavior. It

will be used as the basic material for this dissertation also due to its availability.

2.1.7 Standards of Al-Si-Mg Alloys

Standards for aluminum alloys (see Figure 10 for a simplified example) have been
adopted in 1957 by the American National Standards Institute (ANSI) as ANSI
H35.1[34]. The Unified Numbering System (UNS)'? runs in parallel to the ANSI
system e.g. A356.0 is represented as A13560.

" Average values based on 0.4 < fs < 0.6 (exception AISi7Mg 0.5 < fs < 0.6)
2 managed by ASTM International (ASTM) and Society of Automotive Engineers (SAE)
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Figure 10 - Simplified aluminum alloy system per ANSI H35.1
Any standard alloy with increasing post digit number has a reduced maximum ratio
for non-key components but therefore still falls into the limits of the group e.g. A356

— key components Al-Si-Mg with reduced Fe percentage 0.2 for A356.0 down to
0.12 for A356.2.

Table 2 Physical Characteristics of A356.2 alloy [35]

Attribute Values

Density 2.686g/cm?3

Freezing Range Liquidus 615°C (1140°F) - Solidus 555°C (1035°F)
Coefficient of Thermal Expansion 23.5 um/mK (13.1 pin/in°F) at 20-300°C (67-572°F)
Thermal Conductivity T51 Sand 167 W/mK (96 Btu/ft*hr*°F)

Latent Heat of Fusion 389 ki/kg (167 Btu/Ib)

Electrical Conductivity T51 Sand 43% IACS (40.1 nQ*m) at 20°C

2.1.8 Influence of variability of alloy composition towards fraction solid
Standard alloy compositions such as EN AC-42100 (A356.0 as per AA) are defined
within alloy composition constraints. Basic definitions are done through a main
component e.g. Al that is the main proportion defined by 100% - all additional
components, key added alloy components defined by max and min proportion and

additional components for refinement or impurities defined by max proportion.

Table 3 - AISiMg compositions as per EN 1706:2010

Name Chemical Al Si Mg Fe Cu Mn Zn Ti Others
EN AC-42100 | AlSi7ZMg0.3 | balance |0.65-0.75| 0.3-0.45 | max 0.15[max 0.03| max 0.1 [ max0.07 |max 0.18| 0.03-0.1
EN AC-42200 | AlSi7ZMg0.6 | balance |0.65-0.75| 0.5-0.7 |max 0.15|max 0.03| max 0.1 [ max0.07 |max 0.18| 0.03-0.1
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The variability especially in Si and Mg has an effect on the attributes of the alloy.
This has been studied by Kaufmann et.al [36] for processability especially through

fluidity and fraction solid.

Kaufmann et.al showed significant differences in the alloy behavior e.g. phase —
temperature sensitivity (S”) at 50% fraction solid could change from an average
value (see Table 1) about 0.8% per Kelvin (e.g. at AISiMg min) to a very high
sensitivity for AISi7Mg max (see Figure 11) at 50%.

. MSITMg max = AISiTMg min
90 2 S
B0 N\
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Figure 11 - Thermocalc® calculated fraction solid by temperature for AISiMg min and max
compositions [36]

2.1.9 Thixotropic raw material enhancements

Several process routes have been identified to achieve a thixotropic / time
dependent shear thinning behavior. Initially Spencer [1] physically stirred Sn-Pb
alloy from a liquid state to a semi solid state. During further research different paths
were discovered to create material that can be processed to achieve a thixotropic
state with an adequate behavior. Process routes include (see Figure 12) chemical
composition changes, cold working to increase dislocation density/energy, stirring

and pure temperature processing.
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Thixotropic raw material
process routes

Chemical Cold Working Stirring Temperature
Grain Refinement Cold Rolling Physically Stirring Isothermal Holding
Equal Chanel Angular Magnetically Stirring Undercooling

Extrusion/Swaging Ultrasonic Agitation

Figure 12 - Basic raw material process routes

Process techniques resulting from the basic routes will be further discussed in
Section 2.2.

2.1.10 Measure processability of A356 with Rheocast Quality Index
To measure the applicability of semi-solid alloys for processing within thixoforming
or Rheocasting a quality index was developed called the Rheocast Quality Index
(RQI) as defined by Zoqui [37]. The index is defined as:

globule size

RQI = 2.20
¢ grain size x shape factor

The shape factor used is different than the one used by Loué and Suéry [16] (see

Equation 2.7) and is defined by the area and perimeter of the primary phase:

2

2.21

h tor = —=
shape factor dmd,

Zoqui et.al derived the apparent viscosity based on the shearing rate and the

determined RQI as follows:
u(Pas) = (2.37 + 53.6544¢(~562+ReD)y (=05) , 105 2.22

The proposed equation can be used to simulate the apparent viscosity when
knowing the shearing rate and the RQI.
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2.1.11 Derived strength of A356 from microstructure attributes

When either casting or producing using additive manufacturing it is critical to
understand the resulting mechanical properties of the final or interim product. To
standardize the representation of these quality attributes for A356 a quality index
for casting has been designed by Drouzy et.al in 1980 [38]. This index condensed

mechanical properties as follows:
Q = UTS + K = log(Elongation) 2.23

with UTS being the ultimate tensile strength. K is a material constant e.g.
equivalent to 150 Mpa for A356. As an alternative to testing of the mechanical
properties Khomamizadeh and Ghasemi [39] proposed the microstructural
attributes dendrite arm spacing (DAS), porosity and spherodicity to predict the
mechanical attributes via the quality index. The result of the mechanical
experiments and microstructural analysis of different A356 samples enabled
Khomamizadeh & Ghasemi to approximate the quality index using linear
regression as follows:
Qi(Mpa) = 213 — 0.081 * DAS(um) + 126 = spheroicity — 24

* porosity(%) 224

The differences in microstructural attributes arise at different positions in a cast

mold and through different solidification times.

The quality index proposed by Drouzy, Jacob et al. was reviewed as valid
especially for A3xx alloys but may not be valid for A2xx alloys. Alexopoulos [40]
reviewed other quality indices for validity for different aluminum cast alloys. A
review of other quality indices becomes interesting when one would significantly
deviate from the standard A356 e.g. by adding grain refinement or changing
composition for reducing the oxygen affinity (corrosion).

2.1.12 Conclusion on thixotropic raw material
Semi-solid/thixotropic aluminum alloys have a good potential as a filament for

material extrusion based additive manufacturing. A basic assumption of this thesis
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is that the composition and morphology of the filament will be a critical factor for
the successful use of thixotropic slurries during the material extrusion. A356 or
A367 are the most commonly used aluminum alloys for processing in a semi-solid
state. Due to their mechanical attributes and wide process window (temperature)
they have good potential for use in MEAM. It becomes clear that not just the
composition but also the history and resulting morphology of a potential A356
filament is important e.g. resulting grain size, grain shape and entrapped liquid in
the semi-solid state. As such the pre-processing for a potential filament must be

reviewed to conclude a route and define initial experiments.
2.2 Pre-processing of semi-solid metal

2.2.1 General Approaches

The process to achieve a semi solid feedstock can be separated into two basic
routes Rheocasting & Thixoforming [15]. The Rheocasting route starts from a fully
liquid alloy which is agitated during solidification to produce a slurry which will be
directly injected into the mold. The Thixocasting/Thixoforming route includes a
complete solidification of steered or otherwise prepared (e.g. SIMA) slurry and later
re-heating into partially re-melted slurry. The rheocasting route using liquid metal
to create a slurry is not applicable to a filament based Material Extrusion process.
As such only the thixoforming route will be discussed further. Nevertheless some

Rheocasting processes can be used to prepare a filament or pre-filament rod.

2.2.2 Semi-solid agitation/stirring production of thixotropic raw
material
Mechanical stirring was the first process route used for creation of semi-solid
slurries. A new type of mechanical stirring was developed by the MIT and is called
Semi-Solid Rheocasting (SSR®). Rheocast processes include an agitation/stirring
and rapid cooling process component. SSR® combines the two process
components by inserting a cold/cooled spinning rod into the alloy just above the
liquidus temperature. The liquid metal at the rod will be rapidly cooled and pushed
outwards into the liquid metal which results in a fine dendritic structure [41]. Within
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the flowing liquid the dendrite arms will coarsen and those arms that are too small

will melt off (see 2.1.4 for minimum nucleus/particle size).

A similar method is the gas induced semi-solid (GISS) process [42] by which also
a liquid alloy just above the liquidus temperature is agitated through the injections
of a graphite diffusor that applies an inert gas into the liquid alloy. Similar to the
SSR® process the injected gas will rapidly cool and agitate the liquid and new solid
particles. The SSR® and GISS process claim to offer semi-solid slurries with a low
fraction solid 0.1 — 0.2 that provide improvement during pouring without

modification of the die casting machine.

A completely different feedstock production method still relying on particle agitation
is call Magneto-Hydro-Dynamic (MHD) casting or extrusion (see Figure 13). This
method is the most commercialized method of producing thixotropic feedstock [22].
The advantage of this method is that it can be added to a commercial caster or

extruder so that the melt is agitated at the correct process step.

Figure 13 - Stirring modes: (a) mechanical stirring; (b) passive stirring; (c) electromagnetic vertical
stirring; (d) electromagnetic horizontal stirring [43]

Electromagnetic stirring can be applied in a vertical, horizontal or hybrid mode. It
results in agitation of the liquid phase. This moving liquid will disturb the growing
dendrites in the cooling zone and when those break they will typically form rosettes.
Several casting devices with electromagnetic stirring components are patented
mainly as mentioned before as an addition to continuous casters e.g. [44].
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2.2.3 Non-stirring production of thixotropic raw material

The Strain Induced Melt Activated (SIMA) process was developed by Young et.al
and patented in 1983 [45]. This process does not include a particle agitation during
a fluid or semi-solid state. It utilizes the changes within the microstructure (see
2.1.1) resulting from cold working. It was observed that a certain strain e.g. size

reduction due to cold rolling (see Figure 14) will reduce the grain size similar to an

electromagnetic stirred alloy [16].
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Figure 14 - Grain size of electromagnetic stirred (o) and cold rolled (o) AlSi7MgO06 at 580°C and 30s
holding time.[16]

Loué and Suéry concluded that: “Cold working prior to partial remelting of AlSi7Mg
alloys allows the most rapid obtaining of a perfectly globular morphology of the
solid phase, once the threshold deformation for recrystallization is surpassed. The
final solid phase grain size is independent of the initial microstructure, coarsening

while isothermal holding is slowed down when compared to the

electromagnetically stirred alloy.”

The patented process by Young et.al defines a four step process (see Figure 15)

[45]:

1. Conventional casting of a dendritic alloy billet
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2. Hot working including size reduction by extrusion, rolling, forging or swaging
at a below solidus temperature (typically 0.7*Tsoliqus Kelvin) to produce a
striated and directional grain structure. Size reduction should be at minimum
10/1 and suggested by the patent at a ratio between 1/19 to about 1/60.

3. Cold working as drawing, swaging, rolling, compression or upsetting
equivalent to an at least 12% reduction.

4. Reheating the alloy into the semi-solid temperature range to achieve a liquid
fraction between 0.05% to 0.8%.

Temp

L TS

L T

L e St SR TR SRS T

Time

Conventional Hot Cold

Casting Working Working Reheating

Figure 15 — Time - Temperature Profile of the SIMA Process[45]

The resulting grain size using the patented SIMA process is claimed to be below
30um. In his dissertation E. Tzimas [46] compared the SIMA, Spray Casting and
the MHD process and concluded that the MHD compared to the other two
processes exhibits a higher resistance to flow as a result of the morphology of the

solid phase.

The SIMA process can be classified into the severe plastic deformation (SPD) that
create significantly higher rates of dislocations. Equal Channel Angular
Extrusion/Pressing (ECAP) is an SPD process with higher induced strain [47]. This
process implies that a billet is extruded through two equal sized channels which
intersect at an angle (see Figure 16) so that ideally the billet experiences simple
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shear without a change in the cross sectional area [48]. This process may result in

anisotropic'? attributes.

Route A Route Ba [ )
e L 90 1

IS |

Route Bc Route C ( }

Figure 16 - Schematic illustration of ECAP processing routes with different or no rotation [48]
Jiang and Luo [49] used the ECAP as the strain induced step during the SIMA
process. The “new SIMA” reduced the grain size from about 180um to about 25um
at the semi-solid state of an AZ91D billet. Furthermore the “new SIMA” with ECAP

resulted in increase of mechanical properties such as yield strength, ultimate

tensile strength and elongation. Ashouri et.al [50] applied the ECAP process to
A356 with one to four passes. The resulting grain size was below 90um with a

shape factor around 0.9.

A continuous Equal Channel Angular Swaging (ECAS) process (Figure 17) for
filament has been proposed by Groche et.al [51]. The swaging die performs an
oscillating rotary movement resulting in a gradual severe plastic deformation. The
copper specimen used had a reduced grain size from 16.3um to 6.8um with
homogenous material attributes. The authors claim a reduce requirement of force
as a result of the die exhibiting only short-term contact with the filament.

3 Anisotropic is the directional dependency of attributes in case of EACP resulted by the direction
of processing. Additional EACP passes with rotation can reduce the anisotropic result.
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Figure 17 - Suggested continuous ECAS process for filament [51]

Chemical modification is a process by which additional elements other than the
major alloy elements Al-Si-Mg or Cu or impurities e.g. Fe are added to the alloy
[35]. This addition can be done during alloy production or in non thixocasting
processes right before casting itself. Sauermann [52] and Noll [53] reviewed the
design of Al alloys and enhancements to A356. Noll noted that chemical
modification is a compromise between achievement of small grain size,
spheroidization and fineness of eutectic areas. Strontium (Sr) acts as a eutectic

modifier whereas Titanium and Boron are used as grain refinement.

2.2.4 Conclusion on pre-process routes for semi-solid metal

Semi-solid aluminum slurries can exhibit extremely different characteristics than
ABS or similar plastics used in popular MEAM processing based on composition
and pre-processing/history. It is essential to achieve a semi-solid slurry that
exhibits a stable (in terms of time and temperature) viscosity so it can be extruded
and deposited to form an object. The strain induced pre-processing route is already
employed for producing an aluminum alloy filament via a drawing process. With
initial extrusion molding from an ingot and then further hot and finishing cold
drawing (instead of rolling) the process is very similar to the SIMA process
reviewed above. It is assumed that a produced A356 filament already exhibits key
attributes for semi-solid processing. Besides the potential composition changes
e.g. for reduction of oxidation and further reduction of the grain size, additional

changes to the pre-processing needs to be part of the research to find an adequate
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MEAM aluminum alloy filament. Recent research improves the strain induced
process route through more advanced severe plastic deformation processes.
Depending on the initial experiments this might lead to further options for improving

the filament for the MEAM process.

2.3 Additive Manufacturing
The term Additive Manufacturing (AM) has been defined in 2009 by ASTM

International as a “process of joining materials to make objects from 3D model data,
usually layer upon layer, as opposed to subtractive manufacturing methodologies”
[54].

The AM process can be separated into eight process steps (Figure 18) [55]
transferring the part idea into a Computer Aided Design (CAD) file followed by the
creation of an STL or newer AMF'4 file. Optionally the STL or AMF file needs to be
manipulated for repositioning, orientation change, segmentation or combination of
objects(s), changing size to compensate for shrinkage and for other method or
application specific reasons. After the completion of the STL/AMF file the machine
needs to be set up e.g. changing layer size or material. The build process can
typically run fully autonomously or with limited user interaction e.g. exchange of
(support) material. After the object is built it must be removed from the build
platform and, depending on the method, post-process removal of supports or
unused material may be required. To finalize the part for use it might need some
form of surface treatment e.g. polished. Some methods also require heat treatment
when the resulting object is a “green” part for sintering. After those process steps

the part is ready for use.

Create of Conversion Transfer to Machine Post
concept via » toSTLor » machine and > _— » Part Building > rocessin » Use of Part
CAD AMF manipulation P P g

Figure 18 - Additive Manufacturing process chain [55]

4 Improved file format
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Use may differ depending on the application for prototyping or end application. A
well-known end application of AM technology is the creation of dental aligners by

Align Technology [56].

2.3.1 Variations of Additive Manufacturing
Additive Manufacturing can be categorized by the raw material [55, 57] but this
does not show the full complexity of the process categories. A better categorization
method has been established by the ASTM

combination of deposition and fusing types.

International[54] through a

Table 4 - Advanced Manufacturing variations

ASTM F2792-12a
classifications [54]

Description [54]

Example Technology
implementations

Binder Jetting

Liquid binder selectively
joining powder materials

ZPrinter

Direct Energy
deposition

Focused thermal energy
fuses materials by melting as
they are being deposited

Laser Engineered Net
Shaping (LENS)

Dispensed material

Fused Deposition Modeling®

FDM
Material Extrusion selectively through a nozzle . ( ) N
or orifice Fused Filament Fabrication
(FFF)

Material Jetting

Droplets of build material are
selectively deposited

Stratasys Polylet Process

Powder Bed Fusion

Thermal energy selectively
fuses regions of powder bed

Selective Laser Sintering
(SLS),
Selective Laser Melting
(SLM),
Direct Metal Laser Sintering
(DMLS),
Electron Beam Melting
(EBM)

Vat
Photopolymerization

Liquid photopolymer in a vat
is selectively cured by light-
activated polymerization

Stereolithography (SL)

Sheet Lamination

Sheets of material are
bonded to form an object

Laminated Object
Manufacturing LOM
Ultrasonic Consolidation UC
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The most common method for making metal parts is via powder bed fusion (see
Figure 19 for installations). Other methods for metal part production include
directed energy deposition, binder jetting and Ultrasonic Consolidation (UC) [58].
Recent research [57] reviewed the fatigue behavior of SLM'® produced metal parts
which result in comparable dynamic behavior to conventionally processed
stainless steel. Besides that the current trends are to create faster machines e.qg.
DMLS systems with up to 40x within 4 years [59] and creation of large build
volumes e.g. 200mm x 620mm x 620mm [60].

Metal powder-bed fusion systems

Phenix Cumulative

Systems Riachl)zer installations
11.7%

SLM Solutions
1.2%
MTT
Technologies
11.4%

Renishaw
0.9%

Concept Laser
17.2% Arcam

12.0% Source: Wohlers Report 2012

Figure 19 - Metal powder-bed system installations [61]

Further review of AM technology will be restricted to the MEAM as the dissertation

focuses on the application of metal with MEAM.

2.3.2 Material Extrusion Additive Manufacturing (MEAM)

MEAM is an AM technology using a filament (currently ABS, polyphenylsulfone,
polycarbonate) transported into a liquefier chamber and extruded through a nozzle
tip (see Figure 20). The filament material is heated to a temperature where the
viscosity of the material is sufficient for extrusion but stable enough to keep the

form after extrusion.

5 Powder-bed system with a laser as heat source (SLM) as compared to an electron beam as heat
source (EBM)
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The filament material is used as a piston in its non-liquefied state pressing the
liquefied material through the extrusion die. A screw or pinch roller system is used
to push the filament into the liquefier and create the piston like pressure. The
position between the base-plate and the nozzle is changed in in the x-y direction
within a layer. When the layer is finished the distance between the base-plate and
the nozzle is increase in the z dimension by one layer thickness to extrude the next

layer.

Wire feed
component

Filament transport

N

I

Heating (resistive or inductive)

Liquefier Chamber

O O O O O O O

©co0o0doope

Extrusion die

Base plate

Figure 20 - Schematic of Fused Deposition Modeling

The possibilities for the mechanical implementation of the x-y-z changes range
from a complete stable base plate and full motion of the nozzle (common for most
CNC machines), the complete stable nozzle with the base-plate performing all
motions or a mixture in between. When extruding the next layer the remaining heat
energy must be sufficient to allow the region of contact between the laid rods to
bond. Additional areas of concern [55] are the 2D fill and 3D layer pattern, path
control between a fill structure and boundary, start-stop problems and the use of

support material. As this dissertations reviews the basic extrusion of semi-solid

32



aluminum further literature review will be restricted to the filament transport,
heating process, die extrusion process and heat transfer applicable to bonding. It
is required to examine those topics for conventional current filament types and

later adapt this knowledge for aluminum alloys.

2.3.2.1 Filament transport

When restricting the review to the transport of continuous filaments instead of other
solid possibilities like pellets or powders [55] filament transport can be done via
feed rollers or screw-feed. The standard design for welding machines using
filament as well as 3D Printers is a pinch roller feeder such as that used by a
Stratasys uPrint machine [62]. For plastic filaments the feed rollers typically use
teeth to increase the transmission of power from the rollers to the filament. To
maximize power transmission and also improve the flexibility of used feedstock the
fabbster 3D printer uses corrugated or “teethed” sticks (see Figure 21) and calls
this “Stick Deposition Molding” [63].

Figure 21 - fabbster teethed stick feed [64]

Each stick has a female and male side that can be connected so that the sticks
form a continuous filament. (see Figure 22) The storage mechanism of these sticks
connects the next available stick automatically at the time that the last one at the

bottom is removed.
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Figure 22 - Connecting of Fabbster sticks for form filament

Aluminum filament feeding devices are common in MIG welding machines. There
are numerous patents that describe those mechanisms. Examples for the purpose
of automation are the reduction of vibration [65] or the measurement of the wire
speed [66]. The wire feeding device defines the force that the solid wire will apply
to the semi-solid slurry in the heating channel, similar to a piston. Assuming the
force applied to the wire from the feeding rollers is tangential then the force of the
wire/piston (F) can be calculated using the motor torque (M), radius of the feeding
rollers (r), a slip percentage of the feeding rollers (s), the gear ratio between the

motor and the feeding rollers (R) and efficiency of the gear (n;).
M
F=(1—S)*R*7]G*? 2.25

When using pinch rollers the shape of the filament touching surface depends on
the type of filament. It is suggested [67] to use a V shape for steel filaments (Figure
23 - 1) and a U shape for aluminum filaments (Figure 23 - 2). If the wire feeder is
not directly attached to the nozzle a wire liner needs to be used which will result in
additional friction for the filament. Such friction forces will be up to 4-5 times higher
[68] for wire liners in a curved or even looped geometry. Padilla, et al. [68]
measured friction forces for wire liners of 0.75m - 3m and aluminum filament of

about 2N to 8N depending on wire liner geometry and liner material (Nylon/Teflon).

34



® @

Figure 23 - filament pinch roller types 1-steel, 2-aluminum [67]

Go et. al. [69] reviewed the pinch wheel feed of a standard FFF 3d printer and

identified the maximum force that can be applied at higher feed rates.
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Figure 24 - Filament feed force and shear a) nozzle measurement
b) feed rate vs force c) shear failure [69]

Based on the findings of the review a new process has been developed for filament
feeding to allow high speed 3D printing FastFFF [70]. To allow a higher force to be

applied to the filament similar to the “Stick Deposition Molding” [63] a nut-feeder

has been added to the extruder. Filament has been cut with a standard 4-40 thread

adding a triangular profile as a preparation and then pushed forward by the nut

(see Figure 25). For a single threat cut into the filament Go et.al. were able to apply

up to 109N axial force before the shear failure occurred. Go et.al. commented that

an improvement could be made by working on the thread profile and coating of the

nut.
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Figure 25 - FastFFF Extruder with nut feeder and laser pre-heater [70]

2.3.2.2 Heating process

To process the aluminum alloy in a semi-solid state the filament has to be heated
to a very exact predefined temperature range. For aluminum alloy filament two
practical processes are possible [71]: applying heat through conduction in a
heating channel which is typically controlled via resistive heating or the induction
of heat through changes in a magnetic field penetrating the filament.
Conductive/resistive heating is common in MEAM 3D Printers whilst inductive
heating is common in heating processes for thixotropic aluminum casting/forging.
Advantage of resistive heating is its lower complexity of the equipment compared

to induction heating. Induction heating allows a faster change of the energy feed
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and allows temperature control by indirect measurement via the induction coil [72].
Independent of the heating process the filament requires a finite energy (AQ) to
heat up from the initial (room or pre-elevated) temperature (T1) to the semi-solid
extrusion temperature (T2). This energy can be calculated using the mass (m), the

specific heat (cp) and the temperature difference (T2-T+1) as follows [73]:

Compared to the MEAM process with ABS, when using an aluminum alloy about

5-times more energy is required to get to the semi-solid state, due to:

e the higher temperature difference (565°C vs. 210°C),
e higher density (2.67g/cm3 vs. 1.04g/cm3)
e lower specific heat capacity (0.963J/Kg*K vs. 1.3 J/Kg*K).

To further analyze the conductive heating process the general heating equation
(see Equation 2.29) can be derived using conservation of energy as a basis. The
thermal energy flowing into a system or control volume (Ein) minus the energy
flowing out of the system (Eou) plus the energy created in the system (Eg) equals

the change of the energy stored (AEst) in the system [73]:
AEg = Eip — Eoue + Ey 2.27
This equation can be used to show the rate of energy changes as follows[73]:

_dEg

Est = W = Ein - Eou + E 228

9

Using this equation a general heat equation can be derived using a control volume

model (see Figure 26) also known as heat diffusion equation [73]:

d (k6T>+ d (k6T>+ 0 (k6T>+ . aT 299
ax \“ox) Tay\"ay) Taz\"5z) T1T Py '
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Figure 26 - Differential control volume for conduction analysis [73]
For a cylindrical control volume as observed in a filament the following heat
equation can be achieved by replacing coordinates x and y with r and ¢ [73]:
16(k 6T>+1 a(kaT)_l_a(kaT)_l_._ aT 230
rar\ ar) T2 \"ap) T9z\"9z) T1T Pt '
Using this symmetric cylindrical approach for filament heating and assuming the

heater and the filament do not have temperature gradients in the ¢ direction then

it can be assumed that the heat transfer in the ¢ direction is zero [74]:

L9 (k aT) =0 2.31
r2ap\ o¢/ '

That reduces the heat equation to a 2 dimensional problem which in the case of
billet heating could be reduced even further when assuming that the heat transfer
in the z-direction is also zero[74]. In the case of a continuous aluminum filament

this cannot be assumed which leads to the 2-dimensional heat equation 2.32:
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A heating channel with a filament can be seen as a composite from a heat transfer

perspective. The contact area between the heating channel and the filament
results in an additional thermal contact resistance due to surface roughness and

air gaps [73] (see Figure 27).

» Temperature
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Figure 27 - Temperature drop due to thermal contact resistance [75]

Such contact resistance can be reduced through pressure but in the case of the
heating channel would increase the friction of the filament. The contact resistance

(R¢.) can be determined by using the temperature difference at each composite

wall and the heat flux (gqy) [73]:

"no_
R =

Ty—Tg
qx

2.33

Table 5 — Typical conductance with normal surface finish and moderate preasure (1 to 10 atm) [75]

Interfacial Conductance (hc) (W/m? K)

Contacting Faces
Iron/aluminum 45,000
Copper/copper 10,000 - 25,000

Aluminum/aluminum 2200 - 12000
Stainless steel/stainless steel 2000 - 3700
Stainless steel/stainless steel 200-1100
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(evacuated gaps)

Ceramic/ceramic 500 - 3000

Using the heat transfer rate q the thermal contact resistance can be calculated

using an interfacial conductance (hc) and contact area (A) [75]:

R, = 2.34

Typical interfacial conductivity values are listed in Table 5 [75].

In the case of a significant air gap (inert gas) between the filament and the nozzle
wall, heating needs to be calculated as transfer from the heating nozzle to air and
then from air into the filament. From the melting front downwards the gap can be

assumed as closed due the piston pressure resulting from the wire feed [71].

Induction heating creates indirect closed loop current flow (known as eddy current)
via an alternating magnetic field generated by an induction coil [76]. The workpiece
itself must be conductive to allow the eddy current to flow, which is the reason that
direct filament heating is not possible for plastic (e.g. ABS). Instead induction
heating for the nozzle which subsequently heats up the plastic flament would be
possible [77]. Through the electrical resistance in the workpiece the energy of eddy
currents is transferred into heat, also known as Joule heating. In cases of magnetic
materials, the heat in the workpiece is also generated by magnetic hysteresis
losses. As aluminum and its alloys do not show significant magnetism the details

of that influence are omitted.

When working with alternating current flows/magnetic fields the tendency of the
current to flow in the outer area of a wire is known as the skin effect. This is due to
the electromagnetic field which is created by the eddy currents and directed
against the initial electromagnetic field of the induction coil. This field is largest at
the center of the workpiece and pushes the currents to the outer (skin) area of the
workpiece (see Figure 28). The size of the skin area is described by the Skin or
Penetration Depth ().
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........ Definition of current density
§ X

Jx)=Jy-€

J: Current Density

X. Distance to surface
. Skin Depth

J,: Max Current Desity
I Work Piece Radius

Work Piece Induction Coil

Figure 28 - Induction Heating and Skin Depth [76]

This skin depth for symmetric bodies with significant conductivity can be estimated

by:
5= /i 2.35
oUW

with o representing the electrical conductivity, p the magnetic permeability and w
the angular frequency of the magnetic field (with w=21f). The current density (J)
at a depth x can be calculated using the skin depth (&) and the maximum current

density (Jo) at the surface of the work piece (see also Figure 28):

J) = Jores 2.3

This results in that at the depth of =1 the current density is reduced to 1/e or 37%
and about 86% of the power has been induced in this skin area. To achieve
sufficient induction effectiveness the diameter of the work piece needs to be at
least 3-4 times larger than the skin depth [78] (see Figure 30). The skin depth can
be controlled using the frequency of the magnetic field as the other factors are
material dependent (see Figure 29). In case of a 1Tmm radius filament where the
skin depth should be 7 of the radius the frequency should be approximately
400KHz as per Skin Depth Monogram [79].
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Figure 29 - Skin Depth Monogram [79]

As such the effectiveness has to be compromised with non-uniform heating from
surface to center of the work piece. Therefore, the induction heating process is
always a combination of electrical induced heat and heat transfer in the work piece
which is described by the same heat equation 2.32 (using the simplified 2
dimensional heat equation) as above shown for resistive heating. In cases of billet

heating to the semi-solid state the power is step wise reduced to allow a through

heated billet with no significant temperature gradient.
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Figure 30 - Inductor-effectiveness per diameter skin depth ration (adapted from [80])

2.3.2.3 Die extrusion process

A nozzle in the MEAM Process could be seen as a pipe for a shear thinning fluid.

At the heating channel a melt front can be found where the filament changes from

solid to a semi-solid or slurry. This could be seen as a piston driving the semi-solid

fluid through an extrusion die and can be compared to a direct hot extrusion still

recognizing that the extrusion temperature would be lower than in a semi solid

case. In case of a MEAM machine the heating zone is typically an axisymmetric

cylindrical channel with a radius R1 and a respective cross section A1. The billet or

in case of MEAM the semi-solid filament is pressed through a die with a orifice

area A2and a die angle a (see Figure 31).
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Figure 31 - Extrusion Principle (adapted from [81], [82] and [83])

For an ideal fluid without friction or a turbulent flow the pressure in the extrusion
die would drop due to the conservation of momentum [84] as the velocity of the

fluid will increase by the Extrusion Ratio R [81]:

D?  (r\? A
Rex - D_22 - (g) - A_z 2.37
Based on this ratio the velocity can be calculated [81]:
D 2
V, =V, * Ry =V * (—1) 2.38
D,

Compared to the metal extrusion below the liquidus temperature the activation
energy in the convergence of the die only relates to the Bingham behavior of the
semi-solid metal. In case of hot extrusion the extrusion force can be calculated
using the initial area (A1), a temperature based extrusion constant (k.) and the

above calculated extrusion ratio [85]:
F,, = Ajk:InR,, 2.39

Expected extrusion constants examples at different temperature are shown in

Figure 32.

As the initial area multiplied by the pressure would result in the extrusion force, the

term k.InR,, can be seen as the expected pressure drop in the extrusion system.
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Figure 32 - Extrusion constant for various metals at different temperatures [85]

An assumed equivalence to the pressure drop might be found in the extrusion of
shear thinning plastic as also used in conventional MEAM technology. The shear
stress vs. strain relationship is modeled slightly differently than in section 2.1.5 by

transforming the consistency factor k and power law index n as follows [86]:
1 1
k=¢ mandn=— 2.40
m

This results in the following equations for shear stress (t), shear rate (y) and

dynamic viscosity (1) during a steady state operation [86]:

1

A 2.41
T‘<¢)
,_8(m+3)Q 242
V=" '
e\ =
M=<V¢ ) 2.43

Pressure drop in zones |, Il & Il (see Figure 31) can be calculated as follows [86]
using the length of zones | & Il (L1, L2) where L1 depends on the location of the
melt front inside the heating channel:
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The resulting pressure drop along the extrusion nozzle is [86]:
Ap = Apzone1 + APzone 11 + BPzone 11 247

Nevertheless, this model would not be an ideal fit since in Zone | the temperature
of the semi-solid alloy increases in front of the melt front location until the nozzle
temperature is met. In this area the viscosity is not just dependent on the shear

rate but also significantly on the temperature and the solid/liquid fraction.

An model of the link between the semi-solid MEAM pressure drop and the resulting
extrusion force was used by Finke [71], modifying the calculation of the pressure

drop in the nozzle capillary (AP) from Paradies et al. [87]

1
TS Vrdrdd  nReg, [APRegTE

Veap = = resulting in
cap J'OZ” foR rdrde 3n+1l 2Kl 2 48
b 2K1 [Vcap(sn + D"
Rcap chap
and the pressure drop (P.,) in the extrusion die from Blazynski [88]:
P,, = (0.8 + 1.5InR,,) 2.49
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R.qp represents the radius in the capillary, AP the pressure drop, K and n the
shear thinning material constants 1., the velocity in the nozzle, z the axial and r

the radial coordinate.
The resulting force (F,,) calculated by:
F,, = A;(AP + P,,) 2.50

was significantly (2.5-3 times) lower than the force values Finke [71] measured in
a load cell mounted in the extrusion head during the extrusion of semi-solid 60Pb-
40Sn alloy at 195°C. Finke explained the difference by not taking into consideration
friction / pressure drop in the heating channel and possible different segregation
behavior in the back extrusion experiment that was used to determine the material

constant (K), the power law index (n) and flow stress (7). (see also section 2.4.3)

Another aspect of the extrusion is the die angle (a) that will change the behavior
of the raw material that will be extruded. This includes the flow type (laminar or
turbulent), the shear stress on the material in the die and the force required. If the
die angle is large enough a dead zone will be formed that can typically be found in

planar dies [89] (see Figure 33).
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Figure 33 - Material flow in a planar extrusion die [89]

Orgéas et al. [26] showed the dead zone in a semi-solid extrusion experiment
using A356. In contradiction to Finke’s [71] observation Orgéas et al. identified a
decreasing / lower pressure than expected by a no-slip Poiseuille flow. A thin
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eutectic layer of segregated liquid material (see liquid vein in Figure 34) was found
in the capillary and in the converging area of the dead zone which leads to the

assumption of a “...solid plug (‘plug flow’), almost all of the shear rate being
accommodated by this thin layer of liquid (i.e. replacement of the no-slip condition

by a free-slip one)’[26].

Liquid vein e

Dead zone

100pm

Figure 34 - Eutectic layer besides the dead zone during A356 extrusion [26]

Further publications on extrusion cover die design via modeling/simulation to result
in a homogenous strain rate and best position for material overflow to limit semi-
solid segregation [90] or the reduction or minimization of distortion in the extruded
material [82]. This could be applied to semi-solid MEAM as the current observed
die designs are simple converging dies (e.g. 40° die used in Finke’s extrusion of
semi-solid 60Pb-40Sn [71]).

2.3.2.4 Heat Transfer for Layer Bonding

Layer to layer bonding in AM is mainly determined by the remaining heat which
activates the interface between the layers below and the newly deposited road. In
addition, an oxidation skin and segregated material in the skin could change the
bonding behavior in the case of a semi-solid aluminum alloy. There are several
proposed interface heat transfer & bonding potential models for the MEAM process.

Yardimci et al. [91] described a cooling model that takes complex geometry into

48



account. Cooling of the laid road will be influenced / delayed in case of either
environment / build chamber temperature (T») or residual heat in the relevant
neighbor roads (Ty.;4r)- These influences are covered in sink terms for convection
losses (S.) and road interactions (S;):

aq 0%T

p§=kﬁ—SC—Sl 2.51

Filament material constants are represented by the density (p), specific enthalpy
(p) and effective thermal conductivity. The process identifies the average cross-
section temperature (T) at the axial coordinate of the road (x) and the time after
deposition (t). The sink terms are calculated using the road width (width), the
convection coefficient (h) and the ratio of the road element volume to its free

surface area (hs):

Sc = (T —T) 2.52

hefr

k

Si = g (T = Tneign) 2.53

Using this temperature transition during the cooling process Yardimci et al. created
a bonding potential number (¢) using the time the road spends above a critical

bonding temperature (T,) with 7 representing the integration variable:

t
¢ = J(T ~T.)dt 2.54
0

Another model that has been created by Costa et al. [92] using a lumped
capacitance approach. This approach allows an analytical solution for transient
heat problems but requires the assumption that the heat gradient in the solid can
be neglected when comparing it to the convection to an outside fluid. To ensure
that this assumption holds true a test can be done by calculating the Biot number
[73].

49



This number will be small if the heat resistance of the solid is much less than the
heat resistance of convection. The lumped capacitance approach can be applied
if the condition: B; < 0.1 holds true [73].

Costa at al. [92] derived analytically the following equations to calculate the
temperature at a time t:
<_Pb(a1ra2'a3'a4ra5) hCOTlU()b)(t_t )
T(t) = Cie pAC pLC *+Q(ay, a3, a3 a4,as)

hconv (:bATE
PLb(al, Ay, A3, Ay, aS)

2.56

The filament is represented by the cross sectional area A, the perimeter P, filament
length, the heat capacity C, the density p and ¢ which represents whether it is the

first filament:

= { liffirst filament 057

0 ifnot first filement
The environment and the table as well as other filaments are represented by the
heat transfer coefficients for convection ( h.,, ) and the thermal contact

conductance (h;) for contact i (i € {1,2,3,4,5}) (see Figure 35).

The boundary condition C+1 can be calculated using the filament temperature To at
the time to:
hconvd)ATE

C =T, — ) ) 4 4 - 2
1 0 Q(a1 a2, A3, A4 aS) PLb(all az,as,ay, as) 58
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A, or A,

Figure 35 - Filament with possible contact areas A1, Az, As, As to filament, Az to table [92]

The functions Q (a4, a,, as, a,, as) and b(ay,a,, as, a,, as) are calculated using the
coefficient a; that represent whether or not the filament or table is adjacent (see
Figure 35):

1i tacti St
a = { if contact i exists Vi = {1,2,3,4,5) 2 59

0 if contact i does not exists

5 5
b(a,a,,as,a,, as) = Aeony <1 — z aixli) + z a;h;iA; 2.60

i=1 i=1

hconv(1 - i5=1 aili)TE + Zg’:l aihi/li Ti

2.61
b(all az, a3, Ay, a5)

Q(alr ay,asz, Ay, aS) =

The fraction of the perimeter P that is in contact with filament or the support is

represented by A;.The Biot number can be calculated by:

_ éb(al, a,, a3, Ay, aS)

i 2.62
P k

and still has to adhere to B; < 0.1.

This model assumes that due to the high conductivity the radial and axial heat
conduction can be neglected and that contacts between the filaments/laid roads
are constant over time which means neglecting gravity and the weight of the
filament above. It also transfers the conduction problem between the filament

roads to a convection problem (see the use of h;). Costa et al. [92] showed with
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the simulated results the dependency of cooling on the velocity, filament

dimensions, material, sequence of deposition and the environment temperature
(see example results in Figure 36).
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Figure 36 - Simulated time based temperature evolution for 9 filament roads [92]

Finke [71] evaluated the interface temperature suggested by Carslaw et al. [93]:

T; = Tssm

-1 -1

Adm Assm Assm Xgm
+ / +Tam | 1+ 2.63
Assm Xam am )ldm Assm

A represents the thermal conductivity and a the thermal diffusivity of the layer

material. Finke used the temperature gradient results (see Figure 37) to estimate
that the interface temperature (T;) will be the arithmetic average of the temperature

of the deposited semi-solid metal (Ts,,,,) and the temperature of the previously

deposited layer (T4, )-

1
Ti ~ E (Tssm + Tdm) 2.64
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Figure 37 - Temperature gradient and average approximation of layer interface [71]

Besides the review of heat transfer models the growth of the road contact areas
also known as neck growth was reviewed by Sun et al. [94]. The neck size
expected by the theoretical models is significantly smaller than the measured ones.
Sun et al. [94] suggested that the reason for the larger neck growth lies in the creep
deformation either from the gravity effect or the downward pressure from the
extrusion head during the part building process. It is concluded that this growth will
significantly influence the bonding as well as the heat transfer and should be

factored in bonding models.

As mentioned before the key control parameter for bonding is the interface
temperature. As the temperature of the deposited road is more or less pre-defined
through the extrusion the interface temperature can be mainly changed by
increasing the temperature of the previously deposited roads. There are several
strategies available or possible to increase the temperature of the deposited layer
to allow a sufficient residual heat and therefore the interface temperature above a

critical temperature e.g. in the semi-solid range:

e Heated build chamber as patented by Stratasys [95]

e Selective heating using forced air [96]
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e Selective heating of metal filament using induction heating coil, similar
examples can be found in selective mold heating [97] or using magnetic

shielding [98] to direct induced heat

2.3.3 Conclusion of MEAM

There are several models proposed to estimate, design or control extrusion and
deposition that are applicable for MEAM. When using those all models have to be
evaluated for applicability towards semi-solid extrusion and deposition by
reviewing the assumptions and simplifications. For instance, adapted analytical
bonding heat transfer models can be used to adjust the required selective heating
of previously laid roads. But it has to be evaluated whether the boundary conditions

allowing the simplification still hold true (e.g. axial/radial heat conduction).

2.4 Research on MEAM with thixotropic/semi-solid metals

Based on the growing experience in both areas of thixotropic metal processing and
MEAM (mainly through Stratasys Inc. and their FDM) research projects have been
conducted in the area of MEAM with thixotropic material. Besides research on
MEAM with polymer/metal mixtures'® [99-102] two approaches can be identified in

the research on MEAM with thixotropic or non-eutectic alloys (see Figure 38).

The first approach was done by Mendez, Rice and Brown at the Massachusetts
Institute of Technology (MIT) using a rheocaster to prepare the semi-solid slurry
from a molten/liquid bath by cooling and stirring the alloy to the required
temperature and microstructure. This resulted in two theses [103, 104], a paper [3]
and two patents [105, 106]. These two patents have expired (in 2007/2009) and a
founded rheocasting focused company (Semi-Solid Technology Inc.) closed
through “involuntary dissolution by Court Order or by the SOC” in 2007 [107].

6 MEAM with polymer/metal filament mixtures are not discussed as this dissertation is focusing on
pure metal filaments
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Figure 38 - time bar showing research results and patents for MEAM with thixotropic or non-eutectic
metals at the start of this work

Using these rheocaster experiments as a basis Vijh et al. [4] has conducted heat
transfer simulations using A356 aluminum alloy properties to identify deposition

patterns that would support bonding of layers.

At the Netherlands Organization for Applied Scientific Research (TNO'") a
research project was conducted using low melting alloy filaments reheated to a
semi-solid temperature. This resulted in a PhD dissertation [71] and two papers [2,
108].

Stratasys Inc. which owns the first FDM patent [109] as well as a large number of
significant ones (e.g. heated build chamber [110]) has filed a patent application for

the use of FDM with semi-solid metal filaments [111].

In 2013 experiments were made by Mireles et al. [112] to use low melting
temperature solder filaments including a non-eutectic composition (Sn60Bi40) for

enabling electronic conduction paths to be added into polymer MEAM objects.
During this dissertation noteworthy literature that has been published are:

e 2017 - Direct metal writing with rheocasting approach [113]

7 Nederlandse Organisatie voor toegepast-natuurwetenschappelijk onderzoek
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e 2017 - Fast Desktop-Scale Extrusion Additive Manufacturing [70]

e 2016 - Induction heating of aluminum alloy into semi solid state [114]
Each of these research areas and contributions will be reviewed in detail below.

2.4.1 Rheocaster approach on MEAM and metal joining

Rice and Brown studied the rheocaster approach (see Figure 39) for the extrusion
of semi-solid metals. Their research included the example extrusion of Sn85Pb15
to either join metal plates together (see Figure 40) or to extrude 3D objects (see
Figure 42). As a result of the experiments Rice [104] proposed a dimensionless
group (Me) which defines the extruded material in terms of its resistivity of
deformation by using the density (p), the gravity constant (g), the characteristic
time after the viscous flow stops (i), the apparent viscosity (1) and H as the height

of the deposited road:

t-H
Mengf

2.65

Figure 39 - Rheocaster for extrusion and deposition of semi-solid slurries [3]
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If the group (Me) is much larger than one the deposited road will be liquid like

whereas much lower than one will lead to solid-like behavior.

They demonstrated in both projects that the extrusion and deposition of the semi-
solid metal Sn85Pb15 is possible and will result in sufficient joining of substrates
as well as the creation of interface free (see Figure 41) 3D objects. Rice [104]
conducted tensile tests with machined specimens from casting and semi-solid
deposition. The results showed that the UTS for the deposition process (avg.
53.844MPa) were not statistically different than the casting specimens
(55.7+4MPa).

10zzle

/ shurry

substrate

aroove

Figure 40 - Semi-Solid joining process [103]

Besides a calculation of the expected shrinkage which is just 2/3 of that of casting,
Rice et al. proposed an orifice design that produces square or rectangle roads
being extruded to increase the maximum free overhang that can be achieved using

the extrusion process.
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Figure 41 - Sample extruded objects and interface section (middle arrow) [3]

A practical application of the MEAM process with the Rheocaster could not be

found and due to the complex apparatus requirements compared to a filament

based MEAM approach, it is not likely that this approach would ever be
commercially viable.

Heating
PID Control

Computer Control

Substrate

X-Y-Z Table

Figure 42 - MEAM setup with rheocaster [104]

2.4.2 Numeric heat simulation of deposition of aluminum

Vijh et al. [4] developed a heat transfer model based on the Finite Difference
Method to simulate the temperature distribution during deposition of semi-solid

metal. The solidification heat is included in the model using the relationship
between enthalpy (H) and temperature (T):
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( H
| , H < Hg
T(H) = { P~ 2.66
H-Hg -
ch slu’ -
T <Ts

Cp_soiT,
H(T)={ p—sol

2.67
HS + Cp—sol(T - Tslu)’ T = TS

The enthalpy at a temperature (T) is represented by H(T), the enthalpy at the
solidus temperature by Hg, the solidus temperature is represented by Ts, the
constant slurry temperature by Tsu, the specific heat capacity of the solid by Cp-sol
and of the semi-solid by Cp-siu. As a simulation example material Vijh et al. utilized
A356 aluminum alloy parameters. The following assumptions to simplify the model

are made:

e Fixed square slurry cross section with no deformation after deposition
¢ No temperature and solid fraction change during deposition itself

e No gaps in the deposited material / full direct connections of roads

e Temperature gradient within the slurry/road cross section is neglected

e Repositioning of the rheocaster/base plate takes no time — no cooling

The simulation was executed to review the maximum height that could be
deposited with fully fused layers'® compared to the deposition rate (see Figure 44)
as well as the best deposition pattern comparing rotational, unidirectional and

alternating patterns (see Figure 43 - Simulated deposition pattern [4]Figure 43).
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Figure 43 - Simulated deposition pattern [4]

8 Assumption was used that the interface need fall within the semi-solid rage for fully fused layers
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Vijh et al. found that the alternating pattern is the most optimal one using the
assumptions. The unidirectional and alternating showed a similar optimal results
but it had to take into account that the repositioning takes additional time so the

slurry would be able to cool.
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Figure 44 - fully dense deposition height based on the extrusion rate [4]

One further assumption Vijh took was that the base plate is heated to the semi-
solid slurry temperature used. When using a closed build environment that may

not be practical due to the heating of the full apparatus.

2.4.3 Solid Freeform Fabrication of metal components by extrusion and
deposition of semi-solid metals
Besides the Stratasys Inc. patent application the work conducted by Finke et al. [2,
71, 108] is the most applicable work towards this dissertation project. Finke in her
dissertation [71] reviewed Pb-Sn, Sn-Bi, Sn-Pb-Bi and AL-Ge alloys for their
applicability for extrusion and deposition of semi-solid metals (EDSSM). As part of
that review solidification experiments (70Sn.30Bi) and Microstructure analysis
(60Pb20Bi & AI-17Ge) were performed. Important extensions of the AlGe
experiments were a review of the influence of cold rolling to the globular particle
size. Finke concluded similar to what was found in the literature before (see also
chapter 2.2.3) that cold rolling reduces the size of the globular particle. Also a cold
reduction above 20% did not have any further reduction effects as well as the effect

itself will be visible over time increase for longer isothermal holding times 15-30min.
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Using Sn70Bi30, rheological studies were performed with three types of
experiments: a capillary viscometer, plate-plate rheometer and a back-extrusion

experiment (see Figure 45).

| PC Motor&
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Figure 45 - Rheological studies of Finke [71] a) capillary viscometer, b) plate-plate rheometer, c) back
extrusion experiment

Only the back-extrusion experiment produced meaningful results to evaluate the
filament material towards its appropriateness for EDSSM. During back extrusion a
power law index of n=0.8 was determined. Also significant segregation could be
identified in the capillary and back extrusion experiment. When reviewing the
results Finke concluded that the segregation effects can be observed when the
force is below a critical value at a certain velocity. When comparing the force
required for squeezing out the liquid and the normal force required for extrusion,
those force functions meet at a critical velocity (see Figure 46) e.g. 8-9*10-3m/s for
Pb60Sn40 at 0.4 fs.
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Velocity (m/s)

Figure 46 - Force resulting in segregation (solid) vs. extrusion force (dotted) [71]

This led to a start-stop phenomenon where higher liquid content in the semi-solid
was extruded during the start and after reducing velocity in some cases clogging

was observed as well as delayed stopping and liquid droplets.

Finke measured the extrusion force via a load cell integrated in the experimental
nozzle (see Figure 47) and compared this with the calculated extrusion forces via
existing models. Measurements have been observed with 3-times higher force
values but a model that would fit the real values has not been found. Finke
concluded that a model for the required force could be used for a more direct
control of the segregation via changes of applied force when it drops below the

critical value.
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Figure 47 - Experimental nozzle including force measurement via load cell [71]

Finke reviewed the bonding requirements and concluded on the basic requirement

from Rice et.al.[3] that the interface temperature must fall in the semi-solid range

and that one possibility is a heated build environment just below the semi-solid

range (e.g. 160°C for a filament temperature of 210°C resulting in an interface

temperature of about 185°C).

The extrusion rate compared to the x-y velocity was determined to be at a rate of

1:1. When reviewing the extrusion itself Finke concluded that shear thinning

through the extrusion could not be observed at an extrusion ratio of 25.

Finke overall found the following problems that need to be reviewed:

e Segregation and clogging at a low filament velocity or force

e High environment temperature leads to lower mechanical properties of the

extruded part

e Coarsening of the microstructure during holding times
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e Capillary and plate-plate rheometer are not adequate to review such semi-
solid alloys

e Force measurement and control should be applied and a model needs to
be developed to differentiate between friction, extrusion and capillary force

to detect and compensate for inhomogeneous flow

As one of the key results Finke developed a process window for EDSSM that
allows an application to build 3 dimensional parts using Pb40Sn60 (see Figure 48)

and demonstrated that this window is sufficiently large to operate in.
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Figure 48 - Process window for EDSSM a) 3D quantitative representation, b) cross section through
the process volume

Finke concluded her work by discussing the application of her results to an

aluminum alloy filament and suggested the following design elements:

e Grain refinement should be used to allow minimal grain size / small nozzle
orifice while assuming that the grains should not be larger than 1/6 of the
nozzle orifice.

¢ Induction heating should be used compared to resistive heating which also
is assumed to reduce the start stop phenomena. A heating with a power of
2KW and a frequency of 500kHz to 1.2MHz was tested and deemed

adequate.
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e To reach the interface temperature, (sub) build environment heating,
selective laser heating and selective induction heating was discussed
where the preference was selective inductive heating.

e To stabilize the particle size or also allow larger grains without clogging,

nozzle agitation was suggested e.g. via piezo agitation.

2.4.4 Stratasys Patent for FDM with metal

Stratasys Inc. has filed a patent application[111] for a system that uses semi-solid
metal to create layer based 3D objects. This basically describes their FDM
apparatus for use with semi-solid metals. This patent application includes a friction
wheel or screw pump filament transport mechanism, a heated build platform above
350°C and an oxygen free build chamber. The patent application also explains the
expected creation of non-dendritic microstructures to allow a semi-solid deposition

at a sufficient viscosity.

Worthy to note is that the example extrusion of the AISi alloy was at 610°C and if
this was done using A356 or a similar alloy with such a silicon portion the
temperature range would be in a very sensitive range in terms of changes of
viscosity (see section 2.1.8). Also, as the example microstructures shown in the
figures are only from heating experiments and no final extruded 3D objects are
displayed, it is assumed that Stratasys does not yet have the full process under

control.

2.4.5 Use of low melting temperature soldering alloys

Mireles et al. [112, 115] refitted a Stratasys FDM 3000 system with a straight
liquefier (see Figure 49) to reduce the pressure drop and therefore the extrusion
force (see also section 2.3.2.3) to support the extrusion of two low melting
temperature soldering alloys (eutectic Bi58Sn42 and non-eutectic Sn60Bi40). The
extrusion of both alloy types is done above the liquidus temperature and not in the
semi-solid range of the non-eutectic alloy. Still Mireles et al. could create multi-
layer 3D objects using this soldering alloy (see Figure 50).
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Figure 49 - a) standard curved liquefier of FDM 3000 b) added a strait liquefier [115]
Mireles also demonstrated extrusion of a metal alloy combined with the extrusion
of ABS filament. This was tested to prove the combination of the two materials to

for example allow embedded electronics.

Figure 50 - Extrusion examples for a) 2D and b) 6 layer 3D structures [115]

Mireles et al. concluded that further research on higher melting metals and better
temperature control resulting in microstructure and interfacial bonding control is

required.

2.4.6 Direct metal writing with rheocasting approach

Chen at al. [113] performed further (see also section 2.4.1) experiments with a
rheocaster approach. The work was published as Direct Metal Writing DMW using
BizsSN2s instead of SNssPb1s by Rice et al. [3]. The Rheocaster was designed
using multiple resistive heating circuits with thermocouple feedback (see Figure
51) resulting in a precision of +2°C. During the experiments a nozzle orifice
diameter of Tmm with a substrate distance of 0.7mm was used.
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Figure 51 - Direct Metal Writing - a) Rheocaster design b) experiment setup [113]

The extruded material was layered on a substrate and similar to Rice et.al [3]
reviewed were performed whether adequate bonding can be achieved. A critical
influence in the observed bonding was pre-heating of the substrate material (see
Figure 52).

Interface

Figure 52 - Rheocasting bonding a) adequate bonding with pre-heated substrate b) Inadequate
bonding without pre-heating of substrate [113]

This does correlate to the results of the work of Finke [71] and Carslaw et al. [93]

(see Figure 37).
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2.4.7 Fast Desktop-Scale Extrusion Additive Manufacturing
While not direct related to MEAM Go et.al developed, besides a nut based filament
feeding, a double heating system for the FastFFF [70]. This includes a laser-based

pre-heating and a resistive based liquefier heating (see Figure 53).

Quartz
chamber

Threaded [ —[
L

filament J

Laser
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| liquefier
|
Heater |
block
Nozzle

Figure 53 - FastFFF Extruder with laser pre-heating [70]

This process does allow a faster extrusion reaching up to 177cm3/h for 1mm
nozzle orifice. A dual heating process with preheating the filament and then
resistive heating to achieve a semi-solid state might be an applicable approach for
MEAM as well. Pre-heating might be performed by laser or induction heating as

both would allow a fast start up and stopping.

2.4.8 Induction heating of aluminum alloy into semi solid state
As part of a master thesis [114] Garcia developed an induction heating process for
Aluminum-Fused-Filament Fabrication (Al-FFF) using AA6061 (see Table 6 for

composition).

Table 6 - Composition of AA6061 [114]

Si Fe Cu Mn Mg Zn Ti Cr Al
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0.4- 0.7 0.15- 0.15 0.8- 0.25 | 0.15 | 0.04- | Balance

0.8 max 0.40 max 1.2 max max 0.35

For induction heating purposes of AA6061 Garcia developed a feeding enclosure
allowing the oxygen layer free filament processed into the Nozzle (see Figure 54).
The aluminum filament (3.18mm) was manually processed using an abrasive grit
pad to remove the natural aluminum-oxide layer and quickly placed into the oxygen

free feeding enclosure.

OSF with OSF Argon
Integrated L Gas Inlet
Feed —

Mechanism

UOT}ORII(] MO[,] UOSIY
pue pod.J JUSWIE[I]

| Gas Tight Li

Figure 54 - Oxygen shielded feeder for Al-FFF [114]

The initial aluminum oxide ceramic (Al203) nozzle was replaced with a boron nitride
ceramic (BNC) nozzle due to fusion with the semi-solid aluminum alloy. Also the
BNC nozzle broke twice during the experiments as such Garcia proposed future
research needed to build a nozzle that can withstand the high temperature as well
as the lateral and compression stress. During the experiments the work coil

observed incidental induction energy losses due to other system components or
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tooling nearby. This effect has been noted as a potential barrier for an Al-FFF
system. For example, a distance lower then Smm between the work coil and the
bed the amperage raised significantly due to the induced current in the bed. A
spike based (Mesa baseplate) bed was created to minimize the interference with

the work coil.

Ambient air experiments showed the oxide layer prevented the extrusion process
and later experiments showed significant issues with the temperature control of
the induction heater for the narrow semi-solid window. Planned fusion of extruded
material with the base plate was not possible due to the large temperature
difference and only extruded material with overheated material was able to fuse.
Garcia proposed an induction coil at the nozzle tip to head the extruded layer and

allow fusion with the new layer.
The work resulted in a provisional patent 62300188 (not available for public review).

2.4.9 Conclusion of MEAM with thixotropic/semi-solid alloys

It can be seen from the literature that efforts have been made to extrude semi-solid
alloys to build (or integrate in) 3D objects. None of the literature could fully verify
the application of semi-solid aluminum alloys for the MEAM process. But it could

be seen where the challenges could be expected:

e Controlling the microstructure before or during the extrusion and deposition

e Heating of the filament and previously deposited layer

e Managing start-stop phenomena including segregation of liquid and solid
state

e Managing the existing oxidation layer of the filament as its liquid
temperature is above 2000°C

e Managing the oxygen affinity of the deposited layer
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3 INITIAL EXPERIMENTS

3.1 Initial filament review
Using a 2mm diameter Al4018 filament from Drahtwerke Elisental [116] initial
heating experiments at the Foundry Institute - RHTW Aachen [117] were
conducted. This specific filament was chosen as Al4018 appeared to be
insignificantly different from the A356 standard for the purposes of this research,
as it had slightly increased magnesium and decreased copper percentage (see

Table 7) and the filament was commercially available:

Table 7 - Alloy composition compare Al4018 vs. A356

Si Fe Cu Mn Mg Zn Ti Al
Al4018"™ | 6.5- | 0.2 | 0.05 | 0.1 | 0.5-0.8 | 0.2 | 0.2 remaining
7.5
A356 6.5- | 02| 0.2 | 0.1 0.25- 0.2 | 0.2 remaining
7.5 0.45

The filament is produced in a typical drawing process at the manufacturer via the

following steps after initial extrusion to a 9.6mm raw wire:

Drawing process from 9.6mm to 5.8mm
Isothermal holding at 380°C for 10hours

Drawing process from 5.8mm to 3.8mm

B bdh =

Drawing process from 3.8mm to 2.0mm

As mentioned in section 2.2.4 the drawing process is similar to the SIMA process

and during reheating a globular structure can be expected (melt activation).

The as-is filament shows a typical severe deformation microstructure where a grain

size cannot be determined (see Figure 55).

19 DIN EN 573-3
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Figure 55 - as-is filament Al 4018

From conversations with the filament vendor the last step of the filament production
process was performed as a cold operation and no heat treatment was applied
after that. It is expected that this results in an energy increase in the filament due
to an increase of dislocations (see section 2.1.1). Therefore, the filament should
re-crystalize during heating and isothermal holding at a semi-solid temperature
range with a fine globular grain size. This can be compared to the SIMA process

route explained in chapter 2.2.3.

A first experiment of heating the filament was conducted and the expected globular
grain structure was found at an isothermal holding time of 15 minutes (see Figure
58). Further experiments have been conducted to quantify the microstructure
through the fraction solid, form factor and globular diameter. Al4018 with its AlSi7
alloy components should show an approximate 50% fraction solid at 585°C. As
such the factors for the temperature have been defined as 575°C, 580°C, 585°C
and 590°C. The heating time to the target temperature of 585°C was determined
using a type K(Ni-CrNi) thermocouple attached to the flament when heating in the

air-flow oven?® (see Figure 56).

20 Brandhorst air-flow oven including a Nabertherm C40 temperature control unit
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The filament was placed in the air-flow oven on a bed of quarry sand. Within the
first approximately 60 seconds the filament heated up to about 583°C while to

reach the oven temperature of 585°C it took overall 120 seconds.
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Figure 56 — Time required for the filament to reach 585°C in the air-flow oven

After holding for 15 min at the defined temperature the filament was then quenched
in a water bath at room temperature. This process was repeated for the other
temperature factors and micrographs were taken (see Figure 58). The micrographs
were then analyzed using automatic separation®' of grains (see Figure 57 for an
example picture of automatically separated grains) and measurement of form

factor and diameter of the grain assuming a perfect cycle with the same area.

21 Using Carl Zeiss KS400 V3.0
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Figure 57 - Picture of micrograph example 585°C with automatic grain separation and numbering

Using these values the fraction solid has been calculated. Each factor was

repeated 4 times.

The results (see Table 8 and Figure 59) show a small average grain size between
44.6 um and 49.4um which is sufficiently small for semi-solid extrusion and a good
form factor above 0.87. Comparing the temperature 575°C and 590°C coarsening

can be observed (see Figure 58).

Table 8 — filament isothermal holding for 15 min at different temperatures results

T [°C] T [min] fs [%] F Dcircle [um]
575 15 69.6 0.87 44.6
580 15 67.7 0.89 48.1
585 15 66.8 0.88 48.5
590 15 64.5 0.88 49.4
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585 °C  590°C

Figure 58 - Al4018 filament micrographs after 15 minutes isothermal holding

Aside from the diameter and form factor the fraction solid was calculated by the
analysis software and determined as averaging between 69.6% and 64.5% (see
Figure 60). This is much higher than expected through the lever rule, where it
should be around 50%.

As a last experiment it was reviewed how the filament microstructure will evolve
within the first 5 min of isothermal holding after heating to a now constant

temperature of 585°C as that was the previously expected temperature for fs=0.5.

The results show (see Figure 61) that the microstructure evolution only starts at 5
min where before no change is visible compared to the as-is filament. Even at
isothermal holding of 5 min globular grains could not be seen as such the filament
would not be in a state for semi-solid processing where that would need globular

grains.
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Figure 59 - Graph of average grain diameter and form factor vs. temperature
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Figure 61 - Microstructure evolution with the first 5 min of isothermal holding
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Because of the lower fraction solid results as well as the surprisingly late globular
microstructure evolution the filament was analyzed for its components via Mass

spectrometry (see Figure 62).

Impulse/eV

AL-Draht 1
AL-Draht 2

300+

AL-Drant 3

Figure 62 - Mass spectrometry of the Elisental filament

Those results show clearly that the Al4018 standard was not met as the silicon
percentage was an average of 4.29% too low, copper is missing in the alloy, and
silver is with almost 0.5 %, which is 10x higher than the allowed additional

impurities.
Table 9 - Mass Spectrometry results

Mass percent (%)

Spectrum o Mg Al si Fe Ag
Al-Draht 1 0;:84: 0573 93;55: 4;39 0,13 ;35
Al-Draht 2 0,67 0,73 93,45 4,53 0,16 0,44
Al-Draht 3 0,59 0,78 93,90 3,95 0,14 0,64
Average 0,70 0,75 93,63 4,29 0,15 0,48
Sigma: 0,13 0,03 0,23 0,30 0,01 0,14
Sigma Average: 0,07 0,02 /0,130,318 0,01 0,08

When estimating the filament alloy found in the Elisental flament with a simple
Thermo-Calc® calculation for AISi4.29, matching solid fraction rates can be
calculated as shown in Figure 63. This would result in a liquidus temperature of
635°C and a temperature for the 50% solid fraction of about 610°C.
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Figure 63 - Estimation of the Elisental filament using Thermo-Calc with Al-Si4.29

The above shows that the processing parameter for the Elisental filament needs
to be adapted if used for the semi-solid extrusion. As major elements are missing
and the effects of the silver impurity is unknown, this initial experiment did not
provide much knowledge or experience related to whether an A356 aluminum alloy
can be used without major verification. In other words, the microstructure and

thixotropic attributes at about 50% fraction solid still need to be studied. It has to

be evaluated whether production of a real A356 aluminum alloy filament would be

more efficient.

3.2 Metal MEAM test apparatus components and design

For the execution of extrusion experiments and later 3D object modeling the

following components need to be engineered and later integrated:

e a heating channel with either restive or induction heating
e an aluminum filament transport mechanism

e a 3D gantry system

e an oxygen free build chamber

e potentially a full or selective heating device for deposited layer
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For the experiments a nozzle with a high temperature resistive heating channel

has been designed by Hotset® Heizpatronen und Zubehér GmbH (see Figure 64

and Figure 65) using a hotspring® coil heater with 300W. The company has

experience with tin and zinc-based pressure die casting which requires about

100°C less processing temperatures than the expected aluminum alloy processing.

The nozzles are connected to a control unit with 2 temperature control circuits (see

Figure 66).

ineral sulated thermacoaple A0 =

Figure 64 - Hotset® heating nozzle design
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Figure 66 — Resistive heating channel and control unit
It is planned to use the heating channel for extrusion but possibly also for the pre-
treatment of the filament to allow for microstructure evolution. Later on, one nozzle

was improved by adding a replaceable nozzle tip.

For the filament transport a feeding device (see Figure 67) that allows internal slip

and external process control has been acquired. The unit is used for filament

feeding in robotic soldering installations.
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Figure 67 - Wire feed and control unit [118]

A potential 3-dimensional motion system is being realized with an Isel modular
CNC base system (see Figure 68). The system is controlled through G-code
software, break out board and step motor drivers. For the completion of the first 3-
D deposition system the wire feed components need to be integrated with the G-
Code software while the temperature control unit can be separately controlled
manually. The 3D motion system has been tested as a rep-strap?? [119] type 3D
printer using ABS and PLA.

Figure 68 - Isel Modular 3-D motion system

The Isel-Modular will be housed in a closed compartment that can be vented with
inert gas e.g. argon. The compartment will be used also for initial extrusion proof

of concept without the 3D motion system.

22 Rep-strap is the term used by the community for re-use of other machines as a rep-rap type 3D
printer
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A chamber or selective heating system need to be developed after initial extrusion
of several layers and a first bonding review. With the current equipment chosen it
is not likely to use a building chamber heating as the components have only a

specified working temperature range below 100°C.

To allow initial heating and extrusion experiments a nozzle mount has been
created. It had to be stripped to a relatively thin but stable mount that allows both
the nozzle and the nozzle insulation to be held. A pure nozzle mount results in a

large temperature loss
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Figure 69 - Filament heating and extrusion test setup

3.3 Material choice and filament production
Due to the silver impurity and the missing silicon fraction (see 3.1) it has been
decided to use a proper A356 material and one more reference material. In
discussion with Salzburger Aluminium AG (Lend/Austria) material has been
identified as A356 (THIXALLOY® - 630) and THIXALLOY® - 540 as reference
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material. Both materials are provided in thixo-casting ready state. The company
prepares the material through patented extrusion and magnetic stirring process
which allows thixotropic processing after a defined inductive heating. Table 10 and

Table 11 show the respective composition of the alloy.

Table 10 - A356 (THIXALLQY 630) / AlSi7MGO0.5 composition (exclusive Al)

Si Fe (max) Cu (max) Mn (max) Mg Ti
6.5-75 0.15 max. 0.05 max. 0.10 | 0.25-0.40 | 0.01-0.15

Table 11 - THIXALLOY - 540/ AIMg5Si2 composition (exclusive Al)

Si Fe (max) [ Cu (max) Mn Mg Zn (max) Ti

1.8-2.6 0.20 0.02 0.25 5.0-6.0 0.07 0.01-0.05

The raw material is delivered in form of 76mm and 88mm diameter rods each 6m
long (see Figure 70a). As a preparation of the filament extrusion the rod material

has been trimmed down to bolts of 28mm x 100mm size (see Figure 70b).

Wy

Figure 70 - Raw material (a —rod, b —reduced bolt)
Filament has been produced with a 0.5MN Extrusion press (see Figure 71 a) with
the parameter as shown in Figure 71 b and Table 12. A problem identified during

the filament production was the adhesive tendency of the A356 alloy. This resulted
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in clogging and cleaning several times. A small sample of THIXOALLQY - 540 has
been produced as well using similar processing parameters. The adhesive
tendency was not as strong as with A356.

Table 12 - Filament extrusion process parameter

Material Bolt Temp Press Die Ratio | Ram
Cylinder speed

DB|Lin| TB|DC|TC|DD|TD]| [] V
mm | mm °C mm “C mm “C mm/s

A356 28 100 | 420 30 400 | 2(4x) | 420 56 3

Extrusion Force [KN]

T T T T T T T T 1
75 100 125 150 175 200 225 250 275 300
Punch path [mm]

Figure 71 - 0.5MN extrusion press and recorded processing parameter
To understand the microstructure before and after a micrograph analysis has been
conducted. In general, dendritic microstructure of the raw material are dissolved
after extrusion. See Figure 72, Figure 73, Figure 74, Figure 75 for micrograph

pictures and Table 13 for analysis results.

Table 13 - Microstructure analysis results of raw and extruded material

Material A356 THIXALLOY 540
Raw Rod |- Dendritic structure with | - Dendritic structure with
globular grain globular grain

84



- Scattered precipitates up to
2um size within dendrite

arms

Scattered precipitates up to
2um size at dendritic border

and between dendrite arms

- Structure dissolved

- Homogenous precipitates

Structure dissolved
Homogenous precipitates

Individual coarse precipitates

Figure 72 - A356 (THIXALLOQOY 630) raw rod material a) 25x magnified b)
50x magnified c) 50x magnified d) 200x magnified
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Figure 73 - A356 extruded filament a) 50x magnified b) 100x magnified
¢) 200x magnified d) 500x magnified

c)

L
50 ym

Figure 74 - THIXALLOY 540 raw rod material a) 50x magnified b)
100x magnified c) 200x magnified d) 500x magnified
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Figure 75 - THIXALLOY 540 extruded filament a) 50x magnified b) 100x magnified
¢) 200x magnified d) 500x magnified

3.4 Initial proof of concept testing
With the availability of new filament material (A356) a proof of concept setting was

built using the heating nozzle, the wire feeder and a housing with inert argon gas
(see Figure 76).

The apparatus was tested in terms of heating up to 650°C to allow liquid extrusion
if needed. The wire feeder was tested with the heating channel i.e. removing the

nozzle tip from the enhanced nozzle.

Extrusion and heating experiments with A356 and the Al4018 resulting in clogging

and adhesion to the nozzle wall. No controlled extrusion was possible.



Figure 76 - Proof of concept extrusion setting

This failed proof of concept showed that the material and process parameter need
to be closely controlled. As planned prior the following reviews need to be

performed:

e Temperature management in the resistive nozzle and resulting liquid

fraction of the alloy — Simulation

e Compare temperature management through inductive heating as used in
semi-solid casting — Simulation

e Microstructure evolution — Experiments

e Microstructure time dependency though coarsening (aging) - Experiments
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4 SIMULATION AND EXPERIMENT

4.1 Simulations

4.1.1 Simulation of heated channel changes

To understand the heating channel behavior under semi sold processing condition
a thermal analysis simulation has been conducted with SolidWorks. Important for
the extrusion process and design dimension of the nozzle is how much the
dimension of the heating channel changes from ambient (20°C) to semi-solid
temperature (585°C). This is especially important regarding potential segregation
and back-extrusion of the liquid phase. The expansion of the nozzle was observed
during commissioning of the Nozzle from Hotset. During delivery testing the
insulation cracked at about 350°C (see Figure 77). The supplier replaces both
insulations and determined the incorrect expansion calculation and therefore

required larger inner diameter of the insulation as the cause.

Figure 77 - Cracked nozzle insulation due to expansion at elevated temperature

While the temperature for this simulation is assumed uniform (at 585°C) the
displacement vector (URES) shows the highest value at the nozzle top and bottom
(see Figure 78c). The dimension of the heating channel changes by about 1% from
designed 2.1mm to 2.12mm.
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Figure 78 - Heating channel simulation a) nozzle entry dimension at ambient temperature
b) displacement vector at 585°C c)nozzle entry dimension at 585°C

4.1.2 Simulation of resistive heating

To understand the heating of the filament in a resistive heating channel a
simulation has been conducted with Ansys Fluent. As the material liquifies through
the heating process it is important to model the flament material correctly in the
simulation. For that purpose, linear approximation of calculated values from
JMatPro V8 for the fluent model of A356 have been used.

Besides the temperature dependent density (see Figure 79) especially the specific
heat required to increase the temperature by 1K (see Figure 80) as well as the
thermal conductivity (see Figure 81) were reviewed and piecewise linear
approximations are defined. For completeness of the material model for Fluent the
approximated total viscosity (see Figure 82) has been included as well. Note that
this viscosity will change with the dendritic or globular microstructure (see section
2.1.5 and Figure 9). As the heating simulation does not include an actual nozzle
but just a heating channel this can be neglected. The material model is completed
by the solidus temperature (555°C/828.15K), the liquidus temperature
(615°C/888.15K) and the pure solvent melting heat or heat of fusion (389000 J/Kg).

This more accurate material model was used throughout the simulations.
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Density A356 Model and Approximation
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Figure 79 - A356 Density / Temperature model and approximation
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Figure 80 - A356 Specific Heat / Temperature model and approximation
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Thermal Conductivity A356 Model and
Aproximation
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Figure 81 - A356 Thermal Conductivity / Temperature model and approximation
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Figure 82 - A356 Viscosity at liquid temperatures model and approximation

4.1.2.1 Ideal Nozzle
The initial resistive heating simulation was performed using an ideal uniform

temperature distribution in the nozzle wall heated by the resistive coil heaters at
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the outside wall of the nozzle (see Figure 83 for actual nozzle and Figure 64/Figure

65 for design).

Figure 83 - Nozzle inside with resistive coil heaters and thermocouple connection

With the material settings for A356 and the ideal nozzle approach (uniform 585°C
for 50% Fs/FL) several inlet filament velocities have been simulated (0.1mm/s,
1mm/s, 2mm/s). With 2mm/s the simulation showed the maximum velocity still
achieving the 585°C / 50% fraction solid/liquid (see Figure 85).

ANSYS
R17.1

Academic

g

0 001 002 (m)
0.005 0.015

Figure 84 - Temperature contour for ideal/uniform nozzle temperature at 585°C, 2mm/s
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Mass Fraction Temperatur at Filament Center Line
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Figure 85 - A356 Simulation results for ideal/uniform nozzle temperature at 585°C, 2mm/s
Mass fraction liquid and temperature

As shown in Figure 83 the resistive heating coils are not uniformly distributed
throughout the nozzle wall. As such a non-uniform temperature distribution within
the nozzle is expected. The next step in simulating the real nozzle is to identify the

temperature distribution.

4.1.2.2 Nozzle temperature verification

To identify the distribution function in the nozzle the temperature has been
experimentally recorded. Due to the nozzle temperature fluctuation as well as
expected measurement error (measurement depth, temperature, etc.), design of

experiment was used (see section 0).

After definition of 2 factors (2 temperature setting levels, 8 sensor depth levels)
and a pre-experiment of 2 samples were conducted resulting in a full factorial
design of 80 runs. The results (see Figure 86 and section 0) show an inadequacy
of a linear model for the temperature distribution (calculated as delta temperature

= actual temperature — setting temperature).

For purpose of the simulation the following temperature profile function has been
determined for A356 and 585°C setting through a fitted line of the average values

determined by the experiment (see Figure 87):

T(x) = 702.5 + 8545 * x — 108048 * x? 4.1
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Individual standard deviations were used to calculate the intervals.

Figure 86 - Interval Plot for temperature delta from temperature setting

Fitted Line Plot
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Figure 87 - Fitted line plot and temperature distribution function
for 585°C / 858K temperature setting
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4.1.2.3 Adapted temperature distribution within the nozzle
The adapted nozzle temperature function was added as a User Defined Function
(UDF) into ANSYS Fluent (see Figure 88). In addition to the adapted temperature

profile, the convection at the outlet has been taken into account assuming ambient

temperature.
/
J/* Nozzle_Cell Temp_Profile.c =y
/* UDF for specifying steady-state Temperature profile condition in Nozzel */
/

/* includes the standard macros stored in the udf.h header file */
#include "udf.h”

/* starts the define profile function used for face profiles but can also be used for cell profiles */
DEFINE_PROFILE(Nozzle_Temp_Profile Channel, threat, index)

{
/* Variable definitions */
cell_t cell; /* define cell as cell threat index =/
real position[ND_NDJ; J* this will hold the position wector x=position[®],y=position[1] only in case 3D z=position[2]
- ND_ND macro hold the constant as per 2D (ND_ND=2) or 3D (ND_ND=3) case*/
real x; /* define x as a real variable to store the x position of a given cell and use that to calculate

the temperature */
/* Loop over all cells in the given threat by the DEFINE_PROFILE Macro */
begin_c_loop(cell, threat)
/% gets x,y and for 3D cases z coordianted for a given cell and stores it in the position array with x=position[@],y=position[1]
only in case 3D z-position[2] */
K_CENTRDID(pusitiun,Eell,threat)

/% get the x position from the position array from its [B] array element */
x = position[8];

/* assign the calculated temperature to the C_PROFILE macro that will store this in the cell attributes */
C_PROFILE(cell,threat,index) = 702.5+8545%*x-108048*x*x;

end_c_loop(cell,threat)

Figure 88 - ANSYS Fluent User defined function to apply the nozzle temperature distribution

The results of the simulations (see Figure 89) showed a significant deviation from
the initial uniform results (see Figure 85) and are aligned with observations during

the proof of concept and experiments.
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Figure 89 - Adapted Simulation Results for A356 heating with nozzle temperature profile
Contour for resulting temperature and mass fraction liquid with setting 585°C / 858K

4.1.3 Simulation of inductive heating

To compare the induction heating with the resistive heating and to understand the
potential application in a MEAM machine a simulation has been conducted. First
preparation for a simulation is to understand the temperature dependent electrical
resistivity / conductivity as shown in Figure 90. While Garcia [114] in his induction
heating MEAM approach did not deem this as significant i.e. neglected that, it is
strongly recommended by ANSYS to include the temperature dependency of the

electrical conductivity.

Electrical Conductivity Model and
Approximation
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5000000

0
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~ I I
[32] <

Temperature in °C
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220

Electrical Conductivity in 1/Ohm*m
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==@==|MatPro Electrical Conductivity Mode| ==@==|inear Approximation

Figure 90 - A356 Electrical Conductivity / Temperature model and approximation
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The next preparation step for the induction heating simulation is to identify a
meaningful frequency (f) to be applied throughout the temperature range. Key
influencing factors (see also equation 2.35) are the adequate skin depth (&) for a
thorough through heating and the electrical resistivity (o). As aluminum is a non-
ferrous metal the relative permeability (u,) is 1.00002 i.e. can be neglected and

only the magnetic constant (1, = 1.25664E — 06) becomes relevant.

g

f

4.2

T T

Using the formula 4.2 the frequency can be calculated for various skin depths
around 4 of the filament diameter as referenced by Haimbaugh [120]. Table 14

shows the resulting frequencies for different skin depth and temperature.

Table 14 - Frequency calculation based on skin depth and temperature

Skin Depth | Temperature | Electrical resistivity Frequency
inm in °C in (Ohm*m) in kHz
0.0005 25 3.98005E-08 40
0.0005 555 1.1981E-07 121
0.0005 585 1.9898E-07 202
0.0005 620 2.6363E-07 267
0.0005 700 2.7851E-07 282
0.00033 25 3.98005E-08 93
0.00033 555 1.1981E-07 279
0.00033 585 1.9898E-07 463
0.00033 620 2.6363E-07 613
0.00033 700 2.7851E-07 648
0.00067 25 3.98005E-08 11
0.00067 555 1.1981E-07 23
0.00067 585 1.9898E-07 28
0.00067 620 2.6363E-07 30
0.00067 700 2.7851E-07 26

To allow an efficient heating at the target temperature (see Table 14) the frequency

has been chosen as 200kHz for the Simulation.

A design with ANSYS Maxwell for the eddy current simulation and ANSYS Fluent
has been created as seen in Figure 91. For the geometry a basic heating channel

98



has been drawn with the filament inside and a 10 turn inductive work coil
surrounding the channel (see Figure 92a). From that a 2D symmetric cross section
has been created and used for the Maxwell and ANSYS simulation. For the
Maxwell materials glass as an example nozzle material has been used and a
filament material designed (referencing A356) using the temperature dependent

approximation for the electrical conductivity/resistivity (see Figure 90).
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Figure 91 - Ansys induction heating simulation setup with Maxwell and Fluent
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Figure 92 - Induction heating simulation geometry design
a) 3D model b) 2D symetric cross section of 3D model

During initial simulations the ampere excitation for about 50% liquid fraction has
been determined and simulations been run to understand the sensitivity of the work
coil excitation vs. the liquid fraction. Each simulation requires multiple runs of
Maxwell and Fluent as the feedback between both parts of the simulation is manual.
All Fluent simulations have been done with a filament / inlet velocity of 0.005m/s

as a low speed / controlled extrusion.
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Table 15 - Induction heating simulation run results for excitation of 315 Ampere

Ohmic Losses | Max Temperature | Max Fraction Liquid | Maxdelta T

Run in W in °C in % in °C

1 12260 560 7.8 -

2 18691 573 30.5 538

3 20009 581 42.5 79

4 20292 582 45.3 12

5 20346 583 46.1 1.9

6 20361 583 46.2 0.4

Table 16 - Induction heating simulation run results for excitation of 318 Ampere

Ohmic Losses | Max Temperature | Max Fraction Liquid | Max delta T

Run in W in °C in % in °C

1 12495 560 8.7 -

2 19116 575 33.1 538

3 20490 583 47.9 78.9

4 20821 585 50.6 12.6

5 20882 586 51.6 1.7

6 20898 586 52.2 0.7

Table 17- Induction heating simulation run results for excitation of 321 Ampere

Ohmic Losses | Max Temperature | Max Fraction Liquid | Maxdelta T

Run in W in °C in % in °C

1 12732 561 9.6 -

2 19546 578 37.3 539

3 20982 587 52.5 78.5

4 21374 589 56.3 12.4

5 21450 593 63.1 2.3

6 21455 589 57.2 3.5

7 21451 589 56.7 3.1

8 21451 593 63.1 0.9

Figure 93 shows the resulting ohmic losses in Maxwell after one run in the eddy
current simulation including the flux lines (left) and after all Maxwell — Fluent
temperature feedback loops (right). After the initial eddy current simulation, the
filament shows nearly the same ohmic losses from the Inlet (top) to the outlet

bottom. After all temperature feedback loops the ohmic losses increases due to
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the stable frequency (200 kHz) but larger dependent penetration depth at higher
temperature. After the first run the maximum liquid mass fraction is in each
excitation cases (315A, 318A, 321A) below 10%. This shows the significance of

the temperature dependent electrical conductivity for the simulation.
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Figure 93 - Ohmic Losses - left) after one simulation pass right) after last simulation pass

4.2 Experiments

4.2.1 Heating to globular microstructure experiment

Based on current microstructure condition of the filament (see section 3.3), the
simulation results (see section 5.4) and nozzle temperature distribution (see
section 4.1.2.2) an experiment has been designed to identify an adequate process
for globular microstructure preparation ready to extrude in a semi-solid state. The
goal is to choose the adequate parameter for a following extrusion experiment as
well as understand the parameter - response relationships. For that purpose, the
Rheocast Quality Index (RQI — see section 2.1.10 and equation 2.20) was chosen
as the metric. Besides the RQI it is important to also observe grain size and if
possible verify the fraction liquid.
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To achieve a relative uniform temperature for the heated alloy a 2cm sample
filament size was chosen at the most temperature-stable area (Placement depth:
2cm — 4cm) of a nozzle without a neck. For that the replaceable nozzle tip was

removed (see Figure 94 left).

To reduce the adhesion of the semi-solid material with the nozzle wall Boron
Nitride ceramic spray (see Figure 94 right) has been applied to the nozzle and the

filament?3,

Figure 94 - left) Nozzle without tip right) Boron Nitride ceramic spray

The heating as well as following experiments were performed using metal pins
(see Figure 95 left for a pin in the test tube) as a piston to push the sample through
the channel or later through the nozzle neck. A test tube has been used to quench
the sample as well as keep the extruded sample oriented for marking. The

following setup and execution process was used for each sample:

1. Review clean and coated nozzle
2. Prepare 2cm filament (A356 or THIXALLOY 540) with Boron Nitride

3. Heating nozzle to the temperature range and wait 5 min

23 Note: this is not an adequate approach for future layer bonding as the ceramic coating of the
filament would restrict the bonding to the next layer. It has been applied on both nozzle and filament
to ensure a more effective coating. A future MEAM nozzle would be produced using coating
processes such as Chemical Vapor Deposition. This would be applied to the nozzle only.

102



Find setting temperature for target temperature +2°C at 3.5cm
Insert Filament 2cm deep into the heating channel

After target time passed press sample into the test tube with water

N o o &

Mark the sample upper area and document

Ao f \,'\
Nozzle h
without tip [
J‘\"’ Lk

camera

Test glass

(.
"clogging‘,‘

o

Figure 95 — Left) Experiment Setup right) sample results

The experiment execution was designed using DOE. For that the initial heating

experiment was used to identify the standard deviation.

Table 18 - Initial heating experiment results

Temperature in °C Run Average Diameter in ym
575 1 45.63
575 2 44.869
575 3 43.788
575 4 44.465
575 5 44.404
580 1 47.833
580 2 47.575
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Temperature in °C Run Average Diameter in ym
580 3 49.082
580 4 47.673
580 5 48.343
585 1 49.614
585 2 47.751
585 3 47.754
585 4 49.213
585 5 48.229
590 1 50.598
590 2 50.909
590 3 47.225
590 4 49.008
590 5 49.475

Analysis of Variance
Source DF Adj SS Adj MS F-Value P-Value
Temp 3 66.37 22.1218 23.71 0.000

Error 16 14.93 0.9331
Total 19 81.29

Calculation of Standard Deviation:
MSE = 0.9331 o =,/ MS;=0.966

Based on the calculated standard deviation a full factorial design was created
using Minitab for each alloy (A356 and THIXALLOY540):

Power and Sample Size
General Full Factorial Design

a = 0.05 Assumed standard deviation = 0.966
Factors: 2 Number of levels: 3; 2

Include terms in the model up through order: 2
Not including blocks in model.
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Maximum Total Target

Difference Reps Runs Power Actual Power
1 15 90 0.95 0.950794
1 13 78 0.90 0.915679
2 5 30 0.95 0.979531
2 4 24 0.90 0.935018
3 3 18 0.95 0.991592

With the design above, 4 replicates to detect a difference of 2um where chosen
expecting an actual power of 0.935 (see also Figure 96). This was deemed
sufficient as the microstructure analysis and further processing is at a significant

cost.

Power Curve for General Full Factorial

—- 13
—-- 15

Assumptions

< o 0,05

[ StDev 0,966

% # Factors 2

o # Levels 3;2
Terms Included In Model

Blocks No

Term Order 2

0,0 0,5 1,0 1,5 2,0 2,5 3,0
Maximum Difference

Figure 96 - Power Curve for full factorial design for the heating experiment

The full factorial randomized design is shown in Appendix 0.

After the first results reviewed it was identified that the lower temperature value for
THIXALLOY 540 was not chosen in a range that develops an adequate
microstructure for analysis (see Figure 97). As this alloy is just a comparative one
it was chosen to rely on the higher temperature only. Further on, due to clogging
within the nozzle, 106 samples attempts were needed to achieve the expected

remaining 40 samples.

105



Figure 97 - Example of THIXALLOY 540 low temperature with inadequate microstructure
For each sample, microstructure analysis was prepared and micrographs where
taken. Due to the length of the sample and measured temperature distribution in
the nozzle a derived model for the 3 micrographs (upper, middle and lower area)
has been created (see Table 19 and Table 20). This results in 120 micrographs for

the 40 samples created.

Table 19 - Temperature model for A356 heating samples with marked overlaps

Temperature
setting at 3.5cm

Temperature of
sample upper area

Temperature of
sample middle

Temperature of
sample lower area

area

Normalized 0°C -3°C 0°C -12°C
585°C (Low) 582°C 585°C 573°C
595°C (High) 592°C 595°C 583°C

Note the highlighted High temperature/lower area and Low temperature/upper
area temperature are just 1°C different within the model. It should be tested
whether the results do not significantly differ from each other. This will also allow
to validate the model if in other cases the temperature would show significant

difference.
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Table 20 - Temperature model for THIXALLOY 540 heating samples

Normalized 0°C -3°C 0°C -12°C

605°C (High) 602°C 605°C 593°C

After micrographs are taken the following measurements need to be completed:

- Microstructure / Macrostructure correlation

- Perimeter and area of each full grain resulting in average values per

micrograph

Figure 98 - Example panorama picture of Microstructure — Sample 18 — A356 15min @ 585°C

Figure 99 - Example of chosen micrograph for sample 18 middle at 50x maginification
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The Micro- and Macrostructure was counted using the method described by Zoqui
[37] (see Figure 100). For each micrograph 5 vertical samples and 5 horizontal
samples are taken (see Figure 101 left) and the average has been used for this
sub-sample (see Figure 101 right).

it ’

<) d) e)
o
A\
R
o AW £ A
A = A
E E
C & [o
D ° D
6
E E'
1) 8) k)
Measured Globules Measured Globules Measured Globules
142
B
172
B

Figure 100 - Macro- and microstructure analysis approach by Zoqui et.al. [37]

RUN 18 m
GS (Makrostruktur) GLS (Mikrostruktur) Ratio GS (Makrostruktur) GLS (Mikrostruktur) Ratio

14,50 16,50 0,88 8,00 8,00 1,00
13,50 15,50 0,87 8,00 11,00 0,73
13,50 14,50 0,93 6,50 8,50 0,76
13,50 14,50 0,93 9,50 10,50 0,90
13,00 13,00 1,00 4,50 7,50 0,60
Average Average
13,60 14,80 0,92 7,30 9,10 0,80
Deviation Deviation
0,49 1,17 0,05 1,69 1,39 0,14
Vertical and Horizontal
GS (Makrostruktur) GLS (Mikrostruktur) Ratio
Average
10,45 11,95 0,86

Deviation
0,12739216

Figure 101 — left) sample micrograph - right) results of macro- and microstructure analysis

The Rheocast Quality Index (RQI) requires relatively precise measurement of
perimeter and area of the grains. Therefore, the grains have not been automatically

segmented as done prior in the initial filament review (see section 3.1). This had
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led to a higher spherical shape than observed in the sample. Imaged and Gimp
have been used to process the images through a multi-step approach as shown in
Appendix 0. The main process steps are smoothing, removal of scale, black/white
transfer, removal of small particles (see Figure 102a), manual grain segmentation

(Figure 102b), inverting (Figure 102c) and measuring (see Table 21 and Table 22).

Figure 102 — Sample 18M image processing a) BW transfer & smooth b) manual segmentation
c) inverted final image for measurement

Eleven Micrographs are found where an analysis is not possible due to inadequate

microstructure development. Those have been excluded from further review.

Table 21 - Example of individual grain results of sample 18

Grain count Area Perim. Circ.
1 160.387 46.565 0.93
2 5056.275 274.596 0.843
3 35771.029 | 1277.821 0.275
4 3080.462 223.169 0.777
5 130.718 42.631 0.904
6 2988.874 220.003 0.776
7 2535.232 202.197 0.779
8 23103.897 687.298 0.615
9 1243.967 132.53 0.89
10 325.504 77.141 0.687
82 5478.957 287.525 0.833
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Table 22 — Area and perimeter average of Sample 18M

Average Average

Sample Count | Total Area Size %Area |Perimeter| Circularity
18 M —-FS

without 119 | 898704.642 | 7552.14 | 72.895 | 359.735 0.661
entrapped FL
18M=FSwith |15 | g83002.07 | 7420.942 | 71.629 | 359.735 | 0.658
entrapped FL
18 M — border

grains 82 618622.513 | 7544.177 | 50.177 | 353.874 0.704
removed

The above results have been used to calculate the RQIl as shown in Table 23.
See Appendix 0 and 0 for all A356 and THIXALLOY 540 results.

Table 23 - RQI calculation example for sample 18

Actual Shape
Run | Temp Area Perimeter | Factor | Diameter | GS GLS RQl
18 573 | 9494.525 | 429.110 | 1.54 88.50 10.25 | 11.25 0.590
18 585 | 7544.177 | 353.874 | 1.32 85.28 10.45 | 11.95 0.662
18 582 |10513.767| 442.178 | 1.48 95.11 9.60 | 11.50 0.564

For the failed sample attempts it has been tested whether the Alloy, Temperature
or holding time has a significant effect on the failure occurrence (see Appendix
0). There is now evidence of such effects and it is assumed that those failures

are random.
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Interval Plot of RQI
95% Cl for the Mean
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Individual standard deviations are used to calculate the intervals.

Figure 103 - Interval plot of RQI for temperature settings, alloy and hold Time

With the RQI results at hand the first review required is to verify the temperature
model i.e. whether the A356 samples High Temperature / upper area vs. Low
Temperature / lower area have a significant effect on the RQI. As the ANOVA
below shows there is no statistical significance in those sample groups for this

factor. As such the model is deemed appropriate.

General Linear Model: RQI versus O-M-U; Hold Time

Factor Information

Factor Type Levels Values
O-M-U Fixed 2 O U
Hold Time Fixed 3 15; 20; 25

Analysis of Variance

Source DF AdjSS  AdjMS F-Value P-Value
O-M-U 1 0.000423 0.000423 0.08 0.781
Hold Time 2 0.068091 0.034046 6.45 0.009

Error 16 0.084511 0.005282

Lack-of-Fit 2 0.009889 0.004944 0.93 0418
Pure Error 14 0.074622 0.005330

Total 19 0.158706
Model Summary
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S R-sqg R-sq(adj) R-sq(pred)
0.0726769 46.75%  36.77% 15.40%

Residual Plots for RQl
Normal Probability Plot Versus Fits
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Figure 104 - Residuals Plot for the A356 Temperature Model verification

To understand the main effects and potential interactions the below ANOVA was
reviewed. The results show no significant effect on the hold time and actual
temperature interaction but a significant effect of the hold time and temperature

independently.

General Linear Model: RQI versus Hold Time; Actual Temp
Method

Factor coding (-1; 0; +1)
Factor Information

Factor Type Levels Values
Hold Time Fixed 3 15; 20; 25
Actual Temp Fixed 5 573; 582; 585; 592; 595

Analysis of Variance

Source DF AdjSS AdjMS F-Value P-Value
Hold Time 2 0.07954 0.039770 9.70 0.000
Actual Temp 4 0.04315 0.010789 2.63 0.046

Hold Time*Actual Temp 8 0.03178 0.003972 0.97 0.471
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Error 48 0.19685 0.004101

Total 62 036334
Model Summary

S R-sq R-sq(adj) R-sq(pred)
0.0640387 45.82%  30.02% 0.00%
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Figure 105 - Residual Plot for the A356 hold time and temperature effects on RQI
Besides the RQI, the Grain Size / Diameter of the semi-solid alloy is important

especially for the size of the nozzle neck, the smaller diameter channel and outlet
(see Finke [71]).

Below ANOVA shows the Grain Size (Diameter calculated Diameter =
4*Area/Perimeter) is only affected by the hold time and not the temperature or

interaction.

General Linear Model: Diameter (D=4A/P) versus Hold Time;

Actual Temperature
Factor Information

Factor Type Levels Values
Hold Time Fixed 3 15; 20; 25
Actual Temp Fixed 5 573; 582; 585; 592; 595

Analysis of Variance

Source DF AdjSS AdjMS F-Value P-Value
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Hold Time 2 1052.6 526.31 7.39 0.002

Actual Temp 4 3796 9491 1.33 0.271

Hold Time*Actual Temp 8 7153 8942 1.26 0.289
Error 48 34175 71.20

Total 62 54722
Model Summary

S R-sqg R-sq(adj) R-sq(pred)
843787 3755%  19.33% 0.00%
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Figure 106 - A356 Residual Plots for effects on Grain Size

The fraction solid is not determined by any of the factors as shown below:

General Linear Model: FS versus Hold Time; Actual Temp
Factor Information

Factor Type Levels Values
Hold Time Fixed 3 15;20; 25
Actual Temp Fixed 5 573; 582; 585; 592; 595

Analysis of Variance

Source DF AdjSS AdjMS F-Value P-Value

Hold Time 2 20.88 10.44 0.36 0.701
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Actual Temp 4 23423  58.56 2.01 0.109
Hold Time*Actual Temp 8 35444 4431 1.52 0.176
Error 48 1401.75 29.20

Total 62 2033.20
Model Summary

S R-sq R-sq(adj) R-sq(pred)
540399 31.06%  10.95% 0.00%

The THIXALLQOY 540 has been reviewed with a single setting temperature and as
such with only 3 observed temperatures as per model in Table 20. Overall as
shown in the below ANOVA tables the RQlI is only affected by the hold time. The
Grain Size / Diameter is affected in contrast to A356 by the hold time and

temperature.

General Linear Model: RQI versus Hold Time; Actual Temp

Factor Information

Factor Type Levels Values
Hold Time Fixed 3 15; 20; 25
Actual Temp Fixed 3 593; 602; 605

Analysis of Variance

Source DF AdjSS  AdjMS F-Value P-Value
Hold Time 2 0.043083 0.021541 422 0.027
Actual Temp 2 0.002275 0.001137 0.22 0.802

Hold Time*Actual Temp 4 0.005026 0.001256 0.25 0.909
Error 24 0.122484 0.005104

Total 32 0.170887
Model Summary

S R-sq R-sq(adj) R-sq(pred)
0.0714388 28.32% 4.43% 0.00%
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Residual Plots for RQI
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Figure 107 - THIXALLOY 540 Residuals Plot for RQI

General Linear Model: Diameter (D=4A/P) versus Actual
Temperature; Hold Time

Factor Information

Factor Type Levels Values
Actual Temp Fixed 3 593; 602; 605
Hold Time Fixed 3 15; 20; 25

Analysis of Variance

Source DF AdjSS AdjMS F-Value P-Value
Actual Temp 2 22330 111.649 5.81 0.008
Hold Time 2 317.89 158.946 8.26 0.002

Error 28 53850 19.232
Lack-of-Fit 4 9.86 2.466 0.11 0.977
Pure Error 24 52863 22.026

Total 32 109592
Model Summary

S R-sq R-sq(adj) R-sq(pred)
438544 50.86%  43.84% 31.98%
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Residual Plots for D=4A/P

Normal Probability Plot Versus Fits
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Figure 108 - THIXALLOY 540 Residuals Plot for Grain Size / Diameter

4.2.2 Aging experiment

The aging experiment was designed to understand the time-based development
of the microstructure within the filament after a semi-solid processing state has
been reached. In practical terms for MEAM it would be significant for a re-heating
of an already globular material for immediate extrusion. In case of a resistive
heating approach the filament may observe waiting time at the semi solid state due
to non-extruding position changes of the nozzle, waiting time to start printing, etc.
It needs to be understood at what holding time the microstructure is deemed
outside the processing parameter. It is expected (see section 2.1.4 and Figure 7)
that the main effect is coarsening but not creation of a dendritic structure. In
addition, it needs to be observed whether the RQI will drop over time. It is expected
that if the roundness of coarsened grains (see Figure 7f) is even more globular the

RQI will not drop but increase.

The experiment process and analyses are identical to the heating experiment.
Meaningful timeframes to test are 30min (5min after the longest heating
experiment), 40min and 50min. Based on the expectation that heating to globular
structure is not greater than 25 min, a holding time review between 5min and 25min

is assumed meaningful for MEAM machines operation.
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As the holding time intervals are greater than the ones used in the heating
experiment the maximum difference for the sample / power calculation can be
relaxed. From the below Minitab Power and Sample Size calculation it has been
assumed that a maximum difference of 4um in grain size is sufficient. As such that

sample size has been chosen as 2 replicates (see also Figure 109).

Power and Sample Size

General Full Factorial Design

o = 0.05 Assumed standard deviation = 0.966
Factors: 2 Number of levels: 3; 2

Include terms in the model up through order: 2
Not including blocks in model.

Results
Maximum Total Target
Difference Reps Runs Power Actual Power
3 3 18 0.90 0.991592
3 3 18 0.95 0.991592
4 2 12 0.90 0.981303
4 2 12 0.95 0.981303
Power Curve for General Full Factorial
Reps
2
—_— 3
Assumptions
« 0,05
StDev 0966
# Factors 2
- # Levels 3;2
g Terms Included In Model
8 Blocks No
Term Order 2

0 1 2 3 4
Maximum Difference

Figure 109 - Power Curve for full factorial design for the aging experiment

The full factorial randomized design is shown in Appendix 0.
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For the same reason as in the heating experiment the lower temperature for the

reference alloy (THIXALLOY 540) has been removed from the experiment.

Figure 110 - Aging example — sample 19: A356 50min @ 585°C

Figure 111 - A356 a) Sample 18M - 15min @ 585°C b) Sample 19M 50min @ 585°C

As shown below (see ANOVA and Figure 113) the RQI does increase but stabilize
over time for A356 and increase over time for THIXALLOY 540.

General Linear Model: A356 aging RQI versus Hold Time;
Actual Temperature

Factor Information

Factor Type Levels Values
Hold Time Fixed 6 15; 20; 25; 30; 40; 50
Actual Temp Fixed 5 573;582; 585; 592; 595
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Analysis of Variance

Source DF AdjSS AdjMS F-Value P-Value
Hold Time 5 0.16338 0.032677 10.03 0.000
Actual Temp 4 0.04463 0.011157 3.42 0.012

Error 83 0.27043 0.003258
Lack-of-Fit 19 0.06895 0.003629 1.15 0.325
Pure Error 64 0.20148 0.003148

Total 92 047038

Model Summary

S R-sq R-sq(adj)

R-sq(pred)

0.0570804 42.51%

36.27%

28.38%

Residual Plots for RQl - A356
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Figure 112 - Residual Plot for A356 heating to aging
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Main Effects Plot for RQI
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Figure 113 - Main effects plot for RQI - A356 heating to aging

General Linear Model: RQI versus Hold Time; Actual Temp

Factor Information

Factor Type Levels Values
Hold Time Fixed 6 15; 20; 25; 30; 40; 50
Actual Temp Fixed 3 593; 602; 605

Analysis of Variance

Source DF AdjSS  AdjMS F-Value P-Value
Hold Time 5 0.164863 0.032973 7.35 0.000
Actual Temp 2 0.005539 0.002770 0.62 0.546
Hold Time*Actual Temp 10 0.017675 0.001767 0.39 0.939

Error 30 0.134639 0.004488

Total 47 0320243

Model Summary
S R-sqg R-sq(adj) R-sq(pred)

0.0669923 5796%  34.13%

*
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Residual Plots for RQI - THIXALLOY 540 Aging
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Figure 114 - Residuals Plot RQI - THIXALLOY 540 Aging
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Figure 115 - Main effects plot for RQI - THIXALLOY 540 Aging

As per ANOVA below the grain size/diameter is only affected by the holding time.
As such a regression analysis has been done to study the behavior throughout the

time sampled.

General Linear Model: A356 Diameter versus Hold Time;
Actual Temperature
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Factor Information

Factor Type Levels Values
Hold Time Fixed 6 15; 20; 25; 30; 40; 50
Actual Temp Fixed 5 573;582; 585; 592; 595

Analysis of Variance

Source DF AdjSS AdjMS F-Value P-Value

Hold Time 5 69025 1380.50 18.89 0.000

Actual Temp 4 228.9 57.22 0.78 0.539
Error 83 6066.1 73.09

Lack-of-Fit 19 13284 69.91 0.94 0.534

Pure Error 64 47377 74.03

Total 92 131562
Model Summary

S R-sq R-sq(adj) R-sq(pred)
8.54898 53.89%  48.89% 42.62%
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Figure 116 - Residual Plot
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Main Effects Plot for Diameter - A356 aging
Data Means
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Figure 117 - Main effects plot for grain size - A356 aging

Regression Analysis: A356 Diameter versus Hold Time
Analysis of Variance

Source DF AdjSS AdjMS F-Value P-Value

Regression 1 65255 6525.54 89.56 0.000
Hold Time 1 65255 652554 89.56 0.000
Error 91  6630.7 72.86
Lack-of-Fit 4 335.7 83.93 1.16 0334
Pure Error 87  6294.9 72.36

Total 92 131562
Model Summary

S R-sq R-sq(adj) R-sq(pred)
8.53607 49.60%  49.05% 47.21%
Coefficients

Term Coef SE Coef T-Value P-Value VIF
Constant 76.31 2.24 33.99 0.000

Hold Time 07191  0.0760 946  0.000 1.00
Regression Equation

Diameter = 76.31 + 0.7191 Hold Time
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Residual Plots for Diameter A356 Regression Analysis
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Figure 118 - Residual Plot for Regression Analysis Grain Size - A356 Aging

General Linear Model: THIXALLOY 540 - Diameter versus
Hold Time; Actual Temp

Factor Information

Factor Type Levels Values
Hold Time Fixed 6 15; 20; 25; 30; 40; 50
Actual Temp Fixed 3 593; 602; 605

Analysis of Variance

Source DF AdjSS AdjMS F-Value P-Value
Hold Time 5 2952.74 590.548 26.21 0.000
Actual Temp 2 449.67 224834 9.98 0.001

Hold Time*Actual Temp 10 70.68 7.068 0.31 0.971
Error 29 65342 22.532

Total 46 4295.29
Model Summary

S R-sq R-sq(adj) R-sq(pred)
474678 84.79%  75.87% *
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While for THIXALLOY the grain size is affected by both holding time and
temperature, it is assumed that temperature can be removed when the factor levels
would be increased similar to A356. Also to note is that Residual vs Fitted Value
show very small spread of residuals for larger average grain size. For verification
to A356 the regression analysis has been done for holding time only. With the
below regression model (R-sq = 71%) as well as the scatter plot for diameter (see
Figure 121 — against Holding Time and Figure 122 against temperature) it is

assumed that the regression against the holding time is adequate and comparable

to A356.
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Figure 119 - Residuals Plot for Diameter - THIXALLOY 540 Aging

Regression Analysis: Diameter versus Hold Time
Analysis of Variance

Source DF AdjSS AdjMS F-Value P-Value
Regression 1 3036.0 3036.01 10849 0.000
Hold Time 1 3036.0 3036.01 108.49 0.000
Error 45 1259.3 27.98
Lack-of-Fit 4 1112 27.81 0.99 0422
Pure Error 41 1148.1 28.00
Total 46 42953

Model Summary
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S R-sqg R-sq(adj) R-sq(pred)
5.29000 70.68% 70.03% 68.17%
Coefficients

Term Coef SE Coef T-Value P-Value VIF
Constant 62.15 2.00 31.05 0.000

Hold Time 07091 0.0681 1042  0.000 1.00
Regression Equation

Diameter 62.15 + 0.7091 Hold Time

Residual Plots for Diameter - THIXALLOY 540 Aging
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Figure 120 - Residual Plot for Regression Diameter - THIXALLOY 540 aging

127



Scatterplot of Diameter vs Hold Time - THIXALLOY 540 aging
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Figure 121 - Scatterplot with regression Diameter vs Hold Time - THIXALLOY 540

Scatterplot of Diameter vs Actual Temp - THIXALLOY 540 aging
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Figure 122 - Scatterplot with regression Diameter vs temperature — THIXALLOY 540

4.2.3 Cleaning process development

It is important to remove material remains from the nozzle especially also Al203
material as that has a far higher melting temperature (2050°C) than the MEAM
apparatus would generate (up to 650°C). The process developed has been derived

from a step performed to clean extrusion dies in extrusion molding. Activities
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described by the Institute for Extrusion molding at the Technical University of Berlin

are as follows:

e Stripping of larger remains of aluminum alloy from the die

e Dissolve alloy remains in sodium hydroxide solution at elevated
temperature

e Purge produced hydrogen with an exhaust duct

e Soaking of die in distilled water

The process was first reproduced using an electromagnetic mixer to ensure the
solution will be moving through the smaller channel areas (see Figure 123 left).
This setup resulted in cleaning times of 1 to several hours. It was assumed the
process is stopped if no gas bubble is released from the nozzle channel. Later this
setup was replaced by an ultra-sonic cleaning apparatus (see Figure 123 right).
This reduced the time to about 10-15min before the gas release stopped. Also, the

soaking was performed using an ultrasonic cleaner with distilled water.

Figure 123 - Nozzle cleaning left) magnetic mixer right) ultra-sonic

All cleaning processes were performed using 50% sodium hydroxide solution.
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4.2.4 Extrusion experiment
To allow an extrusion experiment with the existing nozzle and its temperature

distribution the following aspects need to be respected:

1. The identified heating to globular structure holding time and temperature
with applicable RQI and grain size

2. Outlet orifice size so the clogging is prevented: Orifice >> 6x grain size

3. Limited filament sample length to allow a relative uniform temperature
throughout the nozzle motion

4. A motion and temperature regime to process a filament sample with keeping
the temperature approximately constant around the filament sample

5. Ideal condition of the nozzle channel, neck and outlet orifice in terms of

former alloy remains and complete boron-nitride coating

With the results of the heating and aging experiment the following parameters are

chosen for design aspects 1, 2, 3 above:

Table 24 - Extrusion experiment design aspects

Alloy Holding Holding Sample Outlet Orifice
Time Temperature | Length
A356 25min 595°C 5 mm 1.1mm
THIXALLOY
540 35min 605°C 5 mm 1.1mm

The temperature & motion regime has been based on the modeled temperature

from chapter 4.1.1 and prior proof of concept runs as follows:

Table 25 - Extrusion experiment process

Step Process specification

Pre 1 Heating of nozzle to target temperature (595°C or 605°C) at 3.25mm
depth. Thorough through heating of nozzle — >20 min

Pre 2 Insert Filament at 30mm depth with 2mm steel pin and heat for 25min

1 Increase temperature by 5°C

130



Step Process specification

2 Move the filament by 5 mm forward with 2mm steel pin

3 Increase the temperature by 5°C

4 Move the filament by 5 mm forward with 2mm steel pin

5 Increase the temperature by 10°C

6 Move the filament into the neck / smaller channel 2mm piston, verify

with the sharpened 2 mm steel piston

7 Move the filament into the test tube filled with water

For aspect 5 the nozzle needs to be in a cleaned condition and the boron-nitride
coating needs to be applied before a sample will be extruded. The current coating
is applied through a spray known from aluminum welding operation to hinder
spilling adhesion. Disadvantage of the spray is that the coating is easily worn out
by the solid aluminum or the steel piston used to push the filament through the
nozzle. To verify the extrusion a full cleaning cycle as described in section 4.2.3 is
conducted and the boron-nitride spray applied. After the defined number of
experiments at least two further experiment without the cleaning and coating cycle

are planned.

The experiment itself will be conducted only as a conclusion whether the material
can be extruded or not. As such, the outcome is a binary / categorical one.
Designed experiments with binary outcome, as used in clinical trials, require a very
large sample size (see Julious [121]). Due to the cost limitation the number of
experiments has been chosen as 10 samples per alloy plus 2 additional without
cleaning. In case the outcome includes clogging the experiment would need to be

re-designed.

The metal pins are prepared as per step requiring motion (see Figure 124). Step
6 will press the semi-solid into the neck and smaller channel — as such the pin has
been sharpened to form the positive neck shape. The last pin has the outlet orifice

diameter of 1.1 mm and was replaced for each sample.
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Figure 124 - Extrusion experiment piston pins

4.2.5 Induction Pre-Heating experiment

A quick experiment has been conducted as a proof of concept for an induction pre-
heating of the filament to a maximum temperature of about half of the semi-solid
processing temperature. For that a low cost / small-scale induction heating circuit
with a 10-turn work coil has been acquired (see Figure 125). The frequency of the
non-adjustable induction oscillating circuit was 193kHz which is about the
expected adequate frequency of through heating of the filament to semi solid
temperature (see Table 14, chapter 4.1.3). This was connected to an adjustable

power source.

Induction
heating circuit

Induction coil
- 4

Thermocouple

Power supply
control panel

Figure 125 - Small scale induction heating experiment setup
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For that experiment several 10mm filament samples (see Figure 126 left) have

been prepared with a drilling of 1mm diameter and 5mm depth in the center to
insert the thermocouple (see Figure 126 right).

—

Figure 126 - Left) filament sample with drilling right) filament fitted on thermocouple

Initial heating attempts (see Figure 127) show that depending on the voltage and

position, temperatures up to 350°C can be reached with a very simple setup.

Resulting temperature of indction heating at
certain position and voltage
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Figure 127 - Initial induction heating temperature results
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Based on that a simple experiment with 4 replicates has been designed and
completed to understand the temperature that can be reached at two positions
(center/edge) in the work coil as well as 2 voltages (10V / 12V). The maximum
temperature was determined after 40s which would reflect 0.5mm/s2* filament

velocity which is the same as chosen for the induction heating simulation.

The resulting temperature show very little standard deviation (about 2°C center
and about 6°C at the edge) and can reach up to 225°C in the center position at
12V (see Figure 128).

Interval Plot of Temperature after 40 sec
95% Cl for the Mean

225 .
200
175
150

125 I

100

Temperature after 40 sec

.

Voltage high low high low
Position full inside half inside

Individual standard deviations are used to calculate the intervals.

Figure 128 - Interval plot of temperature after 40 seconds

24 Note: the experiment does not reflect an actual movement through the nozzle such as the
temperature reached after 40s processing the filament at 0.5mm/s would be different than the static
holding at center or edge. As this is just a proof of concept experiment this simplification is deem
adequate.
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5 RESULTS AND DISCUSSION

5.1 Initial Al 4018 filament experiments
Initial experiments showed the importance of precise composition of the material.
A deviation in Si composition (-2.7%) as seen in Al 4018 wire resulted in about
25°C higher temperature to achieve 50% fraction solid (see Figure 63). Standard
wire drawing processes as used by Elisental do result in a loss of dendritic or
globular microstructure (Figure 55). In contrast the wire drawing process allows as
a severe plastic deformation (see chapter 2.2.3) and the formation of fine grain
globular material. Due to the deviation in material (Si and Ag) the Al 4018 wire has

been declined as a future experiment material.

5.2 Material production

It was noted that the material produced for semi-solid casting does not immediately
show globular structure (see Figure 72) but requires a defined step heating
process before processing in a semi solid state. When processing the “semi-solid”
ready raw material through a traditional extrusion process similar to the wire
drawing process the existing dendritic microstructure is dissolved completely. As
such the filament production process using magnetically stirred alloy does not add
additional value to achieve a MEAM ready filament. More so the created filament
must be further processed through heat treatment in the experiment extrusion

setup to achieve the semi-solid extrusion readiness.

A final MEAM process filament must be created to a direct globular structure which
is currently not commercially available. It is expected to use a casting style
production of filament. Rheocasting (stirring) or severe plastic deformation
combined with reheating and casting are the best approaches leading to a globular

and minimized grain size.

5.3 Proof of concept experiments
The initial use of A356, THIXALLOY 540 and Al 4018 without understanding of its

microstructure, adhesion to the nozzle, temperature requirements and time-based

changes in microstructure do not allow an extrusion process. It is required to
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establish the optimal development to a globular microstructure as well as

understand the aging (time-based coarsening) of the microstructure.

While the acquired gantry system, wire feeder and inert gas chamber were not
used or useful, the resistive heating nozzle was capable of performing within the
temperature ranges very well. Especially the maximum setting of 650°C at the

nozzle orifice area could be reached without any problems.
5.4 Simulations

5.4.1 Simulation of heated channel dimension changes

Overall the changes in dimension (see max displacement vector in Table 26) must
be considered for the insulation and mount of the nozzle (as also seen in Figure
77). From the change of the orifice (about 1%) no significant changes in the back-
extrusion behavior is expected. The influence would be more expected from the
difference of the filament diameter and the heating channel (used nozzle +0.1mm)
than the dimension changes due to heat expansion. Even with future changes of
the nozzle for aluminum semi solid temperature ranges the orifice dimension

change can be neglected.

Table 26 - Dimension change of nozzle at 585°C

Change of nozzle Change of nozzle Max displacement
orifice orifice vector
0.02mm 1% 0.254mm

5.4.2 Simulation of resistive heating

The simulation results with the adapted nozzle temperature distribution (see Figure
129) showed the significance of an appropriate nozzle design with a uniform
temperature distribution especially near the nozzle outlet. With the current nozzle
design a semi-solid temperature range (achieving about 50% liquid fraction)
cannot be achieved without significant overheating near the center of the nozzle
channel. Besides the microstructure and adhesion of the filament this drop to about

20% liquid at the nozzle outlet would have led to clogging. In case the extrusion is
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still successful unwanted microstructure changes may occur or too little heat

energy is left for layer bonding with prior extruded material.
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Figure 129 - Adapted Simulation Results for A356 heating with nozzle temperature profile
diagram for resulting temperature and mass fraction liquid with setting 585°C / 858K

An experiment design to review the microstructure development of the filament

needs to be adapted using the outcome of the simulation.

For the design of the operational MEAM apparatus a multi circuit resistive heating
is needed to overcome the temperature distribution within the nozzle. Especially
at the area of the semi solid material the nozzle temperature needs to be within
the +3°C range or less. It should be reviewed whether it is advisable to slightly
design a higher temperature at the nozzle outlet to overcome the convection as

well as aid the layer bonding.

5.4.3 Simulation of inductive heating

Overall the simulation shows good results in achieving the required range of liquid
fraction (see Figure 130 right). Also, the cross section of the filament shows
adequate through heating with a maximum difference of about 1.5°C. While those
results are very satisfactory the sensitivity of the excitation vs the liquid mass
fraction as shown in Figure 131 are of concern. Any object within the
electromagnetic field would change the excitation drawn and the ohmic losses

significantly so that it need to be assumed a constant temperature range of about
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1+3°C cannot be achieved. This does correlate to the results of Garcia [114] testing

such a filament main heating while failing to keep a constant temperature.

Filement Temperature at the Outlet from Wall (-0,001) to Center (0) Mass Fraction Liquid - Filament Center - 321 Ampere
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Figure 130 - Induction heating simulation results — left) Outlet temperature difference Wall -Center
for 318A right) Mass Fraction Liquid at the center line 312A
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Figure 131 - - Induction heating simulation result /
sensitivity of the excitation vs. fraction liquid

Thus, induction heating as the final filament heating to the semi solid state is not
recommended. While the (in this work) tested resistive heating nozzle needs to be

improved, the work of Chen et al. [113] show good temperature control with a
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multiple resistive heating circuits solution. To allow a minimized area of
temperature that cannot be fast increased and decreased (i.e. the resistive area)
a pre-heating before the resistive heating nozzle is advised. Such pre-heating does
not need the temperature precision as the area with the semi-solid alloy. It might
be also in a position of the MEAM apparatus that can be more easily shielded and

controlled with respect to other objects moving within the electromagnetic field.

5.4.4 Simulation summary

Overall the simulation shows that the nozzle dimension changes at the semi-solid
temperature can be neglected. The induction heating is not recommended for a
heating of the filament within the semi solid range but is potentially adequate as a
filament pre-heating to aid and shorten a resistive heating nozzle. The resistive
heating nozzle needs to have at least a 2-circuit heating design to manage the
heating up to the semi solid range as well as keeping that semi-solid mass fraction

in an adequate range at the nozzle neck and outlet.
5.5 Experiments

5.5.1 Heating to globular microstructure experiment

The microstructure measured by the RQI is affected by the hold time and
temperature for A356 (see Figure 132 and Figure 133). For THIXALLQY it is only
affected by the holding time (see Figure 135).

The Grain Size for A356 is only dependent on the holding time (see Figure 134)
while for THIXALLOY 540 it is dependent on both holding time and temperature
(see Figure 136).

The fraction solid values achieved are not dependent on the temperature or
holding time. It would have been expected that the temperature has an effect as
defined in section 2.1.3. But due to the experimental nozzle the material must pass
through an area of lower temperature before quenching. It seems the effect of that
area and the time required for manual pushing into the water filled test tube

diminishes that effect.
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Main Effects for RQl of A356
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Figure 132 - A356 main effects of temperature (in °C) and hold time (in min) on RQI

Contour Plot of RQl vs Actual Temp; Hold Time

595
RQl

= < 0,600
Il 0600 - 0,625
I 0625 - 0,650

590 [ 0,650 - 0,675
[ 0675 - 0,700
W 0700 - 0,725
g— W 0725 - 0,750
5 ] > 0,750
2 585 |- > A0
©
=]
3]
<

580

575

15,0 17,5 20,0 22,5 25,0
Hold Time

Figure 133 - A356 contour plot of temperature and hold time (in min) on RQI
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Figure 135 - THIXALLOY 540 Main effects of hold time (in min) on RQI

Figure 134 - A356 Main effects of hold time (in min) on grain size
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Main Effects Plot for Diameter of THIXALLOY 540
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Figure 136 - THIXALLOY 540 Main effects of hold time and temperature on grain size

The goal of this experiment was to identify the parameter for a successful (see
failure proof of concept in section 3.4) extrusion. The Tukey Test below supports

the parameter choice.

Comparisons for RQI
Tukey Pairwise Comparisons: Hold Time
Grouping Information Using the Tukey Method and 95% Confidence

Hold
Time N Mean Grouping

25 20 0.715417 A
20 22 0.667750 A B
15 21 0.622342 B

Means that do not share a letter are significantly different.

Tukey Pairwise Comparisons: Actual Temp
Grouping Information Using the Tukey Method and 95% Confidence

Actual
Temp N Mean Grouping

595 12 0.703040 A
573 8 0.683618 A B
585 11 0.674074 A B

142



592 12 0.647529 A B

582 20 0.634254 B
Means that do not share a letter are significantly different.

Based on the results the factor levels for the extrusion experiment are chosen as

follows:

e A356 Temperature - 595°C for higher fraction solid (please see also the
respective process window from Finke [71]/Figure 46 expecting Fs>0.55)

e A356 hold time - 25 min for a higher Rheocast Quality Index (RQI). 25 min
also corresponds with a larger grain size (average up to 96um) but with an
initial extrusion outlet of planned 1.1mm the threshold defined by Finke [71]
(6x of average grain size) is not exceeded by the material.

e THIXALLOY 540 hold time — 25 min while the temperature is kept at the
tested 605°C.

The expected average values for the RQI and Grain Size are shown in Table 27.

Table 27 - Expected RQI and Grain Size for holding time of 25 min prior extrusion

Alloy Average RQIl expected | Average Grain Size expected
A356 0.731 £0.01 (@695°C) 97.2 £3.9um (@595°C)
THIXALLOY 540 0.762 +0.022 (@605°C) 78.1 £2.6 ym (@605°C)

5.5.2 Aging experiment

The aging experiment showed a growing but also stabilizing RQIl as expected. This
would not limit the processing of the material itself. Increasing precipitation could
be observed within the globular grains. The grain size is growing within the
measured time by about 0.75um per minute holding time (approximation based on
A356 — 0.72pum/min and THIXALLOY 540 — 0.71um/min). As the initial grain size
is dependent on the material history or filament production it is assumed for a
model that the grain size starts with an adequate one for semi-solid processing.

Based on the slope of grain growth and expected initial semi solid grain size a
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prediction model has been built showing the maximum holding time until the limit

of outlet orifice (6x average grain size [71]) has been reached.

Prediction Model for maximum Holding Time
for different initial grain size in um
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40

Holding time in Min

20

5 600 700 800 900 1000
-20
Outlet Orifice in um

8 em— () 100

Figure 137 - Holding time prediction model for A356

This model shows that for some combination such as 100um starting grain size
the limit has already been reached for 0.5mm with no holding time i.e. negative
holding time. The model would need to be validated for times larger than 50min
but those would not be practical holding times needed for an MEAM apparatus.
Those have been included to show potential holding times for outlet orifices up to

1mm.

For the extrusion experiment an outlet orifice of 1.1mm has been chosen also to

remove the influence of the grain size for clogging.

5.5.3 Cleaning process development

The successful cleaning process of the nozzle is determined as a chemical
cleaning after removing of larger remains of the alloy material. The heating nozzle
material as well as the resistive heating coil was chemically resistant against the
50% sodium hydroxide solution. Even after more than 100 cleaning cycle iterations

both tested nozzles do not show any degradation. The applied boron-nitride
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coating was also removed during the cleaning which is not desirable. It is assumed
that a permanent coating as applied to extrusion dies through Chemical vapor
deposition (CVD) will not be affected by the cleaning process. It needs to be
reviewed how the major contamination of alloy material can be removed without
mechanically affecting such coating. The cleaning process with sodium hydroxide
solution will take 10-15 min with dimension similar to the current experimental
nozzle (5cm long) when combined with ultrasonic agitation. A soaking process
needs to be applied after cleaning to remove the sodium hydroxide and the

generated sodium and aluminum salt.

5.5.4 Extrusion experiment

For the final extrusion experiments all samples showed successful extrusion for
both A356 (see example Figure 138 and appendix 0) and THIXALLOY 540 (see
appendix 0). Only one sampled clogged (see Figure 139) during the sample
attempt due to operator error (only first temperature increase was applied). After
correcting the error i.e. immediate increase by 15°C and slightly more force the

sample was extruded.

Figure 138 - A356 extrusion run 5 — left) resulting sample right) microstructure
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Figure 139 - THIXALLOY 540 run9 - left) resulting sample right) microstructure

All samples showed significant segregation of liquid and solid fraction with
extruding first the liquid state followed by a compressed and deformed solid state.
Overall some THIXALLOY 540 showed slightly better results (see sample 3-6
appendix 0) i.e. less segregation. The sample 9 for THIXALLOY 540 (see Figure
139 right) resulted in only minimal segregation. Due to the operator error the
extrusion first clogged and a solid skin developed at the already extruded bubble.
The additional force then extruded the sample after temperature increase. It is
assumed that the higher force applied and the solid skin operating at a plug for at
least some time resulted in a force / velocity combination that results in a

successful extrusion without segregation.

Solid skin — ruptured after temperature
increase and additional force applied

Figure 140 - THIXALLOY 540 run 9 extrusion example with ruptured skin
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The results do correlate with the segregation and threshold force for non-
segregation extrusion shown by Finke [71]. As discussed in section 2.4.3 and
shown by Figure 46 as well as Figure 48 there is a process window that requires
a defined minimal force and velocity. Finke also described that there is a start stop

phenomena that may lead to segregation.

With the current nozzle restrictions of non-uniform temperature and no enduring
coating as well as the filament not directly ready for extrusion in a globular semi
solid state further experiments identifying the force / velocity process window are
not possible. Also, whether start / stop phenomena can be avoided or needs to be

overcome cannot be investigated.

Still the current experiments show that MEAM extrusion of aluminum alloy with a
respective high RQI and small grain size is possible within the adequate process

window of semi-solid state.

5.5.5 Induction Pre-Heating experiment

The induction pre-heating experiment results show a very easy process to pre-
heat the filament to about half of the semi-solid temperature. This can be used to
reduce the size of the subsequent resistive heating nozzle. That setup would allow
to restrict the material in semi solid state during temperature elevated holding times
as well as require far less accuracy and power of the induction heating setup. For
a MEAM apparatus the power needs to be increased to process at higher speed

than tested in the experiment.

5.5.6 Experiment summary

The experiments show that the RQI reaches 72 — 75 for a non-globular filament
after about 25min. This is assumed to be adequate for semi solid processing. The
aging results show a significant increase of globular size up to 100um - 110 um
after 50min as well as a creation of precipitates within the grains. This grain growth
limits the holding time depending on the nozzle outlet orifice as well as the starting
grain size (e.g. about 20min for 100 um starting grain size with 0.7mm outlet orifice).

A model has been developed to estimate the maximum holding time. The extrusion

147



experiments showed it is possible to repeatedly extrude the semi-solid material.
On the contrary only one sample did not showed segregation within the resulting
extruded material. All other samples showed significant segregation while
THIXALLOY 540 had slightly better outcome. It is assumed that the adequate
velocity / force window cannot be reached with the existing nozzle and manual
processing. Due to the filament material and the inadequate temperature

distribution an automated feeding is not possible as of now.

An ultra-sonic improved cleaning process has been used during the final extrusion
experiments. That does result in a faster completion of the process i.e. only 10-
15min needed. Reduced adhesion can be achieved by coating the inner wall of the

nozzle channel and neck with Boron-Nitride.

Finally, a proof of concept of an induction pre-heating showed a low-cost option to

reach about 50% of the semi-solid temperature range.
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6 MEAM PROCESS DESIGN

Based on the experiments the following filament, machine and processing
properties as well as design elements are proposed to create an operational

MEAM process using semi-solid aluminum alloy.

6.1 MEAM feedstock material and shape design

It has been shown during this work that drawing or extruding aluminum filament is

not adequate to achieve an immediately semi-solid processing ready material.

Overall the small scale MEAM process compared to casting of aluminum billets
require narrower parameter ranges. The behavior in the nozzle for example the
fraction liquid is dependent on the raw material composition. As for A356 the
allowed composition ranges (e.g. Si 6.5% - 7.5%) would influence the
processability significantly (see section 2.1.9 and Figure 11). For the raw material
in the MEAM process the composition ranges should be reduced e.g. 6.8% - 7.2%.
For direct processing of aluminum alloy, it is critical that the material loaded into
the apparatus shows already a processing ready globular structure. This will
ensure that the material can be heated into the semi-solid state for a very brief time
right before extrusion. As such the holding time needs to be kept to a bare
minimum also to reduce the coarsening of the microstructure or other changes
such as developing precipitates. The development of the globular microstructure
(for maximizing the RQI) within the MEAM apparatus is deemed impractical as
there has been no process found that would speed up this below 10-15 minutes.
E.g. this would require maintaining material at the elevated temperature for >15min
of extrusion. Production of the raw material need also to ensure that porosity is
reduced to a minimum. The grain size should be as small as possible for products
with fine details e.g. wall size <2mm. For extrusion of 0.5mm material the average
grain size needs to be <80um to adhere to Finke’s [71] grain size <1/6 of extrusion
diameter. It is expected that an ECAP (see 2.2.3 and Figure 1) processing followed
by a semi-solid casting (see also [122] for thin wall casting) with immediate cooling
of the filament would lead to adequate results. The grain size may be relaxed for

production of larger parts without fine details. In such cases material with 100um
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average grain size is sufficient which may reduce costs but also require a larger
nozzle outlet orifice size (>0.7mm). Production of such filament would for example
not need an ECAP process and therefore reduce the cost. The extruded material
needs to be free of an aluminum oxide layer to allow layer bonding. As such the
filament needs to be free of any oxide layer already as removal of such layer in the
MEAM apparatus (e.g. physical or with cleaning agent) is deemed impractical. For
that the filament needs to be produced in an inert atmosphere or the oxide layer
needs to be removed and after that the filament transported and stored in a
protective atmosphere. Alternatively, a protective coating may be identified that
protects the filament during the transportation and storage but dissolves during the

heating process.

The diameter of the filament is an important design aspect as well. Larger diameter
will result in rigid and therefore difficult to process filament. Any deformation of the
filament may not be overcome by the filament feeder and may result in clogging at

the beginning of the heating channel.

Using the above material processing and design constraints a feed stock is
proposed and defined as Fused Bolt Fabrication (FBF). The concept is significantly
different from a continuous coiled filament as the principle used is similar to the
Stick deposition molding described in section 2.3.2.1. The raw material will be
prepared as described above to ensure semi-solid ready microstructure and cast
into round bolts with a male / female connection design at each end (see Figure
141). For feeding purposes the bolt should have a threaded structure at the outside.
To allow positioning of the bolt a notch maybe required. This will keep each bolt
oriented while the thread feeder is moving it into the heating nozzle and at a certain
time allowing the next one to connect automatically. The channel prevents
connected bolts from separating. The rectangular shape of the male connector
allows the next bolt to be oriented correctly while supplied from a container to the

channel.
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Figure 141 - Schematic Bolt design

With this design a set of bolts can be cast in a single step. It is suggested to store
the aluminum oxide free bolts in a magazine either with a protective atmosphere
or a protection coating. With an adequate bolt processing in the MEAM apparatus
the rigidity of the bolt can be neglected. As such larger diameters such as 3-4mm

may be appropriate which would also allow a better semi-solid casting process.

Note: For further experiments the existing material could be used with a nozzle
that has a uniform temperature at significant length of the heating channel, at the
nozzle neck and outlet orifice. With such a nozzle batch processing would be
possible so that verification of the processing parameter such as force vs. fraction
liquid can be performed.
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6.2 MEAM Nozzle and machine design
The MEAM apparatus needs significant design changes to build a prototype for

further experiments as well as for a final production ready apparatus.
Nozzle

The resistive nozzle, while in its current design does not show a constant
temperature window, has still been identified as applicable for the MEAM process.
Additional heating circuits especially at the nozzle tip are required for a constant
(x2°C) temperature. It is assumed that 2 heating circuits may be sufficient when
combining with an induction preheating. The resistive heating area for a production
apparatus should be designed as small as possible to restrict the material aging
(coarsening, precipitation) to a minimum during hold times. Laser pre-heating
might be an option as its also allows very fast power up and down cycles. The pre-
heating temperature needs to be in a range where microstructure processes are
slow (matter of hours see also Hernandez Paz [123]). This will allow multiple power
up and down cycles without the need of the material being discarded. Induction
heating frequency should be chosen based on the feedstock diameter and
maximum temperature. For induction pre-heating of a 2mm filament to 300°C the
frequency should be around 75kHz for a skin depth of 74 of the filament diameter.
When using a threaded filament or bolt design the heating channel may need an
additional constriction to remove the gas within the thread at semi-solid
temperatures. All nozzle inside walls need to be coated with an applicable layer of
material such as Boron-Nitride that reduces the adhesive characteristic of
aluminum alloy in the semi-solid state. Chemical Vapor Deposition (CVD) of boron
nitride has been effectively used for extrusion dies. This might be the preferred
process of ensuring non-adhesive coating layer. Besides the induction heating
before to the resistive through heating a single turn induction heating coil at the
nozzle is suggested. This will reheat the prior deposited alloy layer for bonding
purposes as well as keep the semi-solid temperature for currently extruded alloy
material. As an alternative a selective laser heating might be used. An additional

design element could be the agitation of the semi-solid slurry to decrease the
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required extrusion force (see [124]). Options for this agitation would be through a
sonotrode or Magneto-Hydro-Dynamic (MHD) stirring. The nozzle components
that are in contact with the semi-solid slurry should be designed to be resistive

against sodium hydroxide solution.

—

Thread Feeder
Feeder <
—
o
Induction Coil
Flux
Induction Concentrator
Pre- <
Heating Glass or
Ceramic
Channel
Resistance
Heater
Thermo-
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Anti-Adhesive Coating
e.g. Boron Nitride

Figure 142 - Schematic MEAM nozzle design
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Feeding

In case the feed-stock will be introduced into the MEAM apparatus oxide layer free,
already the storage compartment needs to be under protective gas e.g. inert gas.
The force and speed process window that allows extrusion without solid liquid
segregation needs to be met. For this it is assumed that a pinch roll feeder is not
adequate. Instead a screw feeder used by Go et.al [70] is proposed for the MEAM

apparatus to allow the application of larger forces.

For the suggested bolt material feedstock, a magazine type storage is proposed.
Each bolt will be moved from a horizontal position into a vertical to be connected
with the prior bolt and then pulled into the feeder as well as thereafter the heating
nozzle. This allows processing of the potentially larger diameter bolt feedstock
without bending. The individual bolt can be moved through the curve by the weight

of the next bolts or a conveyer belt.
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Figure 143 - Schematic feedstock supply

MEAM apparatus / housing

Within the housing or build area of the MEAM apparatus the temperature should
not be elevated as the layer deposited needs to be cooled as fast as possible for
better material properties of the printed product. As such a selective heating
approach is necessary to ensure the prior layer is reheated for bonding purposes.
While the layer deposited is cooling, oxidation needs to be prevented to allow a
potential next layer to bond without an intermediate oxide layer. For this it is
required to ensure inert gas atmosphere within the housing of the MEAM

apparatus. Due to the complexity of the nozzle, feeder, feed stock storage and
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selective re-heating it is proposed that the build table performs all required
movements in the x-y-z axes. Within the MEAM apparatus a waste area is needed
to extrude material from the nozzle that has reached its maximum age. A sacrifice
plate or quenching waste bin is suggested which will be connected to the build
table.

Feedstock
Supply

Fix position
MEAM Nozzle

X-Y-Z Table
Waste bin

X-Y-Z Linear
Motion

Figure 144 - MEAM apparatus - including table and housing
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6.3 MEAM Process parameter
The MEAM extrusion requires a precise temperature control (£2°C) for the
extrusion at the semi-solid target temperature to achieve a 50% - 60% fraction
liquid. Especially in the complex case of an induction pre-heating, through heating
resistive circuit, nozzle tip resistive heating circuit and induction reheating outside
the nozzle tip controlling the interaction between all heating components needs to

be designed. Critical conditions are start / stop and change of velocity.

The feeding control system needs to allow the acceleration for the startup to be
high enough to reach the velocity / force process window as soon as possible. The
control system must also be able to detect the force / velocity situations that would
indicate clogging at the nozzle tip. This is important as in worst case a continuous
feeding may result in back extrusion of semi-solid alloy into the nozzle which would

damage the upper area such as the induction pre-heating components.

The control system of the MEAM apparatus needs to identify when holding time at
semi solid temperature is at the maximum time for aging. This might need to be
adjusted for different orifice, grain size and aging (coarsening) speed of the used
alloy. Models as defined in 5.5.2 need to be loaded for each alloy type used. In
case of bolt feedstock delivered in magazines the grain size and alloy type might
be coded into the magazine itself so that the adjustment of the control system is
automated and operator errors are minimized. As soon as the holding time is

reached an extrusion process into the waste area is executed to prevent clogging.

For a mass production apparatus in-build cleaning needs to be reviewed to

decrease the maintenance processes.
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7 CONCLUSION

This work has modeled and validated operational conditions for extrusion of
aluminum alloy in a semi-solid state. Critical aspects that have been found are the
composition and microstructure status of the alloy (feedstock), significance of the
temperature control throughout the heating and extrusion process, the holding time

at the elevated temperature as well as the velocity / force process window.

Existing filament feedstock are not ready to be processed in a semi solid state.
Also, extrusion molding instead of wire drawing of filament feedstock will not create
process ready material. For that a new process of semi-solid casting of such
feedstock needs to be developed. In this work a non-filament but bolt feedstock
was proposed that is assumed to combine the production and extrusion process

requirements.

While the continuous extrusion could not be reached and significant segregation
has been observed, based on prior work from Finke [71] a successful extrusion

with enhanced feedstock and nozzle as well as apparatus is expected.

Practical aspects for a future MEAM process such as resistive heating, induction

heating and cleaning have been reviewed and confirmed as feasible.

Overall while significant design elements are to constructed and further
investigation on alloy material as well as processes are to be performed the MEAM

process looks promising to create a new type of 3D printing.
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8 FUTURE WORK

As the presented work was to model and validated the basic extrusion potential

and parameters, many aspects of a practical MEAM process are still to be

investigated. The list below shows the aspects that have been derived from the

results of this dissertation:

Finalize and validate the nozzle design with a combination of induction pre-
heating and resistive through heating. Identify the number of applicable
heating circuits (22) for temperature variation no greater than +2°C. Note:
For initial experiments to identify the velocity/force process window and
liquid fraction a longer resistive nozzle would be sufficient but may need
more heating circuits to ensure the temperature window in a longer channel
area for batch processing.

Identify the appropriate pre-heating temperature that reduces the resistive
heating area while not affecting the material properties (e.g. precipitations
see also Hernandez Paz [123]) even after multiple cycles.

Review resistive heating for a threaded filament or bolt as the contact
conductance is significantly reduced (see 2.3.2.2 and Figure 27)

Identify a production process for a semi-solid casted feedstock either for
filament or the discussed bolt design

Verify the feeding mechanism (pinch roll and screw feeder) to ensure the
velocity and force window parameters are met.

Verify the acceleration process to achieve the velocity / force process
window that prevents segregation. Identify other supporting parameters e.g.
short-term overheating to start a continuous extrusion. Material extruded
during the start process should be analyzed to understand the adherence
to the later extruded material properties. In case of lower material properties,
a process needs to be applied to ensure such material is outside the printed
product.

Review different liquid solid fractions (between 50%-60%) to find the target

composition for extrusion.
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Identify the behavior of a semi-solid slurry when applying ultra-sonic
agitation in terms of segregation and processing within the nozzle neck.
Review the production and processing of bolt designs to verify and minimize
porosity

Review deposited layer reheating approaches, e.g. induction heating based.
Verify flux concentrators for targeted heating or laser-based reheating
Review cleaning processes to verify the Boron-Nitride coating and other
components (such as induction coils and flux concentrators) show
resistance against sodium hydroxide solution.

Review process parameters and design decision for higher speed MEAM.
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APPENDIX

Heating channel measurements

Pre-experiment:
Response: Temperature in Nozzle channel in °C
Factors:

e Temperature sensor channel position / depth
e Temperature setting of nozzle

Factor Level:

e Temperature setting for Nozzle:
o 585°C
o 600°C

e Temperature sensor Depth
o 46mm

41mm

36mm

31mm

26mm

21mm

16mm

11mm

O O O O O O O

Pre-experiment:
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Temperature setting Nozzle (°C) | Sensor Depth in mm | Temp in Nozzle in °C
585 46 593
585 41 590.6
585 36 587
585 31 578.5
585 26 565.1
585 21 553.2
585 16 533.3
585 11 493.1
600 46 609.2
600 41 603.9
600 36 601.3
600 31 591
600 26 579.9
600 21 566.4
600 16 551.7
600 11 519.6
585 46 591
585 41 589.5
585 36 586.2
585 31 577.2
585 26 566.2
585 21 552.2
585 16 536.7
585 11 496.2
600 46 605
600 41 602.6
600 36 600.9
600 31 592
600 26 579.4
600 21 565.4
600 16 553.7
600 11 520.1

General Linear Model:

Factor Information

Factor Type Levels Values
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Temp setting Fixed 2 585; 600
Sensor depth Fixed 8 11; 1e6; 21; 26; 31; 36; 41; 46

Analysis of Variance

Source DF Adj SS Adj MS F-Value P-Value
Temp setting 1 2001.9 2001.86 1125.63 0.000
Sensor depth 7 28439.5 4062.79 2284.47 0.000
Temp setting*Sensor depth 7 115.5 16.50 9.28 0.000

Error 16 28.5 1.78

Total 31 30585.4

Model Summary

S R-sg R-sg(adj) R-sqg(pred)
1.33358 99.91% 99.82% 99.63%
Calculation of Standard Deviation:

MSE =1.78 o = ,/MS;=1.3342

Power and sample size:

Power Curve for General Full Factorial

Assumptions

. o 0,05

(] StDev 1,3342

% # Factors 2

o. # Levels 2:8
Terms Included In Model

Blocks No

Term Order 2

0 1 2 3 4 5 6
Maximum Difference

General Full Factorial Design
a = 0.05 Assumed standard deviation = 1.3342
Factors: 2 Number of levels: 2; 8

Include terms in the model up through order: 2
Not including blocks in model.
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Maximum

Difference

2

Total

Reps Runs

9 144

Target
Power
0.90

Actual Power
0.915110

2 11 176 0.95 0.965694

3 5 80 0.90 0.957930

3 5 80 0.95 0.957930

5 2 32 0.90 0.905255

5 3 48 0.95 0.996664

Results:
Std | Run | Temp S:en:t(:‘r Temp | Sensor | Delta | Measured
Order |Order | coded coded Setting | Depth | Temp | Temp.

8 1 1 8 585 11 -94.6 490.4
40 3 1 8 585 11 -83.9 501.1
72 16 1 8 585 11 -94.7 490.3
16 29 2 8 600 11 -79.4 520.6
48 31 2 8 600 11 -78.0 522.0
56 47 1 8 585 11 -80.1 504.9
24 51 1 8 585 11 -82.9 502.1
80 71 2 8 600 11 |-111.0 489.0
64 73 2 8 600 11 |-101.1 498.9
32 78 2 8 600 11 |-106.7 493.3
71 4 1 7 585 16 -44.5 540.5
39 17 1 7 585 16 -39.2 545.8
63 20 2 7 600 16 -46.7 553.3
7 24 1 7 585 16 -42.7 542.3
79 33 2 7 600 16 -44.7 555.3
15 37 2 7 600 16 -44.9 555.1
31 39 2 7 600 16 -42.7 557.3
23 42 1 7 585 16 -49.0 536.0
47 48 2 7 600 16 -43.6 556.4
55 50 1 7 585 16 -50.0 535.0
6 6 1 6 585 21 -27.5 557.5
22 9 1 6 585 21 -23.9 561.1
46 18 2 6 600 21 -31.8 568.2
78 28 2 6 600 21 -25.1 574.9
70 38 1 6 585 21 -26.2 558.8
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Sensor

Std | Run | Temp Depth Ter'r.Ip Sensor | Delta | Measured
Order |Order | coded coded Setting | Depth | Temp | Temp.
62 64 2 6 600 21 -24.9 575.1
30 66 2 6 600 21 -25.5 574.5
54 69 1 6 585 21 -21.3 563.7
38 72 1 6 585 21 -25.0 560.0
14 76 2 6 600 21 -25.4 574.6
69 2 1 5 585 26 -10.6 574.4
53 7 1 5 585 26 -11.1 573.9
29 15 2 5 600 26 -12.7 587.3
21 21 1 5 585 26 -11.2 573.8
37 30 1 5 585 26 -11.6 573.4
45 46 2 5 600 26 -20.2 579.8
61 49 2 5 600 26 -14.0 586.0
77 54 2 5 600 26 -10.9 589.1
13 61 2 5 600 26 -13.4 586.6
5 80 1 5 585 26 -10.6 574.4
76 11 2 4 600 31 0.5 600.5
68 12 1 4 585 31 1.3 586.3
28 19 2 4 600 31 -0.1 599.9
20 23 1 4 585 31 -2.0 583.0
44 25 2 4 600 31 -0.7 599.3
4 26 1 4 585 31 -0.6 584.4
60 35 2 4 600 31 0.4 600.4
36 41 1 4 585 31 -0.9 584.1
12 60 2 4 600 31 1.6 601.6
52 77 1 4 585 31 -2.0 583.0
3 8 1 3 585 36 6.4 591.4
43 14 2 3 600 36 8.9 608.9
19 34 1 3 585 36 4.7 589.7
11 40 2 3 600 36 4.9 604.9
67 52 1 3 585 36 5.4 590.4
35 59 1 3 585 36 5.0 590.0
51 63 1 3 585 36 5.8 590.8
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Std | Run | Temp ?)een:ttz‘r Temp | Sensor | Delta | Measured
Order |Order | coded coded Setting | Depth | Temp | Temp.
59 67 2 3 600 36 7.8 607.8
75 68 2 3 600 36 9.5 609.5
27 75 2 3 600 36 8.3 608.3
42 5 2 2 600 41 8.7 608.7
66 10 1 2 585 41 10.1 595.1
50 22 1 2 585 41 12.5 597.5
18 27 1 2 585 41 8.5 593.5
26 53 2 2 600 41 9.8 609.8
74 55 2 2 600 41 9.9 609.9
10 56 2 2 600 41 10.5 610.5
2 57 1 2 585 41 10.0 595.0
34 70 1 2 585 41 10.5 595.5
58 79 2 2 600 41 11.4 611.4
65 13 1 1 585 46 8.4 593.4
17 32 1 1 585 46 6.8 591.8
1 36 1 1 585 46 8.5 593.5
57 43 2 1 600 46 5.1 605.1
9 44 2 1 600 46 5.6 605.6
73 45 2 1 600 46 6.5 606.5
33 58 1 1 585 46 10.0 595.0
25 62 2 1 600 46 9.7 609.7
41 65 2 1 600 46 10.1 610.1
49 74 1 1 585 46 9.5 594.5

General Linear Model: Measured Temp versus Sensor Depth; Temperature
Setting

Method

Factor coding (-1; 0; +1)

Factor Information

Factor Type Levels Values

Sensor Depth Fixed 8 1; 2; 3; 4; 5; 6; 7; 8
Temperature Setting Fixed 2 1; 2
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Analysis of Variance

Source DF Adj SS Adj MS F-Value P-Value
Sensor Depth 7 85611.8 12230.3 543.36 0.000
Temperature Setting 1 3759.3 3759.3 167.02 0.000

Error 71 1598.1 22.5
Lack-of-Fit 7 183.3 26.2 1.18 0.324
Pure Error 64 1414.8 22.1

Total 79 90969.1

Model Summary

S R-sg R-sg(adj) R-sqg(pred)

4.74430 98.24% 98.05% 97.77%
Coefficients
Term Coef ©SE Coef T-Value P-Value VIF
Constant 573.788 0.530 1081.74 0.000
Sensor Depth

1 26.73 1.40 19.05 0.000 1.75

2 28.90 1.40 20.59 0.000 1.75

3 25.38 1.40 18.09 0.000 1.75

4 18.46 1.40 13.16 0.000 1.75

5 6.08 1.40 4.33 0.000 1.75

6 -6.95 1.40 -4.95 0.000 1.75

7 -26.09 1.40 -18.59 0.000 1.75
Temperature Setting

1 -6.855 0.530 -12.92 0.000 1.00
Regression Equation
Measured Temp = 573.788 + 26.73 Sensor Depth 1 + 28.90 Sensor Depth 2
+ 25.38 Sensor Depth 3

+ 18.46 Sensor Depth 4 + 6.08 Sensor Depth 5
- 6.95 Sensor Depth 6
- 26.09 Sensor Depth 7 - 72.53 Sensor Depth 8

- 6.855 Temperature Setting 1
+ 6.855 Temperature Setting 2

Fits and Diagnostics for Unusual Observations

Measured
Obs Temp Fit Resid Std Resid
29 520.60 508.12 12.48 2.79 R
31 522.00 508.12 13.88 3.11 R
47 504.90 494.41 10.49 2.35 R
71 489.00 508.12 -19.12 -4.28 R
73 498.90 508.12 -9.22 -2.06 R
78 493.30 508.12 -14.82 -3.31 R

R Large residual
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Residual Plots for Measured Temp

Normal Probability Plot Versus Fits
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Analysis with delta temperature

Check for Blocking on Temperature setting:

General

Linear Model: Measured Temp Delta versus Sensor Depth;

Temperature Setting

Method

Factor coding (1; 0)

Factor Information

Factor Type Levels Values
Sensor Depth Fixed 8 1; 2; 3; 4; 5; 6; 7; 8
Temperature Setting Fixed 2 1; 2

Analysis of Variance

Source DF Adj SS Adj MS F-Value P-Value
Sensor Depth 7 85611.8 12230.3 543.36 0.000
Temperature Setting 1 33.3 33.3 1.48 0.228

Error 71 1598.1 22.5
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Lack-of-Fit 7 183.3 26.2 1.18 0.324
Pure Error 64 1414.8 22.1
Total 79 87243.1

As P Value of Temperature Setting is 0.228 > 0.05 blocking is not necessary.

General Linear Model: Measured Temp Delta versus Sensor Depth

Method

Factor coding (1; 0)

Factor Information

Factor Type Levels Values
Sensor Depth Fixed 8 1; 2; 3; 4; 5; 6; 7; 8

Analysis of Variance

Source DF Adj SS Adj MS F-Value P-Value
Sensor Depth 7 85612 12230.3 539.78 0.000

Error 72 1631 22.7

Total 79 87243

Model Summary

S R-sg R-sg(adj) R-sqg(pred)
4.76005 98.13% 97.95% 97.69%
Coefficients
Term Coef SE Coef T-Value P-Value VIF
Constant 8.02 1.51 5.33 0.000
Sensor Depth
2 2.17 2.13 1.02 0.311 1.75
3 -1.35 2.13 -0.63 0.528 1.75
4 -8.27 2.13 -3.88 0.000 1.75
5 -20.65 2.13 -9.70 0.000 1.75
6 -33.68 2.13 -15.82 0.000 1.75
7 -52.82 2.13 -24.81 0.000 1.75
8 -99.26 2.13 -46.63 0.000 1.75
Regression Equation
Measured Temp Delta = 8.02 + 0.0 Sensor Depth 1 + 2.17 Sensor Depth 2
- 1.35 Sensor Depth 3
- 8.27 Sensor Depth 4 - 20.65 Sensor Depth 5

- 33.68 Sensor Depth 6
- 52.82 Sensor Depth 7 - 99.26 Sensor Depth 8

Fits and Diagnostics for Unusual Observations
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Obs
29
31
47
71
73
78

Measured

Temp Delta Fit Resid Std Resid
-79.40 -91.24 11.84 2.62 R
-78.00 -91.24 13.24 2.93 R
-80.10 -91.24 11.14 2.47 R

-111.00 =-91.24 -19.76 -4.38 R
-101.10 -91.24 -9.86 -2.18 R
-106.70 -91.24 -15.46 -3.42 R

R Large residual

Percent

Frequency

Residual Plots for Measured Temp Delta
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Overall inadequate linear model.

Repeat of Delta Analysis for semi solid range only with 3 unusual results

removed:

General Linear Model: Delta Temp versus Sensor Depth

Method

Factor coding (-1;0; +1)
Factor Information

Factor

Type Levels Values

Sensor Depth coded Fixed 6 1,2;3;4,56
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Temperature Setting coded  Fixed 2 1,2
Analysis of Variance

Source

DF AdjSS AdjMS F-Value P-Value

Sensor Depth coded

Temperature Setting coded

Sensor Depth coded*Temperature Setting
coded

Error

Total
Model Summary

S

R-sq R-sq(adj)

R-sq(pred)

1.89625 98.31%

Percent

Frequency

99

20

50

10

20

15

10

97.92%

97.36%

5 99956 1999.12 55597 0.000
1 35 3.46 0.96 0.332
5 52.3 10.47 2.91 0.022

48 172.6 3.60
59 102240

Residual Plots for Delta Temp
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Mean

10

Interaction Plot for Delta Temp
Data Means
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Sensor Depth coded
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Heating to globular structure experiment

Design of experiment

StdOrder | RunOrder | PtType |Blocks |Time Temp Alloy Temp
44 1 1 1|20 Min | Low THX540 595
1 2 1 1|15 Min |High A356 595
10 3 1 1|25 Min High THX540 605
30 4 1 1|20 Min | High THX540 605
35 5 1 1|25Min | Low A356 585
18 6 1 1|20 Min | High THX540 605
6 7 1 1|20 Min High THX540 605
20 8 1 1|20 Min | Low THX540 595
24 9 1 1|25Min |Low THX540 595
4 10 1 1|15 Min Low THX540 595
13 11 1 1|15 Min |High A356 595
43 12 1 1|20 Min Low A356 585
29 13 1 1|20 Min |High A356 595
25 14 1 1|15 Min High A356 595
2 15 1 1|15 Min High THX540 605
42 16 1 1|20 Min |High THX540 605
32 17 1 1|20 Min Low THX540 595
3 18 1 1|15 Min |Low A356 585
34 19 1 1|25 Min High THX540 605
11 20 1 1|25Min |Low A356 585
38 21 1 1|15 Min |High THX540 605
26 22 1 1|15 Min High THX540 605
27 23 1 1|15 Min |Low A356 585
15 24 1 1|15 Min Low A356 585
23 25 1 1|25Min |Low A356 585
19 26 1 1|20 Min |Low A356 585
48 27 1 1|25 Min Low THX540 595
7 28 1 1|20 Min | Low A356 585
46 29 1 1|25 Min | High THX540 605
14 30 1 1|15 Min High THX540 605
39 31 1 1|15Min |Low A356 585
31 32 1 1|20 Min |Low A356 585
41 33 1 1|20 Min High A356 595
47 34 1 1|25Min |Low A356 585
33 35 1 1|25 Min High A356 595
9 36 1 1|25 Min |High A356 595
21 37 1 1|25 Min High A356 595
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28 38 1 1/15Min |Low THX540 595
36 39 1 1|25 Min Low THX540 595
8 40 1 1|20 Min |Low THX540 595
17 41 1 1|20 Min High A356 595
12 42 1 1|25 Min Low THX540 595
37 43 1 1|15 Min |High A356 595
45 44 1 1|25 Min High A356 595
5 45 1 1|20 Min |High A356 595
40 46 1 1|15 Min Low THX540 595
16 47 1 1/15Min |Low THX540 595
22 48 1 1|25 Min |High THX540 605
Image manipulation process
Step overview:
Step | Name Step by Step Guide | Description / Makros
Reason
Image)
Opt 1 | Open Image File -> Open Open Original
Opt 2 | Save File -> Save As Save Processed
Processed Image
Image
Opt 3 | Re-Open File -> Open (Original
Original Image | Image)
Opt 4 | Create Stack Image -> Stacks -> Image | Create Stack with
to Stack Original and
Processed Image
1 Make (0,0,2048,1400) Macro1-
Rectangle Sets rectangle for ImagaProcessing
2048x1400 cropping the scale
Process ->
2 Crop Image->Crop Crops the lower part .
fthe i ith Multiple Image
o the image wi Processor
the scale
3 Smoothen Process ->Smooth Blurs the active
image or selection.
This filter replaces
each pixel with the
average of its 3 x 3
neighborhood.
4 Median Filter | Process -> Filter -> Noise removal
Median
Radius: 4 Pixel
5 8 Bit Image Image -> Type -> 8-bit Change image to 8
bit for auto
Thresholding
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6 Auto Local Image -> Adjust -> Auto Create black and
Thresholding local threshold white picture
Method: Otsu Optional: Add to
. Stack
Radius: 100
Optional: choose -> Stack
7 Remove Process -> Noise -> Remove Outliers Macro 2-Remove
Outliers Remove Outliers (black pores in Outliers 10dark-
Dark objects: Radius 5-10 globules and white 10bright
Bright objects: Radius 10- psegdo—
particles/branches) | Process ->
40 Multiple Image
8 RGB Color Image -> Type -> RGB Change image to Processor
Image Color Color for manual
globule separation
GIMP
9 Open original | File -> Open Open Original
image
10 Brightness/ Tools -> Color-> Set high contrast
Contrast brightness/contrast and low brightness
Brightness: ca. -30 for better visibility
Contrast: ca.+100 of globule outlines
in superimposed
image
11 Open File -> Open Open processed
processed image
image
12 Superimpose Processed image: Edit -> | Superimpose
images copy visible original and
Original image: Edit-> processed image for
Paste as -> New Layer better
Opacity of new Layer ca. | comparability
30-50%
13 | Separate Manual separation of Color is chosen for
globules globules by drawing lines | good contrast
with size=5 (preferred
color bright green)
14 Delete original
image layer
15 Crop Image-> Auto crop Crops image to
2048x1400
16 Save File -> Export as -> Saves the processed
separated image with
image separated globules
Image)
17 | Length Analyze -> Set Scale: The scale ratio was | Macro3-

calibration of
Imagel

known distance in pixels=
305

known distance = 200
Unit of length = um

determined by
analysis of an
original image

ParticleAnalysis
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Activate the checkbox for
global

Scale: 1.525 pixels/um

This step is
necessary after
every startup of
Imagel, not for
every image

Process ->
Multiple Image
Processor

18 | Set Analyze -> Set Definition of output
measurements | Measurements parameters of
-Area following analysis
-Shape descriptors
-Area fraction This step is
-Perimeter necessary after
every startup of
Imagel, not for
every image
19 | 8 BitIlmage Image -> Type -> 8-bit Change image to 8
bit for Thresholding
Thresholdin Image -> Adjust ->
° Thregshold ((; 200) Crgate -bIaCk and
’ white picture, value
depends on chosen
Inversion Edit -> Invert color in step 13
Inversion necessary
for Analyze particles
20 | Analyze Analyze -> Analyze
particles Particles If ,include holes’ is
Size: 100-Infinity checked the results
Show: Outlines show the effective
-Display results percentage of the
-Summarize liquid phase.
-Add to manager Otherwise the
(-include holes) relative percentage
is shown
Macro1l:

makeRectangle(0, 0, 2048, 1400);
run("Crop");

run("Smooth");

run("Median...", "radius=4");
run("8-bit");

run("Auto Local Threshold", "method=0tsu radius=100 parameter_1=0 parameter_2=0 white");

Macro 2:
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run("Remove Ouitliers...", "radius=10 threshold=50 which=Dark");
run("Remove Outliers...", "radius=10 threshold=50 which=Bright");
run("RGB Color");

Macro 3:

inputname=getTitle; // sets ShortFileName to file name without .jpg for renaming results
Strind1=indexOf(inputname, ".jpg");

ShortFileName=substring(inputname,0,Strind1);

run("Set Scale...", "distance=305 known=200 pixel=1 unit=pm global"); //sets scale for
measurement

setOption("BlackBackground", false);

run("8-bit"); //prepares image for particle analysis

setAutoThreshold("Default™);

setThreshold(0, 200);

run("Convert to Mask");

run("Invert");

run("Set Measurements...", "area perimeter shape area_fraction display redirect=None
decimal=3"); //sets parameters for output of particle analysis

selectWindow(inputname); // selects Image and starts first analysis for effective area fraction
(holes/pores are ignored)

run("Analyze Particles...", "size=100-Infinity show=0utlines display clear include summarize
add");

selectWindow("Results"); // selects results window and saves results

saveAs("Results", "<Location>\\Results\\"+ShortFileName+"_includeHoles.tsv");
selectWindow(inputname); // selects Image and starts second analysis for relatice area fraction
(holes/pores are taken into account)

run("Analyze Particles...", "size=100-Infinity show=Outlines display clear summarize add");
selectWindow("Results"); // selects results window and saves results

saveAs("Results", "<Location>\\Results\\"+ShortFileName+"_excludeHoles.tsv");
selectWindow(inputname); // selects Image and starts third analysis circularity (without particles
on edges)

run("Analyze Particles...", "size=100-Infinity display exclude clear include summarize add");
selectWindow("Results"); // selects results window and saves results

saveAs("Results", "<Location>\\Results\\"+ShortFileName+"_inHoles_exEdges.tsv");
selectWindow("Summary"); // selects summary window and saves results

saveAs("Results", "<Location>\\Results\\"+ShortFileName+"_Summary_eff_real_circ.tsv");
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A356 Rheocast Quality Index (RQI) results - Heating Experiment

Hold Number
Temp |Timein| Run Model of Shape
setting min | Number | Temperature FS Grains Area Perimeter | Factor | Diameter GS GLS GS/GLS RQl
595 15 2 582 71.227 66 8198.239 412.350 1.65 79.53 10.35 11.45 0.90 [0.547688
595 15 2 595 64.908 62 7696.481 367.653 1.40 83.74 9.50 9.90 0.96 |0.686617
595 15 2 592 59.311 41 12720.724 480.708 1.45 105.85 7.50 8.10 0.93 0.640524
595 15 11 595 71.962 75 7084.599 359.288 1.45 78.87 10.15 10.65 0.95 |[0.657289
595 15 11 592 73.893 48 12141.351 | 454.501 1.35 106.85 10.15 10.65 0.95 |[0.703921
595 15 14 582 71.859 72 7918.54 413.113 1.72 76.67 11.35 13.25 0.86 |0.499456
595 15 14 595 72.868 91 7193.056 356.719 1.41 80.66 11.15 11.75 0.95 |0.674074
595 15 14 592 56.583 52 9447.402 410.411 1.42 92.08 7.10 8.30 0.86 |0.602927
595 15 43 595 73.278 93 6833.913 346.348 1.40 78.93 11.70 12.40 0.94 |0.675489
595 15 43 592 68.406 71 8056.838 389.737 1.50 82.69 10.00 10.90 0.92 [0.611512
585 15 18 573 76.734 61 9494.525 429.110 1.54 88.50 10.25 11.25 0.91 0.59036
585 15 18 585 72.895 82 7544177 353.874 1.32 85.28 10.45 11.95 0.87 |[0.662023
585 15 18 582 73.561 51 10513.767 | 442.178 1.48 95.11 9.60 11.50 0.83 |0.564089
585 15 23 573 70.848 129 4972.937 280.049 1.26 71.03 13.95 14.85 0.94 [0.748518
585 15 23 585 66.38 51 10174.048 | 438.633 1.50 92.78 9.95 11.05 0.90 |[0.598359
585 15 23 582 65.937 58 8296.902 408.232 1.60 81.30 9.90 10.90 0.91 |[0.568225
585 15 24 585 75.648 102 6878.729 348.019 1.40 79.06 11.40 12.30 0.93 |[0.661473
585 15 24 582 78.224 54 10501.064 418.207 1.33 100.44 9.70 13.50 0.72 0.542124
585 15 31 573 69.096 73 7737.54 400.026 1.65 77.37 11.05 11.95 0.92 [0.561863
585 15 31 585 67.016 58 8763.851 422.180 1.62 83.03 10.10 11.40 0.89 |[0.547427
585 15 31 582 70.547 50 10824.239 460.430 1.56 94.04 9.55 10.85 0.88 0.564747
595 20 13 582 70.444 94 6006.923 343.340 1.56 69.98 12.30 12.70 0.97 |[0.620175



clkerr01
Typewritten Text
186


/8T

Hold Number
Temp |Timein| Run Model of Shape
setting min | Number | Temperature FS Grains Area Perimeter | Factor | Diameter GS GLS GS/GLS RQl
595 20 13 595 63.398 80 7186.428 349.691 1.35 82.20 9.60 10.40 0.92 [0.681698
595 20 13 592 59.572 54 9998.395 445.444 1.58 89.78 9.55 10.25 0.93 |[0.589975
595 20 33 582 71.889 53 7995.684 384.502 1.47 83.18 10.65 11.75 0.91 |0.615999
595 20 33 595 71.604 80 7258.226 345.138 1.31 84.12 9.60 10.90 0.88 [0.674372
595 20 33 592 70.475 53 10198.419 | 427.453 1.43 95.43 9.05 11.25 0.80 |0.564238
595 20 41 582 76.708 113 6810.528 340.981 1.36 79.89 12.10 13.25 0.91 |[0.672202
595 20 41 595 69.861 76 8442914 372.561 1.31 90.65 10.30 10.60 0.97 |0.742743
595 20 41 592 61.302 67 6341.341 319.152 1.28 79.48 8.50 10.00 0.85 |[0.664989
595 20 45 582 63.824 73 8101.095 370.799 1.35 87.39 9.50 9.80 0.97 |[0.717751
595 20 45 595 65.944 76 7692.420 359.034 1.33 85.70 9.50 9.90 0.96 |0.719598
595 20 45 592 61.649 54 9548.927 423.002 1.49 90.30 8.80 9.50 0.93 0.62121
585 20 12 573 79.61 63 9474.784 424.108 1.51 89.36 9.55 10.75 0.89 |0.588059
585 20 12 585 72.183 68 9108.235 391.260 1.34 93.12 9.55 10.85 0.88 [0.658092
585 20 12 582 66.358 49 10764.366 | 439.338 1.43 98.01 8.65 9.05 0.96 |0.669836
585 20 26 585 82.973 87 8748.072 391.374 1.39 89.41 12.90 14.10 0.91 |[0.656612
585 20 28 573 76.896 78 9387.275 391.364 1.30 95.94 11.60 12.80 0.91 |[0.697968
585 20 28 585 74.274 48 10518.642 | 407.261 1.25 103.31 8.00 9.30 0.86 |0.685537
585 20 28 582 77.324 45 12311.367 | 459.351 1.36 107.21 8.50 10.60 0.80 [0.587949
585 20 32 573 72.218 76 8536.087 356.399 1.18 95.80 9.95 10.55 0.94 |0.796464
585 20 32 585 69.144 75 7813.917 356.832 1.30 87.59 9.05 10.45 0.87 |0.667857
585 20 32 582 69.69 70 8879.702 365.044 1.19 97.30 9.30 10.30 0.90 |[0.756073
595 25 35 582 76.33 51 12595.509 | 465.078 1.37 108.33 9.75 10.55 0.92 |[0.676279
595 25 35 595 68.349 51 9416.292 377.596 1.20 99.75 7.70 9.00 0.86 |[0.710041
595 25 35 592 71.986 53 9280.354 382.923 1.26 96.94 9.10 9.60 0.95 |[0.753914
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Hold Number
Temp |Timein| Run Model of Shape
setting min | Number | Temperature FS Grains Area Perimeter | Factor | Diameter GS GLS GS/GLS RQl
595 25 36 582 74.001 75 7754.492 346.481 1.23 89.52 11.05 11.55 0.96 |[0.776577
595 25 36 595 72.792 71 7750.956 361.212 1.34 85.83 11.05 11.45 0.97 0.72044
595 25 36 592 71.385 45 11406.883 | 449.984 1.41 101.40 8.20 9.30 0.88 |0.624185
595 25 37 582 75.768 67 8315.749 373.966 1.34 88.95 9.25 10.25 0.90 [0.674318
595 25 37 595 71.483 57 11074.978 | 427.513 1.31 103.62 9.30 9.70 0.96 |0.730071
595 25 37 592 71.164 50 11506.713 | 444.459 1.37 103.56 8.85 9.25 0.96 |[0.700324
595 25 44 582 72.979 77 7820.224 354.772 1.28 88.17 11.00 11.30 0.97 0.760054
595 25 44 595 67.172 60 10108.508 | 405.533 1.29 99.71 9.15 9.25 0.99 |0.764054
595 25 44 592 68.786 52 10345.515 | 419.908 1.36 98.55 9.30 9.90 0.94 0.69263
585 25 5 573 65.082 71 7457.429 316.679 1.07 94.20 8.35 9.55 0.87 0.81704
585 25 5 585 68.217 49 11740.877 | 468.131 1.49 100.32 8.80 9.20 0.96 |0.643977
585 25 5 582 53.501 38 11309.127 | 477.936 1.61 94.65 7.65 8.35 0.92 |0.569999
585 25 20 573 74.533 52 10847.977 | 435.886 1.39 99.55 8.55 9.75 0.88 [0.629179
585 25 20 585 70.362 50 11700.278 | 442.476 1.33 105.77 7.90 8.00 0.99 0.74159
585 25 20 582 64.164 45 11937.513 | 502.865 1.69 94.96 8.25 8.65 0.95 |[0.565795
585 25 25 573 72.101 146 4520.788 233.95 1.00 77.29 13.00 13.20 0.98 [0.984848
585 25 25 585 60.871 84 6381.649 309.671 1.20 82.43 10.10 10.20 0.99 |[0.828062
585 25 25 582 60.489 92 6161.738 302.18 1.18 81.56 9.60 9.90 0.97 [0.822276
585 25 34 585 76.768 31 18382.488 | 602.026 1.57 122.14 7.85 10.65 0.74 0.46979
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THIXALLOY 540 Rheocast Quality Index (RQI) results - Heating Experiment

Hold Number
Temp |Timein| Run Model of Shape
setting min | Number | Temperature FS Grains Area Perimeter | Factor | Diameter GS GLS GS/GLS RQl
605 15 15 593 68.984 124 5038.021 301.73 1.44 66.79 12.45 12.85 0.97 0.67375
605 15 15 605 62.502 132 4330.439 265.455 1.29 65.25 12.45 13.35 0.93 |0.720192
605 15 15 602 60.453 88 5633.197 309.445 1.35 72.82 9.55 9.95 0.96 |0.709542
605 15 21 605 56.799 98 5137.193 280.23 1.22 73.33 10.00 10.50 0.95 0.78292
605 15 22 593 61.711 91 5362.245 303.539 1.37 70.66 11.75 12.75 0.92 |0.673993
605 15 22 605 57.727 86 5908.654 332.632 1.49 71.05 9.90 10.60 0.93 |0.626758
605 15 22 602 57.687 85 5498.787 305.257 1.35 72.05 10.05 10.75 0.93 |0.693271
605 15 30 593 59.747 94 6137.555 317.585 1.31 77.30 9.15 9.75 0.94 |0.717632
605 15 30 605 60.498 89 5730.626 313.529 1.37 73.11 9.65 10.15 0.95 |0.696495
605 15 30 602 58.323 56 7644.082 378.316 1.49 80.82 9.35 11.35 0.82 |0.552894
605 20 4 593 73.46 101 5343.48 318.842 1.51 67.04 10.70 11.60 0.92 |0.609269
605 20 4 605 65.523 78 6216.046 333.337 1.42 74.59 10.60 12.30 0.86 0.60584
605 20 4 602 80.742 51 13029.58 492.268 1.48 105.87 10.35 10.95 0.95 |0.638651
605 20 6 593 64.958 110 5463.626 303.481 1.34 72.01 12.35 13.05 0.95 |0.705479
605 20 6 605 60.541 113 5186.882 291.442 1.30 71.19 11.10 11.60 0.96 |0.734306
605 20 6 602 63.135 76 6828.08 338.599 1.34 80.66 8.80 10.10 0.87 |0.652076
605 20 7 593 66.316 110 5215.763 268.907 1.10 77.58 10.95 11.65 0.94 |0.851945
605 20 7 605 52.827 92 5435.168 282.770 1.17 76.88 8.95 9.25 0.97 0.82649
605 20 7 602 46.665 71 6198.303 307.404 1.21 80.65 8.00 8.40 0.95 |0.785008
605 20 16 593 56.279 68 7776.328 367.856 1.38 84.56 8.50 9.80 0.87 |0.626357
605 20 16 605 57.132 86 5797.531 297.544 1.22 77.94 8.95 10.15 0.88 |0.725617
605 20 16 602 53.187 74 6626.983 324.902 1.27 81.59 8.55 9.35 0.91 |0.721399
605 25 3 593 62.685 92 6115.514 324.179 1.37 75.46 12.20 12.50 0.98 |0.713712
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Hold Number

Temp |Timein| Run Model of Shape

setting min | Number | Temperature FS Grains Area Perimeter | Factor | Diameter GS GLS GS/GLS RQl
605 25 3 605 63.922 102 6101.375 319.267 1.33 76.44 11.95 12.75 0.94 |0.704997
605 25 3 602 60.088 75 6491.548 310.975 1.19 83.50 9.20 9.50 0.97 |0.816905
605 25 19 593 63.551 83 6650.172 317.912 1.21 83.67 10.15 10.55 0.96 |0.795504
605 25 19 605 64.277 119 5115.014 281.602 1.23 72.66 11.10 11.70 0.95 |0.768993
605 25 19 602 55.81 86 5942.689 291.708 1.14 81.49 8.40 9.00 0.93 |0.819093
605 25 29 593 62.514 96 6195.436 310.814 1.24 79.73 11.40 11.60 0.98 |0.792004
605 25 29 605 61.727 74 7094.42 332.859 1.24 85.25 9.15 9.65 0.95 |0.762957
605 25 29 602 57.228 59 7949.99 368.585 1.36 86.28 8.65 9.05 0.96 0.70286
605 25 48 593 76.723 141 5193.36 289.37 1.28 71.79 13.45 13.55 0.99 |0.773632
605 25 48 605 69.76 115 5849.225 299.883 1.22 78.02 12.00 12.10 0.99 |0.810588
605 25 48 602 68.437 59 9677.18 442,782 1.61 87.42 10.00 10.70 0.93 |0.579689
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Count of failures before adequate sample

Temp
StdOrder | RunOrder | Time coded Alloy Temp | Count of failures
1 2 15 Min High A356 595 0
10 3 25 Min High THX540 605 0
30 4 20 Min High THX540 605 1
35 5 25 Min Low A356 585 0
18 6 20 Min High THX540 605 2
6 7 20 Min High THX540 605 7
13 11 15 Min High A356 595 0
43 12 20 Min Low A356 585 0
29 13 20 Min High A356 595 1
25 14 15 Min High A356 595 2
2 15 15 Min High THX540 605 3
42 16 20 Min High THX540 605 0
3 18 15 Min Low A356 585 0
34 19 25 Min High THX540 605 1
11 20 25 Min Low A356 585 2
38 21 15 Min High THX540 605 4
26 22 15 Min High THX540 605 0
27 23 15 Min Low A356 585 0
15 24 15 Min Low A356 585 10
23 25 25 Min Low A356 585 0
19 26 20 Min Low A356 585 0
7 28 20 Min Low A356 585 0
46 29 25 Min High THX540 605 0
14 30 15 Min High THX540 605 0
39 31 15 Min Low A356 585 0
31 32 20 Min Low A356 585 0
41 33 20 Min High A356 595 0
47 34 25 Min Low A356 585 0
33 35 25 Min High A356 595 0
9 36 25 Min High A356 595 0
21 37 25 Min High A356 595 0
17 41 20 Min High A356 595 9
37 43 15 Min High A356 595 0
45 44 25 Min High A356 595 0
5 45 20 Min High A356 595 0
22 48 25 Min High THX540 605 0
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Verification of failures based on alloy (result no significant effect):

General Linear Model: Count of failures versus Alloy

Factor Information
Factor Type Levels Values
Alloy Fixed 2 A356; THX540

Analysis of Variance

Source DF Adj SS AdjMS F-Value P-Value
Alloy 1 2.000 2.000 0.31 0.581
Error 34 219.000 6.441

Total 35 221.000

Model Summary

S R-sq R-sq(adj) R-sq(pred)
2.53795 0.90% 0.00% 0.00%

Verification of failures based on time and temperature for A356 (result no
significant effect):

General Linear Model: Count of failures versus Temp coded; Time

Factor Information

Factor Type Levels Values
Temp coded Fixed 2 High; Low
Time Fixed 3 15 Min; 20 Min; 25 Min

Analysis of Variance

Source DF Adj SS Adj MS F-Value P-Value
Temp coded 1 0.000 0.0000 0.00 1.000
Time 2 7.000 3.5000 0.46 0.641
Temp coded*Time 2 21.000 10.5000 1.37 0.279

Error 18 138.000 7.6667

Total 23 166.000

Model Summary

S R-sq R-sqg(adj) R-sq(pred)

2.76887 16.87% 0.00% 0.00%
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Verification of failures based on time and temperature for THIXALLOY (result

no significant effect):

General Linear Model: Count of failures versus Time

Factor Information

Factor Type Levels

Time Fixed 3

Analysis of Variance

Source DF Adj SS
Time 2 10.50

Error 42.50

Total 11 53.00

Model Summary

S R-sq R-sq(adj)

2.17307 19.81%1.99%

Values
15 Min; 20 Min; 25 Min

AdjMS F-Value P-Value
5.250 1.11 0.370
4.722

R-sq(pred)
0.00%
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Aging experiment

Design of Experiment

StdOrder | RunOrder | PtType |Blocks |Time Temp Alloy Temp
5 1 1 1|40 Min | High A356 595
21 2 1 1|50 Min |High A356 595
15 3 1 1|30 Min |Low A356 585
17 4 1 1|40 Min | High A356 595
13 5 1 1|30 Min |High A356 595
8 6 1 1|40 Min |Low THX540 595
4 7 1 1|30 Min |Low THX540 595
23 8 1 1|50 Min | Low A356 585
20 9 1 1|40 Min |Low THX540 595
14 10 1 1|30 Min High THX540 605
3 11 1 1|30 Min |Low A356 585
10 12 1 1|50 Min High THX540 605
24 13 1 1|50 Min | Low THX540 595
19 14 1 1|40 Min Low A356 585
22 15 1 1|50 Min High THX540 605
7 16 1 1|40 Min |Low A356 585
1 17 1 1|30 Min |High A356 595
9 18 1 1|50 Min | High A356 595
11 19 1 1|50 Min |Low A356 585
12 20 1 1|50 Min | Low THX540 595
6 21 1 1|40 Min | High THX540 605
16 22 1 1|30 Min Low THX540 595
2 23 1 1|30 Min |High THX540 605
18 24 1 1|40 Min High THX540 605
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Extrusion samples A356/THIXALLOY 630
A356 - Run 2

A356 - Run 1 A356 - Run 3

500 ym
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A356 - Run 4

A356 - Run 5

A356 - Run 6
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A356 - Run 7

A356 - Run 8

A356 - Run 9
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A356 - Run 10

A356 - Run 11

A356 - Run 12
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Extrusion samples THIXALLOY 540
THX 540 - Run 1 THX 540 - Run 2 THX 540 - Run 3
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THX 540 - Run 4

THX 540 - Run 5

THX 540 - Run 6
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THX 540 - Run 7

THX 540 - Run 8

THX 540 - Run 9
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THX 540 - Run 10

THX 540 - Run 11

THX 540 - Run 12
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